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1 Introducere software

1.1 Prezentare generala

Houseplan 1.0 este un software puternic, usor de Tnvdtat si compatibil, care poate crea modele 3D si randari
uimitoare in mod eficient. Acesta nu numai ca suporta generarea de entitati arhitecturale 3D cu un singur clic, dar
ofera si instrumente mai avansate care ajuta la personalizarea si rafinarea proiectelor, precum si la producerea de
imagini si animatii de Thalta calitate, fara nicio problema. Pe langa faptul ca este de mare ajutor pentru proiectele
de planificare arhitecturald, poate fi utilizat si in diverse alte industrii care necesita modelare si randare 3D. Metodele
sale puternice de modelare si motorul de randare in timp real, precum si cantitatea mare de resurse de modele si
texturi 3D, va permit sa obtineti cea mai buna experienta de lucru si rezultate de Tnalta calitate cu bugete cat mai
mici.

1.2 Cerinte de sistem

1.2.1 Cerinte hardware

Minimum Recommended
CPU Intel 15-6 procesor Intel 15-9 si mai sus
1920 x 1080 sau o configuratie
Monitor 1440 x 900 afisare in culori reale superioara

Placa video Nvidia GTX1050Ti Nvidia GTX1660Ti sau mai buna

RAM 16GB 16GB sau m-ai multi
Hard Drive 4G 8G

Mouse, trackball sau alt dispozitiv Mouse, trackball sau alt dispozitiv de
Altele de indicare indicare

1.2.2 Configuratie software

0s Win 7 (64-bit) / Win10 (64-bit) / Win 11(64-bit)

1.3 Prezentare generala a interfetei Houseplan 1.0

Interfata cu utilizatorul este formata dintr-o bara de instrumente cu acces rapid, panglica, paleta de proprietati,
bara de stare, fila de fisiere, linie de comanda si spatiu de lucru.
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Bara de instrumente de acces rapid: Permite accesul rapid la instrumentele utilizate frecvent, cum ar fi New, Open,
Save, Save As, Undo, Redo, Layer
Control, Element on/off si Straturi.

Ribbon: Afiseaza instrumentele bazate pe sarcini relevante pentru spatiul de lucru curent, care consta din noua

file. Fiecare fila consta intr-o serie de panouri cu functii conexe.

Home Insert Edit Modeling View Material Scene Video Services

LhezEBEEa M .o00d 8 B BilWO0ABRL B 0 =

New Open Save Save Save Properties Settings Line Rectangle Box Building Cross-section Building Balcony Window Door Rooftop Awning Outdoor Glass Building Move

As  Selected
File Manage Draw Building

BExtrusion BExtrusion  Gallery t Stairs Curtain Wall Attachment Components |

Paleta de proprietati: Afiseaza proprietatile obiectului selectat si poate fi modificata.
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Properties 2 B

B Building R
0 riae

Buildi ame 5 N ;19
Color attached to laj,.'r:rz

3. 0000
Humber of floors above ground 11
Humber of floors underground 0
Indoor and outdoor height difference 0.4500
Base arealm’)
Apron
Floor line
Elevation 0.0000
Total areaim’)
Above groundim’)

Under zroundim® ) 0.00

Bara de stare: Aceasta este compusa din pozitia coordonatelor cursorului, instrumente care afecteaza mediul
de desenare (Ortogonal, Axa polara, Snap, Follow si Reference), unitatile de masura utilizate pentru desenul curent,
cursorul pentru a regla viteza camerei, butoanele pentru modul de vizualizare (Isometric, Perspective) si butoanele

de comutare a efectelor (Shadow, Anti-Aliasing, Light Projection).

-68.474, -35.897, 0.000 Orthogonal | Polar Axis | Snap | Follow |Reference

Scene Units: Meters Camera Speed —————+——0—— | |sometric | Perspective 7 Shadow jAnti-AIiasing Light Projection

File Tab: Situata deasupra liniei de comanda, afiseaza unul sau mai multe fisiere deschise.

Untitled1 Untitled2 Untitled3 Untitled4 Untitled5

Linia de comanda: Afiseaza linia de comanda in timpul executdrii unui instrument sau a unei comenzi..

COMMAND:RECTANGLE
SPECIFY FIRST ANGLE POINT:
SPECIFY THE OTHER ANGULAR POINT:

Command:

Spatiu de lucru: Afiseaza zona vizibila a fisierului deschis curent.

Page 3 of 241



Houseplan 1.0 Make stunning 3D scheme with speed and ease

2 Meniu Acasa

Acest capitol prezinta caracteristicile de baza ale Houseplan 1.0, cum ar fi crearea si salvarea proiectelor, setarile
parametrilor, desenarea liniilor, planurilor si volumelor, proiectarea modelelor de cladiri, deconstructia structurii

interioare etc., permitand utilizatorilor sa creeze rapid proiecte noi si sa imbunatateasca eficienta proiectarii.

2.1 Panoul de fisiere
2.1.1 Nou

Selectati "Home Tab > File Panel B New" pentru a crea un nou desen gol.

2.1.2 Open

Selectati "Home Tab > File Panel Open" pentru a deschide un fisier in format *.cpi.
Nota: Mai multe documente pot fi deschise Tnh acelasi timp si puteti comuta intre documente prin Ctrl+ Tab, puteti

copia (Ctrl+ C) si lipi (Ctrl+ V) date intre documente.

2.1.3 Salvati

Selectati "Home Tab > File Panel > Save" pentru a salva fisierul curent.

Note:

@ Fisierul salvat este in format *.cpi. La salvarea unui fisier existent, fisierul original va fi salvat ca *.cpi.bak.

Daca este nevoie de fisierul original, eliminati sufixul .bak.

@ Intervalul implicit de salvare automata este de 30 de minute. Setati intervalul de salvare si locatia in "Home
Tab > Manage Panel > Settings > Auto Save" (fila Acasa > Gestionati panoul > Setari > Salvare automata).

2.1.4 Save As

Select "Home Tab > File Panel > B Save As" pentru a salva fisierul curent numai in format *.cpi.

2.1.5 Save Selected

Select "Home Tab > File Panel > Save Selected" pentru a selecta si salva obiectele sau elementele existente
n spatiul de lucru in format *.cpi.
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2.2 Gestionatipanoul

2.2.1 Proprietati

Selectati "Home Tab > Manage PaLEm—LProperﬁeg sainchideti/deschideti paleta de

Properties ﬂ X
B Slope Roof

77, 114, 155 PR Rge

on panel type Flat wall entity

ction areaim’) 459 22
Detailed parameter 0. 0000
Flat top heizht 0. 0000

Hanging board enclosure Yes

2.2.2 Setari

Permite gestionarea parametrilor Houseplan 1.0 in ceea ce priveste personalizarea comenzilor rapide, culoarea

de fundal a spatiului de lucru, functia de salvare automata, comutarea temelor, Configurarea unitatilor si resetarea la

optiunea implicita.

Selectati "Home Tab > Manage Panel > TLT Settings" pentru a deschide urmatoarea caseta de dialog.

Set Parameters

Simplify Commands Set Background Auto Save

Switch Theme Units Setup Reset
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2.2.2.1 Simplificarea comenzilor

Stabileste o comanda rapida pentru acces rapid la o comanda similara cu aliasul de comanda. Selectati "Home Tab >

Manage Panel > Settings > Simplify Commands" to open the following dialog box.

Simplify Commands X
B E &z
Home Insert Edit Modeling View Material Scene Video ir"[ b ]
Serial number ' Command description Command name Simplify command ’
1 New NEW
2 Open OPEN
3 Save SAVE
4 Save As SAVEAS
5 Save Selected SAVESEL
6 Properties SHOW _SZXS
7 Settings SetParam
8 Polyline PLINE PL
9 Line Segment LINE L
10 Arc ARC
11 Spline SPLINE SPL
12 Cirde CIRCLE CI
13 Ellipse ELLIPSE
14 Regular Polygon NPOLYGON
15 Vertical Line FACEVERTICALLINE
16 Spiral Line SPIRALLINE
17 Cloud Line CLOUD
18 Rectangle RECTANGLE REC

1. Introduceti o comanda rapida personalizata in coloana "Simplify Command" (Comanda simplificata) si
introduceti-o in linia de comanda atunci cand este utilizata.

2. Faceti clic pe butonul B pentru a salva comanda simplificata.
3. Faceti clic pe butonul buton pentru a deschide o lista de "comenzi de simplificare" definite pentru acces si

modificare usoara.

4. Actualizati lista de comenzi simplificate facand clic pe butonul ] pentru a importa fisierul de configurare a
listei de comenzi simplificate.

5. Faceti clic pe butonul 5= pentru a selecta o locatie de stocare pentru a exporta lista curenta de comenzi
simplificate sub forma unui fisier de configurare.
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2.2.2.2 Setare fundal

Stabileste culoarea de fundal a spatiului de lucru in modul axonometric. Selectati "Home Tab > Manage Panel >

147

Settings > Set Background". Selectati culoarea si faceti clic pe "OK" pentru a aplica setarile.

Basic colors:

Set Parameters . l—- r— - [— - li
Simplify C d Set Background Auto S. -I_r_.l—.-
implify Commands et Backgroun: uto Save

HEEEEERENEN
HEPNEEEEn
Switch Theme Units Setup Reset
HEEEEEEN
NN N
Custom colors:
R S
BEEEE R @R
Define Custom Colors >>
Cancel

™

2.2.2.3 Salvare automata

Stabileste intervalul si calea de salvare pentru fisierele de backup care vor fi salvate automat. Selectati "Home

Tab > Manage Panel > Settings > Auto Save" pentru a afisa urmatoarea caseta de dialog.

Auto-save

Interval (min): [ 30 v

Save path: C:\Users\Administrator\Documents\HousePlan Da | |

Confirm Cancel

Introduceti sau selectati durata intervalului si @Iﬁmpau a seta calea de salvare; faceti clic pe butonul "Confirm" pentru a aplica setarile.

Nota: Formatul fisierului de backup este *.cpi.
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2.2.2.4 Schimba tema

Comuta skin-ul sau temele disponibile furnizate de Houseplan 1.0. Selectati "Home Tab > Manage Panel >
Settings >
Switch Theme " pentru a schimba tema.

(B =N=Rs] 2 | Undefinec < T, Undefined Li Houseplan 1.0[Trial day left 30] - [ Untitied1 ]

Home Insert Edit Modeling ew Material Scene Video se

L8 E B E =B e T HOAR B 8 2 BEEHOM -~ &

New Open Save Save Save  Properties Settings = Line Rectangle Box  Building Cross-section Building Balcony Window Door Rooftop Awning Outdoor  Glass Building Move  Show Draw Floor Draw Stairs Funiture
As  Selected v v 2 Extrusion  Extrusion  Gallery v Stairs Curtain Wall Attachment Components Floors Wall ~ Hole Railings v Gallery
File Manage Draw Building

Undefined = | [0 Undefined Lir = Houseplan 1.0[Trial day left 30] - [ Untitied1 ]
Edit Modeling View Material Scene Video Services
LhEEEE BRSO 8 B BIlEIAR, B 65§ 25 SHEOH - @

New Open Save Save Save | Properties Settings = Line Rectangle Box | Building Cross-section Building Balcony Window Door Rooftop Awning Outdoor  Glass Building Move  Show Draw Floor Draw Stairs Furniture
As  Selected ~ > ~ Extrusion Extrusion  Gallery ~ Stairs Curtain Wall Attachment Components Floors Wall Hole Railings -  Gallery

Building

File

Manage Draw

2.2.2.5 Configurarea unitatilor

Stabileste unitatile de desen pentru desenul curent. Unitatile obisnuite in sistemul metric sunt milimetri,

centimetri, metri, iar unitatile obisnuite in sistemul imperial sunt inch, feet.

Selectati " Home Tab > Manage Panel > Settings > Units Setup" (Setari > Configurare unitati), va aparea
caseta de dialog, selectati unitatile dorite din lista si faceti
clic pe butonul "Confirm" pentru a activa setarile.

Note:

Scene Units: Meters

@ Unitatea de mdsura a desenului este e
Conver to: iMeters v \

determinata de cea mai recenta setare.

(@ Bara de stare va afisa in mod sincronizat \
unitatea setata in prezent.

(3 Daci treceti la o altd metod3 de unitate, se modifici dimensiunile vor fi convertite automat la

valoarea unitatii curente. Cu toate acestea, acest lucru nu se aplica fisierelor fuzionate sau datelor

importate, cum ar fi datele de Tnclinare, datele din norul de puncte sau datele manuale.

La copierea unei scene n altd scend, unitatea scenei selectate se va potrivi cu cea a scenei tinta, iar

valorile aferente vor fi ajustate automat.
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2.2.2.6 Resetare

il

Selectati "Home Tab > Manage Panel > Settings > Reset" (Setari > Resetare), pentru a readuce toate setarile

din software la starea in care se aflau in momentul instalarii software-ului.

2. Desenati panou

2.3.1 Line

2.3.1.1 Polilinie

Creeaza o polilinie. Selectati "Home Tab > Draw Panel > Line > Polyline", exista doua moduri de a

desena.
1. Traseaza direct o polilinie
(1) Desenati un segment de linie dreapta: Dupa ce ati specificat punctul de pornire, specificati urmatorul
punct sau continuati sa specificati mai multe puncte pana la pozitia tinta si apasati Enter.
(2) Pentru a trasa un segment de dreapta circulara: Tastati sau introduceti "A" si apasati Enter, specificati
urmatorul punct sau continuati sa specificati mai multe puncte pana la pozitia tinta si apasati Enter.

Note: Arcul este tangent la segmentul anterior al polilinii.

n timpul procesului de desenare a unui singur segment de linie, liniile drepte si arcele pot fi desenate in
orice moment prin comutarea intre tastele "L" si "A". Pentru a inchide, introduceti "C" si apdsati enter; pentru
a abandona operatia anterioara, introduceti "U" si apasati enter.

2. Desenarea poliliniilor 3D

Tastati sau introduceti "S" pentru a intra si a specifica urmatorul punct sau puteti continua sa

specificati al doilea si al treilea punct pana la pozitia tinta si apasati Enter. Pentru a inchide, introduceti

"C" si apasati Enter; pentru a anula

Orthogonal Polar Axis Bnap TFvollow ]'R—erference

operatiunea anterioara, introduceti "U" si
apasati Enter. Note: Atunci cand desenati o
polilinie tridimensionala, deschideti "axa polara", asa cum se aratad in figura, astfel incat sa puteti sa va fixati pe

liniile auxiliare atunci cand desenati.
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2.3.1.2 Segment de linie

Creeaza segmente de linie. Selectati "Home Tab > Draw Panel > Line > Line Segment", specificati

punctele de inceput si de sfarsit si generati un segment de linie.

2.3.1.3 Arc

F(—u
)
Creeaza un arc. Selectati "Home Tab > Draw Panel > Line > Arc" si exista doua moduri de a trage.
1. Deseneaza un arc de cerc prin specificarea directa a trei puncte.
2. Introduceti sau tastati "C" si apasati enter, desenati arcul prin centrul cercului specificat. Specificati centrul

cercului, punctul de inceput si punctul final pentru a genera.

2.3.1.4 Spline

Creeaza o spline. Selectati elementul "Home Tab > Draw Panel > Line > Spline" pentru a desena o

spline la punctul specificat.

1. Desenati o spline neinchisa: Precizati separat punctul de plecare si tangentele punctului final pentru a genera
spline-urile.

2. Desenati o spline inchisa: Introduceti sau tastati "C" si specificati directia tangentei. Pentru a intrerupe operatia

anterioara, tastati "U" si apasati enter.

2.3.1.5 Cerc

o
Creeaza un cerc. Selectati "Home Tab > Draw Panel > Line > Circle" pentru a crea un cerc cu centrul

si raza specificate.

2.3.1.6 Ellipse
Creeaza o elipsa. Selectati "Home Tab > Draw Panel > Line > @ Ellipse" pentru a crea o elipsa cu centrul

si lungimea axei specificate.
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2.3.1.7 Poligon regulat

Creeaza un poligon regulat. Selectati "Home Tab > Draw Panel @
Line > Regular Polygon", enter a value to

> determinati numarul de laturi si apoi incepeti sa desenati.
Exista trei moduri de a genera.

1. Deseneaza un poligon patrat in interiorul unui cerc:
Specificarea punctului central si introducerea razei genereaza
un poligon patrat cu urmatorul efect.

2. Desenati un poligon regulat pe baza lungimilor laturilor
specificate: Introduceti sau introduceti "E" si apasati Enter
pentru a specifica douda puncte ca lungimi ale laturilor
poligonului regulat.

3. Pentru a desena un poligon patrat tangent la un cerc:

Introduceti sau introduceti "C", specificati punctul central,

introduceti raza si generati un poligon patrat cu urmatorul

efect.
2.3.1.8 Linie verticala

Creeaza linii verticale. Selectati "Home Tab > Draw Panel > Line >

m Vertical Line", specificati primul punct si utilizati directia normala la planul punctului ca directie a liniei verticale

si specificati al doilea punct sau introduceti o valoare pentru a determina lungimea liniei verticale.
Nota: Daca punctul specificat nu se fixeaza pe un plan, linia cu plumb generata este perpendiculara pe planul

XO¥YI.

2.3.1.9 Linie spirala

Creeaza un obiect spirala. Selectati "Home Tab > Draw Panel > Line > Spiral Line". Mai intai

specificati centrul cercului inferior, apoi specificati direct sau introduceti o valoare pentru a determina raza inferioara
si raza superioara, apoi introduceti o valoare pentru a determina numarul de rotatii si gradele egale si apoi specificati
direct sau introduceti o valoare pentru a determina inaltimea la care se va desena spirala. Nota: Puteti modifica
pseudonimul, culoarea stratului, raza inferioard, raza superioara, unghiul de inclinare, numarul de spire ale spiralei,
indltimea spiralei, altitudinea etajului si alti parametri in paleta de proprietati
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2.3.1.10 Linia de nor

Creeaza o linie de nori. Selectati "Home Tab > Draw Panel > Line > E Cloud Line", specificati punctul de

pornire si deplasati cursorul pentru a desena. Exista trei moduri de a desena.

1. Tragerea directa a liniilor de nori Tnainte.
2. Enter or input “F” and press Enter to draw reverse cloud line.
3. Introduceti sau introduceti "A" si apasati Enter pentru a seta lungimea arcului.

Note: Puteti modifica pseudonimul, culoarea stratului, daca este Tnchis sau nu si inaltimea podelei in paleta de
proprietati.

2.3.2 Dreptunghi
2.3.2.1 Dreptunghi

Creeaza un plan dreptunghiular. Selectati "Home Tab > Draw Panel > Rectangle > Rectangle" si
specificati doua puncte de colt pentru a desena un dreptunghi.

Note: Puteti modifica alias-ul, culoarea stratului, lungimea, latimea, numarul de etaje ale cladirii, nadltimea

etajului si alte informatii despre parametri in paleta de proprietati.

2.3.2.2 Poligon

Creeaza un plan poligonal. Selectati "Home Tab > Draw Panel > Rectangle > Polygon", specificati

punctul de plecare si desenati poligonul direct; sau introduceti "S" pentru a desena poligonul in spatiul 3D. Pentru

a anula operatiunea anterioara, tastati "U" si apasati enter.

2.3.2.3 Spline Plane

Creeaza un plan spline. Selectati "Home Tab > Draw Panel > Rectangle >Sp|ine Plane", introduceti

latimea planului si desenati in punctul specificat.

2.3.3 Box

2.3.3.1 Box

Creeaza o cutie. Selectati "Home Tab > Draw Panel > @ Box > @ Box", specificati doua puncte de colt, apoi
specificati sau introduceti o valoare pentru a determina inaltimea.
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2.3.3.2 Cilindru

Creeaza un cilindru. Selectati "Home Tab > Draw Panel > @ Box > CyIinder", specificati mai intai centrul
cercului, apoi specificati sau introduceti valori pentru a determina raza si, respectiv, indltimea.

2.3.3.3 Con

Creeaza un con. Selectati "Home Tab > Draw Panel >@ Box > Cone" pentru a preciza centrul bazei, iar
apoi specificati sau introduceti valori pentru a determina raza bazei, raza superioara si inaltimea.

2.3.3.4 Gogoasa

Creeaza un inel de volum. Selectati "Home Tab > Draw Panel > i Box >Donut ", specificati mai ntai

centrul cercului, apoi specificati direct raza si raza cercului sau introduceti o valoare.

2.3.3.5 Piramida

Creeaza un con prismatic. Selectati "Home Tab > Draw Panel > @ Box > Pyramid", specificati mai intai
punctul central, apoi introduceti o valoare pentru a determina numarul de laturi ale poligonului de baza al
piramidei, apoi specificati direct sau introduceti o valoare pentru a determina raza cercului exterior de baza, raza
cercului exterior superior si indltimea.

2.3.3.6 Sfera

]
Creeaza o sfera. Selectati "Home Tab > Draw Panel > Box > Sphere" si specificati mai intai centrul

sferei, apoi specificati direct raza sau introduceti o valoare pentru a determina raza.

2.4 Panou de constructie

2.4.1 Extrudare pentru constructii

Extrude planuri, solide 3D sau suprafete ale cladirilor pentru a obtine definitii ale cladirilor sau modificari ale formei

acestora. Selectati "Home Tab > Building Panel > E Building Extrusion" sa extrudeze cladirea in urmatoarele doua
moduri.

1. Building Extrusion: Deplasati cursorul pe un plan pentru a-l evidentia, apoi apasati si mentineti apasat butonul

din stanga pentru a extruda sau introduceti o valoare pentru a determina distanta de extrudere.
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\:

\

(1) Selectati un plan si extrudeti (Y) (toate entitatile
sau [faceti clic pe entitatile din planul selectat
(stay) / extrude fara entitati move (N) / enter

valoarea distantei]

(2) Select a plane and extrude (N) (no entity move)
or [click the entities on selected plane (move)
/ extrude with all entities move (Y) / enter

distance value]:

2. Extrudare standard pentru podea:
Atunci cand cladirea este extrudata in sus, daca exista un obiect plan, un solid 3D sau un volum care se afla la

mai putin de 2 metri de cladire Tn jurul ultimului etaj al cladirii, acesta va fi copiat la fiecare etaj pe masura ce

etajul cladirii este extrudat.
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Note:

® Cladirea trebuie s aiba cel putin un etaj pentru a intra in vigoare.

® Sprijina doar etajele supraterane ale cladirii.
Proprietati de constructie:

Properties
B Building

(1) Numele cladirii: Permite N Builds
introducerea unui nume de
cladire.

(2) indltimea cladirii:
Tnaltimea cladirii: indltimea
cladirii se  calculeaza
automat si nu poate fi

modificat3. Tnaltimea

cladirii = diferenta dintre
indltimea interioard si cea
exterioara + (indltimea etajului * numérul de etaje) + iniltimea componentelor acoperisului. in cazul in

care exista mai multe componente ale acoperisului, cea mai Thalta este luata Tn calcul TnTnaltimea cladirii.
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(3) Proprietati ale podelei: Pentru a seta proprietatile etajului, faceti dublu clic pe paleta de proprietati sau

faceti clic pe buton pentru a deschide caseta de dialog prezentata mai jos.

Floor Properties X
Floor number 1 Floor height l Area(m?) ’ Factor | Capacity factor ’
5 3.0000 301.97 1.0000
4 3.0000 301.97 1.0000 1.0000
3 3.0000 301.97 1.0000 1.0000
2 3.0000 301.97 1.0000 1.0000
1 3.0000 301.97 1.0000 1.0000
Sum 18.0000 1811.82
oo

@ Define floor: Click El si selectati un etaj din lista pentru a-llegain

(ar trebui sa utilizati instrumentul "Show Floor" pentru a ascunde acoperisul etajului selectat).
Puteti selecta mai multe etaje, puteti modifica elementele interioare ale unui etaj, iar celelalte
etaje se vor modifica si ele.

Note:

@',I’ine';i apasat SHIFT sau CTRL pentru a selecta mai multe etaje.

@Dupé legare, diferite culori reprezinta diferite etaje standard.

Awning Outdoor Glass Building Move Show Draw Floor
Stairs Curtain Wall Attachment Components Floors Wall Hole

Building
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Propetti

= 8 =
Floor number Floor height Area(m?) Factor Capacity factor |
6 3.0000 301.97 1.0000 1.0000
5 3.0000 301.97 1.0000 1.0000
4 0000 01,9 1.0000 1.0000
3 3.0000 301.97 1.0000 1.0000
2 3.0000 301.97 1.0000 1.0000
; ; 3.0000 301.97 1.0000 1.0000
Sum 18.0000 1811.82

Floor Properties

[Ele =

Floor number ‘ Floor height ’

Area(m?) ‘

301.97

301.97
1811.82

Factor

‘ Capacity factor ‘

Floor Properties X
58z ml n 4
Floor number ‘ Floor height ’ Area(m?) ‘ Factor ‘ Capacity factor ‘ . I
8 3.0000 201.97 1.0000 1.0000
5 3.0000 301.97 1.0000 1.0000
4 3.0000 301.97 1.0000 1.0000
3 3.0000 301.97 1.0000 1.0000
2 3.0000 301.97 1.0000 1.0000
1 3.0000 301.97 1.0000 1.0000
Sum 18.0000 1811.82
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Floor number | Floor height ‘ Area(m?) ‘ Factor ’ Capacity factor l
6 3.0000 301.97 1.0000 1.0000 *
5 3.0000 301.97 1.0000 1.0000
3 3.0000 301.97 1.0000 1.0000 &
2 3.0000 301.97 1.0000 1.0000
1 3.0000 301.97 1.0000 1.0000
Sum 18.0000 1811.82
4 ole
U el0
Bt

Etaj separat:faceti clic pe buton FEI si selectati unul sau mai multe etaje din lista.Atunci cand
aceleasi elemente de interio sunt lipite de alte etaje, acest instrument ajutd la deconectarea

etajului selectat de altele, atunci cand modificati etajul separat, celelalte nu vor fi schimbate.

Floor Properties

= [E] =

Floor number | Floor height | Area(m?) |
301.97

4 301.97

3 3.0000 301.97 1.0000 1.0000
2 3.0000 301.97 1.0000 1.0000
1 3.0000 301.97 1.0000 1.0000

1811.82

Modificati elementele de interior, cum ar fi mobilierul sau peretii din etajul selectat.
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Floor Properties
B 8 =

Floor number | Floor height | Area(m?)

3.0000 301.97
301.97

Faceti dublu clic pe alte podele lipite pentru a vedea elementele interioare la locul lor (nu au fost modificate).

Floor Properties % -

= g =
Floor number | Floor height ‘ Area(m?) | Factor ‘ Capacity factor |
6 3.0000 301.97 1.0000 1.0000 r

5 3.0000 301.97 1.0000 1.0000

2 3.0000 301.97 1.0000 1.0000

1 3.0000 301.97 1.0000 1.0000
18.0000 1811.82

Sum

®

™

Delete bonded FlooR: Faceti clic pe buton i—}g selectati un etaj definit in lista pentru a sterge etajul specificat din

—
etajul cu mai multe instante.
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Floor Properties

8 &[]

Floor number | Floor height ‘

Continue?

o All interior entities bound to this floor will be deleted.

Floor Properties

CIREEIRIE

Floor number l Floor height |
3.0000

Area(m?)
301.97

301.97
301.97
301.97
1811.82

| Factor
1.0000

1.0000
1.0000
1.0000

| Capacity factor I
1.0000

~

Indltimea podelei: Afiseaza indltimea fiecarui etaj, poate fi modificata manual.

Q ©®@ © ®

Zona: Afiseaza suprafata geometrica a etajului curent.
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(4) Numar de etaje:

Properties

Numarul de etaje B Building

Building name new type
deasupra si  sub Color attached to layers W 220.173,

Building height 25
pamant poate fi Floor properties

Humber of floors above ground
mOdiﬁcat, iar Humber of floors underground

Indoor and outdeor height difference
cladirea se modifica Base arealnl)

Apron
in mod dinamic in Floot Tine

. Elevation 0. 0000

consecm',ca. Tatel tarealmi)

Above zroundim’)

(5) Diferenta de Tnaltime

Under zroundim® ) 0.00

intre interior Si
exterior: Diferenta
dintre podeaua interioara si cea exterioara de la parter, care trebuie indicata atunci cand
nu exista un etaj deasupra solului.

(6) Inaltimea deasupra solului a subsolului: indltimea subsolului deasupra solului; acest
element nu este afisat daca nu exista subsol.

(7) Suprafata de baza: Software-ul calculeaza suprafata de baza pe baza conturului cladirii si
nu poate fi modificata..

(8) Sort: Liniile de podea pot fi activate si dezactivate.

(9) Elevatia: Citeste coordonatele z ale cladirii in scena; poate fi modificat manual.

Note:

@ Extrudarea planurilor si a volumelor genereazad automat cladiri cu numarul corespunzitor de etaje, in
functie de Tnaltimea implicita a etajelor.
(@ Datele din paleta de proprietati se actualizeaza in timp real in timpul extrudarii.

2.4.2 Sectiunea transversala Extrudare

Extrude un plan Tntr-un volum sau solid 3D. Selectati "Home Tab > Building Panel > EE Cross-section Extrusion”,
mutati cursorul pe plan, tineti apasat butonul din stanga pentru a extruda sau introduceti o distanta. Exista doua tipuri

de extrudare.

1. Extrudare directa cu orice muchii plane ca limita.
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2. Tastati "S" si apasati Enter pentru a extruda cu marginile cele mai exterioare ale unui plan ca limita atunci cand

liniile sau marginile impart planul. Nota:

@ Atunci cdnd nu este specificata nicio limita, marginile unui plan sau volum, sau alte linii de pe plan,

na

impart" un plan Tn mai multe zone, iar cursorul se va fixa pe una dintre zonele individuale, extrudand-
o Intr-un volum; atunci cand este specificata limita entitatii, marginile din afara entitatii selectate nu

"T

vor mai

mparti" intervalul entitatii.

(@ Atunci cand se efectueaza extrudarea sectiunii transversale asupra unui volum, volumul nou generat
este parte integrantd a entitatii originale, ceea ce reprezinta o extrudare si o transformare locala a
entitatii originale. intrucat liniile sau planurile de pe volum sunt utilizate pentru a imparti un plan dat

in parti si actioneaza ca linii auxiliare.
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(® Dupa cum se arata mai jos, este convenabil sa extrudeti planuri de sectiune pe o cladire.

2.4.3 Galeria cladirii

Houseplan 1.0 ofera o gama largd de contururi de baza pentru cladiri si permite organizarea activelor de
constructie prin adaugarea, stergerea si modificarea operatiilor pe galeria de cladiri, oferind un acces usor la proiectele

de proiectare.
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Selectati "Home Tab > Building Panel >

Building Gallery" pentru a deschide urmatoarea casetd de dialog.

Building Gallery X
Vi i ,
Ar Delete R {E ’ (;—tj
Bu cl
Te i 002 003 004

Rename
Import DWG -
Import Resource [f;:] i :'
Export Resource 006 007 008
00s
New
Area(m3?): 208.77 Outline: 16.5600 x 15,1100

1. Aplicarea galeriei: Trageti conturul cladirii direct Tn spatiul de lucru.

001

005

013

)|

o
(=]
0

Area(m?): 410.50

002 003 004
E B B
006 007 008
E B B
010 011 012
E B B
014 015 016

Outline: 41.0000 x 16,0000

2. Nou: Faceti clic dreapta pe un spatiu liber din lista de galerii pentru a crea o noua galerie.
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3. Editati galeria: Faceti clic dreapta pe numele galeriei pentru a afisa meniul contextual, asa cum se arata mai
sus.

(1) Se sterge: Elimina din lista titlul de galerie selectat.
(2) Clear (Stergere): Elimina toate contururile cladirilor din titlul de galerie selectat.
(3) Redenumire: Schimba numele titlului de galerie selectat.

(4) Import DWG: Schitele cladirilor pot fi importate in galerie prin selectarea comenzii "Import DWG",

care aduce caseta de dialog g
Import file X

prezentatd mai jos. I ]
Floder path(dwag file):
@ Introduceti direct sau C:\Program Files\Gstarsoft\Houseplan\sample\dwg @

faceti clic pe buton Specify the balcony layer name(Others are buildings):
YT

pentru a selecta

n . Confirm Cancel
dosarul in care trebuie

importate desenele.

@ Introduceti numele
stratului balconului la Specify
Balcony Layer Name, iar
entitatile pentru celelalte
straturi au ca valoare implicita

conturul cladirii.
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@& Erase i| Explode IZj Boolean L..

NOte: [£= Offset [B, Stretch 4k Mirror /g
Layer
Properties ~

+$+Move () Rotate *3 Copy /- vig v

@ Desenul importat Modify ¥
trebuie sa fie linii Tnchise,
iar straturile trebuie sa fie
regularizate.

@Schita cladirii
importata de
utilizator trebuie sa
fie un fisier in format
dwg, iar unitatile de

masura ale desenului

trebuie sa fie 1n

metri.

(5) Resurse de export, Resurse de import.

(D Exporta desenele de contur ale clddirii din aceastd categorie, precum si fisierele *.bmp si *.ini

generate din desenele *.dwg ale conturului cladirii, ca fisiere comprimate in format *.zip.

@ Importi fisierul *.zip exportat in galerie.

Building Gallery X

[vil} 11—
Ap: Delete {:ﬂ Q
Bur Clear
Ter 002 003 004
Rename
Impeort DWG
Impoert Resource [:::} .i :
Export Resource 006 007 008
00s 010 011
Area(m3): Outline:
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HousePlan Contents > HousePlan Building Gallery Resources

Name 8- villazip (evaluation copy)

B 009 File Commands Tools Favorites Options Help

B Gallery Resource ﬁ . B I "[T 9 \‘

w21 villa.zi 3
P Add x‘tract To Test View Delete Flnd Wiza

$ ‘ {28 villa.zip - ZIP archive, unpacked size 682,717 bytes

~

Name

&| 001.bmp
5’ 001.dwg
5] 001.ini

&| 002.bmp
8 002.dwg
57 002:ini

&| 003.bmp
¥ 003.dwg
57 003.ini

&| 004.bmp

L] Total 33 files, 682,717 bytes

Notela import, utilizatorul va fi intrebat daca importa prin adaugare, selectati "Da" pentru a pastra
desenele de contur existente in cadrul categoriei si aimporta toate desenele din *.zip Tn galerie si a inlocui
direct fisierele cu acelasi nume; selectati "Nu" pentru a sterge desenele de contur existente Tn cadrul
categoriei si a importa schita cladirii in *.zip.

4. Stergeti: Faceti clic dreapta pe conturul cladirii pentru a o sterge.

5. Construirea atributelor plane: Dimensiunile conturului cladirii si suprafata stratului unic al acesteia, precum si

tipul de gospodarie, pot facilita analiza Building Gallery X
e Vila
statistics.. Fia E . @ .
Bungalow
Terrace 002 003

(1) Suprafata: suprafata bazei cladirii.

(2) Contur: lungimea si latimea conturului cladirii. E

005 006 007
Note:
009 010 011
@ Suprafata nu include suprafata
Area(m?): 745.76 Outine: 42.8400 x 21.6600 l
de baza a balconului.

@ Dupa ce cladirea este extrudata,
software-ul calculeaza automat numarul de gospodarii care vin cu cladirea, precum si informatiile
despre tipul de gospodarie.
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2.4.4 Balcon

Introduce balcoane prestabilite sau personalizate pe cladiri. Selectati "Home Tab > Building Panel > -gg

Balcony" pentru a deschide urmatoarea caseta de dialog.

Balcony
© Convex balcony (' Concave balcony | Concave/Convex balcony
Mode  Custom
2
————————3
3 4
w: [3.6000
Gl 17
N L H1: |0.6000 v
5 6
(isinge ©@Column | |Middle

1. Tipuri de balcoane: Convexe, concave si concave-convexe.

2. Exista doua moduri de a defini un
balcon convex:

(1) Mod: Introduce balcoane in functie
de parametrii setati.

(2) Personalizat: Defineste balconul pe
baza conturului unui plan existent.

3. Puteti seta manual latimea, adancimea,

grosimea si ndltimea tipului de balcon
selectat.
4. Metoda de insertie:

(1) Singur: Introduce cate un balcon odata.

Page 28 of 241



Houseplan 1.0 Make stunning 3D scheme with speed and ease

Balcony
© Convex balcony () Concave balcony () Concave/Convex balcony

Mode  Custom

Il oA

Rl i

H1: [0.6000 H2: [0.9000

> |

Ocam s

© Convex balcony () Concave balcony (| Concave/Convex balcony

Mode  Custom

_

S

1 N

0.8000 v

H2:

(2) Coloana: Genereaza un balcon la etajul selectat, precum si la fiecare etaj de deasupra acestuia.

(3) Mijlocul: Fixeazd automat punctul central al unei muchii a planului cladirii.
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Balcony

© Convex balcony () Concave balcony () Concave/Convex balcony

Mode  Custom

I Single IOColumn I : Middle

\ -

5. Insertie directa: Selectati tipul de balcon, setati dimensiunea, selectati metoda de insertie, apoi faceti clic pe
butonul "Insert". Dupa selectarea etajului suprateran al cladirii, specificarea marginii si introducerea
distantei, balconul va fi inserat cu succes.

6. Insertie personalizata: Selectati balconul convex, treceti la fila "Personalizat", setati dimensiunea, selectati
metoda de insertie, faceti clic pe butonul "OK". Dupa selectarea unui plan orizontal (planuri care nu sunt
cladiri de suprafata) fara gauri si dupa selectarea etajului suprateran al cladirii, balconul va fi inserat.

Note:

@ La inserarea unui balcon, Houseplan 1.0 genereaza automat sorturi de apa la balcoanele de la primul
eta;.

@ Inserarea de balcoane prestabilite va face automat un colt atunci cdnd acestea intalnesc unghiurile
cladirii.

(® Atunci cand se defineste un balcon convex, in cazul in care metoda de insertie a pozitiei originale nu este
bifata, muchia cea mai apropiata de punctul in care s-a facut clic pe cursorul din planul selectat va fi
evidentiata cu rosu, iar aceasta muchie va fi specificata ca muchie de insertie.

@ Dupa inserarea unui balcon, proprietatile acestuia pot fi modificate in paleta de proprietéti.

(® Prinderea marginii planului clddirii activeaza liniile auxiliare la inserarea balcoanelor pentru a facilita o
insertie precisa.
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2.4.5 Fereastra

Insereaza ferestre predefinite sau personalizate pe cladiri. Selectati "Home Tab > Building Panel > Window"
pentru a deschide caseta de dialog prezentata mai jos.

© Flat window ( Bulge Window () Bay window
Mode  Custom

Windowsill height:

|| window cover
Width:
Depth:

Glass dE‘DthI

(Single ©@Column | |Middle Insert

1. Tipuri de ferestre: Fereastra platd,
cu protuberanta si cu goluri. Exista
douda moduri de a defini o
fereastra plata:

(1) Mod: Insereaza ferestrele in
conformitate cu parametrii setati.

(2) Personalizat: Defineste fereastra

pe baza conturului unui plan

existent.
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2. Puteti seta manual latimea, adancimea, grosimea si Thaltimea tipului de fereastra selectat.

3. Metoda de insertie:

(1) Singur: Introduce o fereastra pe rand.

Window

©Flat window () Bulge Window () Bay window
Mode

m. 'h. N.

°
{
:
=
v

Window

O Flat window () Bulge Window () Bay window

Glass depth: {

Width:
Depth;

Glass depth:

W: |1.8000
H:

Depth; |0.1000
Insert

(2) Coloana: Genereaza o fereastra la etajul selectat, precum si la fiecare etaj de deasupra acestuia.
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(3) Mijlocul: Fixeaza automat punctul central al unei muchii a planului cladirii.

() Bay window

© Flat window
Mode  Custom

1
3

) Bulge Window

Width:

Depth:

Glass depth:

4. Insertie directa: Selectati tipul de fereastra, setati dimensiunea, selectati metoda de insertie, apoi faceti clic
pe butonul "Insert". Dupa selectarea etajului suprateran al cladirii, specificarea marginii si introducerea
distantei, fereastra va fi inserata cu succes.

5. Insertie personalizata: Selectati fereastra plata, treceti la fila "Custom" (Personalizat), setati dimensiunea,
selectati metoda de insertie, faceti clic pe butonul "OK". Dupa selectarea unui plan orizontal, a planurilor
care nu sunt suprafete de cladiri fara gauri si dupa selectarea etajului suprateran al cladirii, fereastra va fi
inserata.

Note:

@ Atunci cand se personalizeazd o fereastra pland sau convexd, fereastra genereaza direct la locatia planului

daca planul se afla pe un perete al cladirii.

@ Inserarea ferestrelor prestabilite va face automat un colt atunci cdnd acestea intdlnesc unghiuri
arhitecturale.
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(® Atunci cand se defineste o fereastra de tip "bay window", dacd metoda de insertie a pozitiei originale nu
este bifata, marginea cea mai apropiata de punctul in care s-a facut clic pe cursorul din planul selectat

va fi evidentiata cu rosu, iar aceasta margine va fi specificatd ca margine de insertie.

2.4.6 Usa

Insereaza usi prestabilite sau personalizate pe cladire. Selectati "Home Tab > Building Panel > Door" pentru

a deschide caseta de dialog prezentata mai jos.

Mode  Custom

1 2

| Lt
3 4
5 6

w: (18000
H: [2.1000

[[] Door cover width: |0.1500
Door cover depth: VO.OSOO

[] Mumber of steps; |3
Step width; | 1.3000

[]  Awning height: |3.0000

(_isingle @ Column | | Middle

1. Exista doua moduri de a defini o usa:
(1) Mod: Introduce usile in functie de parametrii setati.
(2) Personalizat: Defineste usa pe baza conturului unui plan existent.

2. Puteti seta manual Iatimea, adancimea, grosimea si Thaltimea tipului de usa selectat.
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3. Metoda de insertie:

(1) Singur: Introduce o usa pe rand.

(2) Coloana: Genereaza o usa la etajul selectat, precum si la fiecare etaj de deasupra acestuia.

(3) Mijlocul: Fixeazd automat punctul central al unei muchii a planului cladirii.

4. Insertie directa: Selectati tipul de usa, setati dimensiunea, selectati metoda de insertie, apoi faceti clic pe
butonul "Insert". Dupa selectarea etajului suprateran al cladirii, specificarea marginii si introducerea distantei,
usa va fi inseratd cu succes. 5. Insertie personalizata: Selectati usa, treceti la fila "Custom" (Personalizat), setati

dimensiunea, selectati metoda de insertie, apoi faceti clic pe butonul "OK". Dupa selectarea unui plan orizontal
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(planuri care nu sunt suprafete de cladiri) fara gauri si dupa selectarea etajului suprateran al cladirii, usa va fi
inserata.

Note:

@ Inserarea sau desenarea de usi presetate vor face automat colturi atunci cand acestea tntalnesc unghiuri
arhitecturale.

@ Tn cazul in care o clddire are un nivel de subsol, insertia usilor se face separat deasupra si sub pamant.

(® Atunci cand se insereaza o usd, marginea cea mai apropiata de punctul de clic al cursorului, atunci cand

planul este selectat, este evidentiata cu rosu, iar aceasta margine este utilizata ca margine de insertie.
2.4.7 Acoperis

2.4.7.1 Perete de parapet crenelat

Un parapet crenelat este un zid jos in jurul acoperisului unei cladiri, care serveste ca protectie. Selectati "Home

Tab>BuildingPanel

Rooftop > Crenelated Parapet Wall" si introduceti o valoare pentru a determina indltimea parapetului crenelat.

Note:

@ Peretele crenelat al parapetului se ia in considerare pentru inédltimea cladirii, indltimea cladirii = diferenta
de Tnaltime intre interiorul si exteriorul cladirii + (indltimea etajului * numarul de etaje) + Tnaltimea
parapetului crenelat.

@ La vopsirea materialului, peretele crenelat al parapetului si volumul principal al cladirii sunt vopsite
separat, iar la vopsirea peretelui crenelat al parapetului, este disponibilda o metoda de vopsire pe o

singura fata.
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2.4.7.2 Acoperis plat

Acoperisul plat este un tip de acoperis exterior cu o forma de acoperis usor care poate fi transformat intr-o terasa,

o gradina pe acoperis etc. Aceastd caracteristica este utilizata pentru a adauga un acoperis plat la o cladire. Select

"Home Tab > Building Panel > &8 Rooftop > Flat Rooftop" and select the top plane of the building to create.

@ Acoperisurile plate nu se iau Tn considerare pentru Tnhaltimea cladirii.
®) Paleta de proprietati va permite sa modificati inaltimea de inundatie, unghiul de elevatie,

grosimea, lungimea streasina si tipul de extensie.
2.4.7.3 Acoperis inclinat

Acoperisul inclinat este generat automat pe baza conturului acoperisului cladirii si a parametrilor setati. Selectati "Home

Tab > Building Panel >

Sloped Roof X

Rooftop > Sloped Rooftop" pentru a deschide caseta

Number of slopes: Full slope ~

Slope gradient: 30.00

Eaves: 1.0000

Confirm Cancel
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1. inclinatie completa: Genereaza automat un acoperis cu pantd completd pe baza conturului acoperisului. Dupd
ce setati panta si streasina, faceti clic pe butonul "Confirm" si selectati planul superior al cladirii pentru a-I

genera.

Number of slopes: ~ Full slope v
Slope gradient:  30.00

Eaves:  1,0000

Confirm Cancel

2. Pantadubla: Generati un acoperis inclinat cu doud pante. Dupa ce ati setat panta si streasina, faceti clic pe
butonul "Confirm" si exista doua moduri de a le genera.
(1) Generarea frontonului: Selectati un singur plan vertical al unei cladiri pentru a genera un fronton.
(2) Generati mai multe frontoane: Introduceti "D" si apasati enter, selectati un plan vertical al cladirii, iar

toate planurile verticale Tn aceeasi directie cu planul respectiv vor genera un fronton.
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3. Patru pante: Genereaza un acoperis cu patru pante. Dupa ce ati setat panta si streasina, faceti clic pe butonul
"Confirm" (Confirmare).

4. Arc de sus: Creeaza un acoperis curbat. Dupa ce ati setat panta si streasina, faceti clic pe butonul "Confirmare".

5. Descrierea parametrilor acoperisului inclinat complet: Odata selectat un acoperis inclinat, proprietatile

acestuia pot fi vizualizate in paleta de proprietati, dupa cum se arata mai jos.
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(1) Tnaltimea placii de agitat:

Properties
B Slope Roof

Stabileste Tnaltimea placii de
agatat.

(2) Tipul de panou de extensie:
Comutare intre peretele plat si

balconul adiacent. Detailed parameter

Aoy, N . Flat top hr‘.-'sght
(3) Inaltimea varfului plat: e
zing board enclosure

Introduceti o valoare pentru ca

acoperisul sa se aplatizeze din
partea superioara.

(4) Parametru detaliat: Pentru a modifica panta si streasina unui acoperis inclinat, faceti dublu clic direct

pe acoperis sau faceti clic pe butonul " * "' al parametrului detaliat pentru a deschide caseta de dialog

prezentatd mai jos.

Edit Sloped Roof

Faceti clic pe "Slope" sau "Eave" pentru a modifica valoarea acesteia. Faceti clic pe butonul "Confirm"
(Confirmare) pentru a regenera acoperisul in conformitate cu noii parametri.
(5) inchiderea panoului de suspendare: Setati dacd panoul de suspendare este inchis sau nu.

Note:
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(@ Acoperisurile cu panta completa create nu pot schimba stilul pe paleta de proprietati.
(@ Dupa modificarea inaltimii acoperisului plat, acoperisul nu poate fi arcuit.

(® Acoperisul arcului nu suporta placa de suspendare inchisa.

@ La modificarea parametrilor detaliati, poate fi generat un fronton dacé panta este modificata la 90 de
grade.

® Acoperisurile nclinate se iau in considerare pentru indltimea clddirii. indltimea cladirii = diferenta dintre
inaltimea interioara si cea exterioara +

(Tnaltimea etajului * numarul de etaje) + jumatate din inaltimea acoperisului inclinat.

6. Descrierea parametrilor acoperisului Arc: Odata selectat un acoperis in arc, proprietatile acestuia pot fi

vizualizate n paleta de proprietati,

Properties
dupa cum se arata mai jos. = Slope Roof
Color 77,114, 155
(1) Indltimea plansei de agdtat: Setati T T | 4448
N ules o < Hanging board height 0. 3000
naltimea placii de agatat.
Style Arc top
(2) Stil: Comutati Tntre panta dubla, patru Slope gradient 30. 0000

Eaves length

pante si varful arcului.
on arealm’)

(3) Inclinatia pantei: Introduceti o valoare Hanging board enclosure

pentru a face ca arcul acoperisului sa-si
mareasca sau sa-si micsoreze raza.
(4) Lungimea streasinii: Introduceti o valoare pentru a mari lungimea de streasina a acoperisului in arc de
cerc.
(5) inchiderea panoului de suspendare: Setati dacd panoul de suspendare este inchis sau nu.
7. Descrierea parametrilor acoperisului cu panta dubla: Odata selectat un acoperis cu panta dubla, proprietatile

acestuia pot fi vizualizate in paleta de proprietati, dupa cum se arata mai jos.
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(1) Tnaltimea plicii de agitat:

C o urys .. Properties
Setati naltimea placii de 8 Sloge Eoof
agétat. I:I:Ill:xr
Room plane height
(2) Stil: Comutati intre panta trie bow Ikt

dubla, patru pante si varful

arcului. Flat top height

N e, N . Tuwrn rooftop into arc
(3) Indltimea  varfului  plat:

Detailed parameter

Introduceti o valoare pentru ... Hanging board enclosure

ca acoperisul sa se aplatizeze

din partea superioara.

(4) Transformarea acoperisului in arc de cerc: Faceti clic pe butonul din paleta de proprietati pentru a
deschide caseta de dialog prezentatda mai jos, setati parametrii arcului de cerc si apoi faceti clic pe

butonul "Confirm" pentru a arcui acoperisul.

Turn Rooftop Into Arc

Chute length: 1.0000

Chute gradient: 20

Chute ratio(%): 25

(5) Parametru detaliat: Modificarea pantei si a streasinii unui acoperis inclinat.

(6) inchiderea panoului de suspendare: Setati dacd panoul de suspendare este inchis sau nu.
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2.4.7.4 Fereastra de mansarda

Introduce o lucarnd pe acoperisul inclinat. Selectati "Home Tab > Building Panel > Rooftop > Dormer
Window" pentru a deschide caseta de dialog prezentatd mai jos. Selectati fereastra de mansarda si specificati locatia

pe acoperisul inclinat pentru a o introduce.

Place Dormer Window

W m N -

Double slope  Three slopes Flat top Full sloped top

W

Arctop  Flatrooftop  Arcrooftop  Flat window

Place Dormer Window

M m m -

Double slope  Three slopes Flat top Full sloped top

M i w

Flat rooftop Arc rooftop Flat window

Note:

(@ Acoperisurile curbate si acoperisurile inclinate care sunt arcuite nu permit inserarea de ferestre de
mansarda.

(@ Puteti modifica proprietatile ferestrelor de mansarda direct in paleta de proprietati.
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2.4.8 Copertina

Insereaza copertina pe cladire conform parametrilor setati. Selectati "Home Tab > Building Panel >

Awning" pentru a deschide urmatoarea

caseta de dialog.

Mode  Custom

marchiza:

(1) Mod: Introduce copertine Height:  [2.7000 .

n conformitate cu

1. Exista doua moduri de a defini o

(iSingle  © Column [ middle

parametrii setati.

(2) Personalizat:  Defineste
marchiza pe baza conturului unui plan existent.
2. Puteti seta manual latimea, adancimea, grosimea si Thaltimea tipului de copertina selectat.
3. Metoda de insertie:

(1) Singur: Se introduce cate o singura copertina pe rand.
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(2) Coloana: Genereaza o copertina la etajul selectat, precum si la fiecare etaj de deasupra acestuia.

(3) Mijlocul: Fixeaza automat punctul central al unei muchii a planului cladirii.

Mode  Custom

o s
e o~
o o
o o
o o
o o
< <

Height: 2,7000 v

© column Middle

4. Insertie directa: Selectati tipul de copertina, setati dimensiunea, selectati metoda de insertie, apoi faceti clic
pe butonul "Insert". Dupa selectarea etajului suprateran al cladirii, specificarea marginii si introducerea
distantei, marchiza va fi inserata cu succes.

5. Insertie personalizata: Selectati marchiza, treceti la fila "Personalizat"”, setati dimensiunea, selectati metoda
de insertie, faceti clic pe butonul "OK". Dupa selectarea unui plan orizontal (planuri care nu sunt suprafete
de cladiri) fara gauri si dupa selectarea etajului suprateran al cladirii, se va insera marchiza.

Note:

@ finclinarea automat a copertinelor inserate atunci cand acestea intalnesc unghiurile cladirii.

(@ Puteti modifica proprietatile unei marchize direct din paleta de proprietati.

2.4.9 Scariin aer liber

Introduce scari exterioare pe cladire in functie de parametrii setati. Selectati "Home Tab > Building Panel >
Outdoor Stairs" pentru a deschide urmatoarea fereastra de dialog.
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Outdoor Stairs

A Direction: Clockwise v
B: 5.4000 © Top cover () Top rooftop

Run to the
accompanying
wall

Railings: 1.0000 [ Imiddle

1. Exista doud moduri de a o genera:

(1) Insert: Introduceti scarile direct in functie de parametrii setati. Faceti clic pe butonul "Insert" (Inserare),

selectati etajul superior al cladirii si inserati-o prin specificarea directa a locatiei sau prin obtinerea unei

muchii de pozitionare si introducerea distantei.

(2) Personalizat: Definiti scdrile pe baza planurilor existente. Facand clic pe butonul "Custom" (Personalizat),

sunt posibile doua tipuri de insertie.

@ Seintroduce cu peretele: Selectati un plan dreptunghiular, apoi selectati etajul superior al cladirii si
specificati direct sau obtineti linia marginii de pozitionare si introduceti distanta de insertie.

@ Introduceti-l in pozitia initiald: Introduceti "Y" si apasati Enter, apoi selectati un plan dreptunghiular,
faceti clic pe o suprafata a etajului suprateran al cladirii, apoi puteti insera scarile exterioare folosind
pozitia planului dreptunghiular ca referinta.

2. Nota privind parametrii:

(1) Directia: Setarea directiei de functionare a scarilor: in sensul acelor de ceasornic si in sens invers acelor de
ceasornic.

(2) Capacul superior: Scari de reglare cu sau fara garnitura.

(3) Acoperisul superior: Daca scarile ajung pe acoperis.
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(4) Alergati spre peretele aldturat: Dacd balustrada de pe o parte a scarii este lipita de perete.
(5) Mijlocul: Fixeaza automat punctul central al unei muchii a planului cladirii.

(6) Balustrade: Stabileste Tnaltimea balustradelor.

Note:

(@D Generarea automata a sorturilor pentru scarile exterioare.

(@ Puteti modifica proprietatile scarilor direct pe paleta de proprietati.
2.4.10 Perete cortina din sticla

Defineste sau deseneaza un perete cortina de sticla pe un perete de cladire. Selectati "Home Tab > Building Panel

> [E Glass Curtain Wall" pentru a deschide urmatoarea caseta de dialog.

Glass Curtain Wall X

OO D

Frame width: ~ 0.0000

Frame depth:  0.0000

Unit width: ~ 3.0000

Unit height: ~ 3.0000

Dupa selectarea unui tip de perete cortina si setarea parametrilor acestuia. Exista patru moduri de a genera un
perete cortina din sticla.

_—
1. Definiti peretele cortina din sticla in functie de peretele sau planul cladirii. Faceti clic pe butonul Lﬂ_l , selectati

un perete al cladirii pentru a genera un perete cortina de sticla.
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il

2. Generarea unui perete cortind din sticla pe toti peretii cladirii. Se genereaza facand clic pe buton si selectand

cladirea cu etaje supraterane.

=
-
3. Desenati peretele cortina din sticla pe peretele cladirii in functie de Iatime. Faceti clic pel['#l'| buton, Plasati cursorul peste

zidul unei cladiri si sa precizeze trei puncte pentru a finaliza operatiunea. Pentru a desena prin alti pereti ai

cladirii, introduceti "C" si apasati ENTER.
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Desenati peretele cortind poligonal din sticla pe peretele cladirii. Faceti clic pe IG]

4. pentru a desena peretele cortind de sticla sub forma unui poligon.

R N
R N
R N
R N
-

A

Note: Paleta de proprietati permite reglarea latimii marginii, a adancimii marginii, a latimii unitatii si a Tnaltimii
unitatii.

2.4.11 Accesorii pentru cladiri

Anexele sunt decoratiuni care sunt amplasate in afara zidurilor cladirilor. Selectati "Home Tab > Building Panel >

Draw

Attachments" pentru a deschide caseta de dialog prezentata mai jos.
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Building Attachment

Cross-section style

custom

Custom Cross-sectionl

=

Cross-section2 [Cross-section3

/D

Cross-sectiond  Cross-section5

Width(w): 0.500

1 Height(h):  1.500
I P; S

Cross-section6  Cross-section? Stratum  Along edge Draw  Interrupt g

1. Metoda de insertie:

(1) Singur: Desenarea unui singur atasament odata.

(2) Coloana: Genereaza cate un atasament pentru fiecare etaj din etajul selectat si mai sus.
2. Exista doua moduri de a o genera.

(1) Generarea de anexe pe baza sectiunilor transversale existente:
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@ Faceti clic pe butonul "Stratum", selectati etajul superior al cladirii, fixati si obtineti marginea de

@ Click "Along edge" button, select the edge of the

building or building wall, left-click to end the
drawing and specify the orientation.

@ Click the "Draw" button, select the edge of the
building or building wall, left-click to end the

drawing and specify the orientation.
(2) Generate attachment according to custom cross -section:

Take "stratum" as an example, click the "stratum" button,

select a plane or ling, select one side of the plane or line

pozitionare. linie, introduceti distanta si specificati orientarea pentru a genera atasamentul. ca linie de

baza si specifica punctul de baza de insertie. Trebuie sa selectati etajele supraterane ale cladirii pentru
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a determinati unde sa addugati atasamentul, apoi selectati calea rosie sau introduceti distanta pentru

a specifica o calesi, in cele din urma, specificati orientarea sectiunii pentru a o genera.

3. intrerupeti: Faceti clic pe butonul "Interrupt" si specificati doud puncte de pe atasamentul care trebuie
intrerupt.

Page 52 of 241



Houseplan 1.0 Make stunning 3D scheme with speed and ease

Note:

(@ Puteti modifica obiectul atasat in paleta de proprietati.
@ Numai parametrii "W", "H" pot fi modificati in stilul sectiunii transversale.

(® La personalizarea sectiunii, atasamentul este desenat ca solid dacé este selectat un plan sau gol daca

este selectata o linie inchisa.

2.4.12 Mutarea componentelor

Schimba pozitia unor componente precum ferestrele, usile, copertinele si scarile din cladire. Selectati "Home Tab >
Building
—y

=
Panel > =1 Move Components", selectati componenta si apasati Enter, apoi trageti cu mouse-ul sau introduceti

distanta de la punctul de baza specificat pentru a le muta.
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. —

Note:

@ Elementele in miscare sprijina selectia de balcoane, ferestre, usi, copertine, scari in aer liber, pasi de-a

lungul liniei si stratificarea zonei.

(@ Atunci cand se specificd punctul de bazd, componenta trebuie sa fie specificatd pe planul vertical al
cladirii.
(® La deplasarea unei componente, componenta se deplaseaza de-a lungul planului vertical lateral al

cladirii.
2.4.13 Arata etajele
=
Ascunde sau nu ascunde un etaj selectat al cladirii. Selectati "Home Tab > Building Panel > B8 Show Floors"

pentru a selecta un etaj, iar etajele de deasupra etajului selectat vor fi ascunse, aratand structura interioara si

facilitand vizualizarea aspectului interior al cladirii. Dati din nou clic pe cladire pentru a readuce cladirea la starea sa

initiala.

Page 54 of 241



Houseplan 1.0 Make stunning 3D scheme with speed and ease

2.4.14 Desenati perete

Deseneaza peretii interiori din interiorul unei cladiri. Selectati "Home Tab > Building Panel > Draw Wall"

pentru a deschide urmatoarea caseta de dialog.
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Draw Wall

B a

et O Mdde Right

1
G

0,0000

Height: 3.0000 Blevation:

1. Desenati pereti: Dupa setarea parametrilor in caseta de dialog, selectati Perete drept, Perete curbat sau
Perete dreptunghiular si specificati punctele de inceput si de sfarsit. Puteti schimba tipul de perete in linia de
comanda. Puteti desena continuu, introduceti "U" pentru a va intoarce la pasul anterior si faceti clic dreapta
pentru a incheia desenul.

2. Descrierea parametrilor: Peretele are trei directii: stdnga, mijloc si dreapta. Grosimea peretelui, indltimea
peretelui si elevatia pot fi setate.

Note:

(@ Bifati casuta "Elevation" pentru a specifica indltimea ca inaltime a peretelui, altfel utilizati indltimea
implicita ca inaltime a peretelui.

(@ Puteti modifica proprietatile peretelui in paleta de proprietati.

(® Zidurile desenate au puncte de prindere care pot fi trasate direct si puncte de intersectie de fuziune.

@ Linia de comanda permite desenarea peretelui in mod continuu, faceti clic dreapta la sfarsit pentru a

continua desenul, faceti clic dreapta din nou pentru a termina desenul, apasati tastatura Escape pentru

aiesi din desen.

(® Schimbarea parametrilor in timpul desenarii poate fi continuata cu noii parametri.

(® Data viitoare cand deschideti caseta de dialog, directia si parametrii ultimului perete setat sunt retinuti.
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2.4.15 Gaura in podea

Deseneaza zone goale pe etajul selectat al cladirii. Selectati "Home Tab > Building Panel > Floor Hole pentru

a deschide urmdatoarea caseta.

Floor Hole

0

Starting floor:
Ending floor:

1. Tragere la sorti: Dupa setarea parametrilor, faceti clic pe butonul "Draw" si desenati direct Tn punctul specificat
pe podea. Puteti desena continuu, introduceti U pentru a reveni la pasul anterior si faceti clic dreapta pentru

a Incheia desenul.
2. Definitie: Selectati obiecte cum ar fi planuri, linii inchise si planuri spline pentru a genera.

Note:

@ Gaurile sunt subentitati ale cladirilor si balustradele sunt subentitati ale gaurilor; balustradele se schimba

pe masura ce se schimba forma gaurii.

@ Instantele dintre fiecare strat de balustrade sunt modificate impreund: modificarea unui etaj modifica

toate celelalte etaje; cu toate acestea, un etaj poate fi eliminat individual fara a afecta celelalte etaje.
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2.4.16 Desenati balustrade

Deseneaza balustrade pe o anumita entitate. Selectati "Home Tab > Building Panel > .l:[‘ Draw Railings" pentru

a deschide caseta de dialog prezentata mai jos.

Draw Railings

4@l ¥

=

Sarngfoo:
S—

Railings height(h): 1.0000

Railings edge-distance(w):  0.1000

1. Desenati de-a lungul marginii: Precizati punctele de Tnceput si de sfarsit pe marginea unei gauri de podea
existente sau pe marginea scarii.
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2. Desen liber: Specificati orice punct din interiorul cladirii pentru a fi desenat. 3. Desen continuu: introduceti U
pentru a va intoarce la pasul anterior si faceti clic dreapta pentru a incheia desenul.

3. Definiti calea ferata: Selectati o linie sau un plan si faceti clic dreapta pentru a converti entitatea de linie sau
planul selectat intr-o balustrada.

A
A

>

Note:

@ Etajele de inceput si de sfarsit nu sunt valabile pentru balustradele desenate pe exteriorul unei cladiri.

(@ Directia distantei balustradei de la margine: poate determina automat limita scarii sau a gdurii pentru a
compensa balustrada spre interior; nu poate determina limita pozitiei originale desenate fara

compensare.

(® Puteti modifica proprietatile balustradei pe paleta de proprietati.
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2.4.17 Scari

2.4.17.1 Scari

SelectatiHome Tab = Building Panel> Stairs > Stairs pentru a deschide caseta de dialog prezentata

R
0

Eh]
Fr

s R

% =

05 06
qllmm ~——
b ~ ,'/

pU i =

07 08

mai ios.

/@h

)

Height{h):
Length(l):

Width{w):

1. Trageti la sorti pentru a se potrivi: Adapteaza lungimea

desenarea unui dreptunghi.

3.6600
2.5600

si latimea deschiderilor de scari existente prin
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2. Selectati pentru a se potrivi: Lungimea si latimea deschiderii scarii pot fi adaptate prin selectarea unui plan

dreptunghiular.

i

—
S

4

4

3. Introduceti scara: Specifica un punct de insertie pentru a insera scara in spatiul de lucru.

4. Rotiti 90 de grade in sensul acelor de ceasornic, 90 de grade in sens invers acelor de ceasornic, 180 de grade:
Roteste scarile de pe spatiul de lucru si adapteaza lungimea si latimea cutiei de delimitare.

5. Intoarceti la stanga/dreapta, intoarceti in fatd/in spate: Se oglindeste scirile si adapteaza lungimea si |3timea
cadrului delimitator.

6. Cozi de scari: Replica matricea de scari, pornind de la nivelul de amplasare a scarii selectate si mergand in sus.
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7. Nota privind parametrii:

(1) indltime: Se potriveste automat cu iniltimea podelei atunci cand este plasat sau indltimea podelei poate
fi introdusa manual.

(2) Lungime: Specificati doua puncte ca lungime totala a scarilor.
(3) Latime: Specificati doua puncte ca latime totala a scarilor.

Note:

(D Daca scara este plasata in interiorul cladirii, indltimea scérii se potriveste automat cu indltimea podelei;
daca este plasata in afara cladirii, indltimea este dimensiunea originala.

(@ Faceti dublu clic pe modelul de scara sau trageti scara in spatiul de lucru pentru a o insera.

(® Banda din piele se fixeaza si pe pereti (interior si exterior) atunci cadnd va deplasati, copiati si urcati scari.

@ Puteti modifica proprietatile scarilor in paleta de proprietati.

2.4.17.2 Desenati scari

AL
Deseneaza o singura scara. Selectati "Home Tab > Building Panel > Stairs > BE&® Draw Stairs" pentru a
deschide caseta de dialog.
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Draw Stairs

@ =
Height of flight: 3.0000 || Starting height: |
() Step width: | 7 Railings:
© step height:  0-1500 Trend:

1. Deseneaza: Deseneaza scarile conform parametrilor setati. Faceti clic pe butonul ,Desenare” si exista doua
modauri de a-l genera.

IS
==

‘I
{W-A/

(1) Mai ntai specificati punctul de plecare pentru a determina locatia segmentului scarii, urmat de
specificarea lungimii si directiei scarii.

(2) Selectati linia de latime a scarii, introduceti ,,S” si apasati Enter, selectati linia sau marginea planului si
specificati lungimea si directia scarilor.

2. Definire: Selecteaza doua linii pentru a defini scarile. Faceti clic pe butonul ,Definiti” si selectati una dintre linii

ca nceput al scarii, apoi selectati cealalta linie lateralad pentru a crea scari.
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3. Nota parametri:

TR

(1) Faceti clic pe cuvantul ,Tndltimea zborului” in albastru pentru a specifica doud puncte ca indltimi a

scarilor.
(2) Faceti clic pe ,indltimea de pornire” cu albastru pentru a desemna un punct ca indltimea etajului scarii.
(3) Faceti clic pe ,,Latimea pasului” in albastru pentru a specifica doud puncte ca Iatime a pasului.
(4) Balustradele scarilor sunt generate in patru moduri: pe ambele parti, pe stanga, pe dreapta si niciunul.

(5) Tendinta: Scarile pot merge 1n sus sau in jos.

Note:

@ Bifati caseta de selectare inainte de ,indltimea de pornire” pentru a utiliza iniltimea introdus3 sau

specificata ca cotd a etajului scarii, altfel utilizati Tnaltimea captata ca cotd a podelei a sectiunii.

(@ Latimea pasului si inaltimea treptei sunt precedate de casete radio. Dacad unul este bifat, celdlalt
parametru va fi gri.

(® Puteti modifica proprietatile scarilor din paleta de proprietati.

2.4.18 Galeria Mobilier

Adauga elemente de mobilier, cum ar fi canapele, paturi si mese in cladiri. Selectati "Home Tab > Building Panel >

@ Furniture

Gallery", iar urmatorul dialog va aparea.
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Bajtyoon] i
B New
g Delete
K
L Clear Delete Bathtub 03
c Edit
S
- Import
Tea Table 3
Wardrobe
Children's Bath Crock Closestool 01 Closestool 02
01
Add Object
New Add File
: .4
Closestool 03 Closestool 04 Closestool 05

1. Aplicare: Faceti dublu clic sau trageti direct previzualizarea mobilierului Tn galerie pentru a o plasa n pozitia
specificata.

Note: Previzualizarile care apar cu gri in galerie se vor descarca automat daca dati clic. Ele pot fi amplasate pe
cladire

etaje numai dupa ce descarcarea este completa.
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2. Editati lista bibliotecii de entitati: faceti clic dreapta pe lista galeriei de mobilier.
(1) Nou: creeaza o noua galerie de mobilier.
(2) Sterge: sterge galeria de mobilier nou creata.
(3) Sterge: sterge toate entitatile de mobilier nou adaugate din galeria selectata.
(4) Editare: redenumeste galeria de mobilier nou creata.
(5) Import: Selecteaza un folder si importa fisierele model din interior.
3. Editeaza galeria de mobilier:
(1) Adaugati obiect: faceti clic dreapta pe un spatiu liber din galeria de mobilier, faceti clic pe , Addugati
obiect” si selectati o entitate din scena pentru a adauga.

(2) Adaugati fisier: faceti clic dreapta pe un spatiu liber din galeria de mobilier, faceti clic pe ,,Adaugati fisier”
si selectati orice *.cpi, *.fbx, *.skp, *.0sgb, *.0sg, *.0bj, *.rvt, *.3ds in caseta de dialog pop-up pentru a
adauga fisierele model.

(3) Stergeti modelul: faceti clic dreapta pe o imagine de previzualizare, faceti clic pe ,Stergeti” pentru a
sterge modelul nou adaugat.

2.5 Panoul de operatii 3D

2.5.1 Mutare

Muta entitatea selectata in functie de axele X, Y, Z. Selectati "Home Tab > 3D Operations Panel > E Move",
selectati alte entitati decat drumuri, faceti clic dreapta pentru a Tncheia selectia. Plasati cursorul pe axa, selectati
directia axiala, planul axial sau centrul axei, trageti sau introduceti o valoare pentru a determina distanta de

deplasare.
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Note:

@ Drumurile nu pot fi deplasate folosind deplasarea spatiala, care se realizeaza prin utilizarea comenzii de
mutare ,,M”.

@ Implicit la axele locale, care pot fi comutate la axele globale introducand ,S” si apdsand Enter pe linia de
comanda.

(® Cand axa este selectatd, entitatea poate fi mutata in orice directie.

@ Axa implicita este in centrul entitatii selectate, iar pozitia axei poate fi reatribuita.

2.5.2 Rotire 3D

Roteste entitatea selectata in functie de axele X, Y, Z. Selectati "Home Tab > 3D Operations Panel >
Rotate".

Note:
@ Axele implicite pot fi

comutate la axele globale

introducand ,,S” si apasand

Enter pe linia de comanda.
@ Rotatia 3D accepta selectia de

entitati, altele decat planurile

cu o singura fata,

componentele cladirii si caile

de animatie.
(® Unele entitati accepta numai rotatia axei Z, cu exceptia liniilor, planurilor si volumelor.

@ Poate fi rotit in orice unghi cand cursorul este plasat pe cercul interior al axei; cadnd este plasat pe

cercul exterior al axei, acesta este rotit conform planului ecranului.
(® Axa implicitd se afla in centrul entitatii selectate, iar pozitia axei poate fi reatribuita.

2.5.3 3D Scale

Scala entitatea selectat3 in spatiu in functie de axe. Selectati "Home Tab > 3D Operations panel > Il 3 3D Scale".

Note:

@ Implicit la axele locale, care pot fi comutate la axele globale introducand S si apasand Enter pe linia de
comanda.

Page 67 of 241



Houseplan 1.0 Make stunning 3D scheme with speed and ease

@ Scalare 3D accepta selectia de planuri,
corpuri, entitati de fundal, entitati de
vegetatie, animatii scheletice si modelate
in forma liberda modeled.

(® Daca cursorul este plasat in centrul axei
XYZ, toate obiectele pot fi scalate ca intreg.
@ Axa implicita este in centrul entitatii

selectate si pozitia axei pot fi reatribuite.

3 Meniu Inseare

Acest capitol prezinta importul si gestionarea suportului de proiect si a datelor, precum si functiile de publicare

si export a proiectului, care ajuta la crearea unui efect de randare detaliat si realist.
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3.1 Panoul de import

| DWG Underlay pY4
3.1.1 DWG substrat Select solution:
Imports DWG sau fisiere DXE o fi folosit ca
Result validity range:

desen de bazd pentru proiectare  Selectati Insert

Tab > Import Panel >DWG Underlay" to

Units used on original drawing: Unidentificz | |Rescale

[ Content within view only
open its dialog box.
[l original height
1. Selectati Click pe E] buton si ~ Do not import block

Selectati DWG or DXF fisie 3 fie importate. »2 Do not import positive entities

. - .« Do not import invisible entities
2.Rezuli intervalul de valabilitate Automat

calculeaza si afiseaza intervalul de dimensiuni la

toate obiectele din desenul inserat ca a o imagine

<Previous(P) Next(N)> Cancel(C)

DWG Underlay X

Select solution:
C:\Program Fil \sample\dwg\Sal @

lResuIt validity range: 40.12...%29.34... I

Units used on original drawing: Meters [ |Rescale

|| Content within view only
[Tl original height
Do notimport block
=4 Do not import positive entities

“4 Do not import invisible entities

’ <Previous(P) Next(N)> Cancel(C)
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3. Unitati utilizate pe desenul original:

. . . . DWG Underlay
identificati automat unitatea desenului
Select solution:
Importat’ care nu poate fi modificata C:\Program Files\Gstarsoft\Houseplan\sample\dwg\Sal @
direct. Daca doriti sa modificati, trebuie sa o
4 4 Result validity range: 40.12...%29.34...
faceti clic pe butonul ,Rescale” pentru a Units used on original drawing: |Meters - | ERescale
. —|Millimeters
. . v ey es . . Centimeters
activa lista derulanta a unitatii, apoi puteti | Content within
3 Inches
. X __ Original height |Feet
ajusta unitatea. Unidentification
Do not import block
4. Numai continut Tn vizualizare: Cand bifati Do not import positive entities

Do not import invisible entities

aceasta optiune, vor fi importate doar

i | r nt vizibile in iul de lucr
obiectele care su bile spat ul de lucru Unit in DWG drawings is imported as meter

cand salvati desenul DWG, in caz contrar,
<Previous(P) Next(N) > Cancel(C)
fiecare obiect din desen va fi importat.

5. néltimea originald: Bifati aceastd optiune
pentru a importa Tn functie de Thaltimea originalad a obiectelor desenate in desenul CAD.
6. Nu importati blocuri: entitatile bloc din desenele CAD nu vor fi importate.

7. Nu importati entitati invizibile: entitatile care sunt inghetate, inchise sau pe straturi blocate nu vor fi
importate.

8. Dupa setarea parametrilor, faceti clic pe butonul ,,Urmatorul” si va aparea urmatoarea caseta de dialog.

DWG Underlay
Edit  Line/Plane Layer
B 0 o
[_ = Defpoints
v (]  ARCH_DOORS
v [ ARCH_WALL
[v (] ARCH_WINDOWS
I ]  ARCH_FURNITURE
v (]  ARCH_STAIRS
v [ ARCH_FLOOR_LIVING

Check a layer to import as editable layer, otherwise import as
underlay layer

<Previous(P) Next(N)> Cancel(C)
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(1) Caseta de selectare: Puteti verifica straturile de desen care urmeaza sa fie importate in spatiul de lucru.
Obiectele care apartin straturilorimportate sunt vizibile si gata pentru a fi editate. Daca debifati straturi
de desen, obiectele sunt vizibile si estompate Tn spatiul de lucru, acele obiecte nu pot fi modificate

deoarece sunt blocate.

DWG Underlay

........ , : Edit | Line/Plane Layer

|| =T

f— o Defpoints.

v = ARCH_DOORS
v [ ARCH_WALL

|

ARCH_FURNITURE
ARCH_STARS
ARCH_FLOOR_LIVING

<
o ojo

%

Check a layer to import as editable layer, otherwise import as|
underlay layer

— <Previous(P) = Next(N)> Cancel(C)

importati obiecte care apartin unui strat ca - importati obiecte ca planuri sau

(2) Tip de import. polilinii suprafete 2D.

Faceti clic pe pictograma pentru a comuta intre ele, faceti dublu clic pe pictograma pentru a selecta toate

straturile simultan. Faceti clic pe butonul ,Urmatorul” pentru a Tncepe importul.

Properties

= Plane
Alias

DWG Underlay
Custom color 255,0,255

Edit | Line/Pane Layer
0

Defpoints Building number of floors
ARCH_DOORS
Elevation

ARCH_WALL

LSS RN i

HD oooooo

ARCH_FLOOR_LIVING

Check a layer to import as editable layer, otherwise import as
underlay layer

Note: DWG accepta versiunile 2002-2021.
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3.1.2 Managementul straturilor DWG

Gestioneaza straturile de desen DWG/DXF importate. Puteti seta starile de stocare, de fixare si ascunse ale
straturilor de desen care sunt in prezent dezactivate (nu pot fi editate) si sa le convertiti in unele editabile in

spatiul de lucru.

Select "Insert Tab > Import Panel > G DWG Layer Management"

DWG Layer Management

(=] [#] [@] E]
Underlay layer: Converts to a solid layer:
Layer Storage% Snap ‘ Hide ’ Layer
[ Awming [V v [ Mo
[ Baleony [ 4 I [ Internal Road
[ Buildin [V [v I [ e
l_ Colunn W I7 l_ Rallmg
[ Text
[ Water Paal

1. Straturi de baza: afiseaza numele, stocarea, starea de aparitie si ascunsa a fisierului DWG importat.

(1) Stocare: stabileste daca straturile de baza pot fi salvate.

(2) Snap: Seteaza daca straturile de baza pot fi snap.

(3) Ascundere: Seteaza daca straturile de baza pot fi afisate.

Faceti dublu clic pe orice caseta de selectare pentru a selecta coloana corespunzatoare simultan.

2. Caseta de selectare Strat de baza: Bifati numele unui strat pentru a-I face vizibil Tn spatiul de lucru, dar nu poate
fi editat.

e - =
01 o g o]

=) I vl i) Undartay layer

' \ Laer

[ ARCH_DOORS

[™ ARCH_FLOOR_L

[~ ARCM_STAIRS

et 1 N TN et

) | ! Lope
[~ ARCH_DOORS
[~ ARCH_FLOOR_L

| [ 25CH STAIRS
=
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3. Convertiti in strat editabil: bifati numele unui strat din lista pentru a-l converti ulterior in strat needitabil.

4. Click = pe buton pentru a incepe conversia stratului. Verificati daca numele stratului este localizat (stratul

de sub acoperire sau Convertiti n lista de straturi editabile), in procesul de conversie, faceti clic din nou pe

butonul pentru a anula.

D= = @ =
LRy s O£, S0k oy Underlay layer: Comverts to a solid layer:
l.’:RCH DOORS s.‘;“'! o afl s Storage | Sosp | Hide | Layer
v . |
e - I | ML [ ARCHDOORS |7 [v [ | [ ARCH_FURNITURE

= v ARCH_WINDOWS ARCH_FLOOR_L [v v [
[ ARCH_STAIRS [v =2 = E 4 2 I

[~ ARCH_STAIRS [v 2
W,
[~ ARCH_WALL W |
| ¥ ARCH_WINDOWS o

5. Click & pe buton pentru a muta obiectele apartinand unui strat selectat intr-o anumita pozitie in spatiul de
lucru.

6. Click @ pe buton pentru a sterge toate straturile DWG, pdstrand straturile editabile vizibile in spatiul de lucru.

7. Click . = butonu (se recomanda sa debifati toate straturile de bazd pentru a vedea efectul de selectie),
selectati orice obiect din spatiul de lucru, stratul corespunzator va fi localizat si selectat Tn caseta de dialog.

3.1.3 imbinati proiecte

Tmbina3 alte fisiere *.cpi in proiectul curent. Selecteaz "Insert Tab > Import Panel > Merge Projects" pentru

a deschide urmatoarea caseta de dialog.

Merge Projects

File: |

[ Original coordinate ] Specify coordinate

Faceti clic pe buton-ulsiiselectati fisierul CPI de imbinat.

Coordonata originala: Insereaza fisierul in functie de coordonatele originale stocate.

Specificati coordonatele: Insereaza fisierul in functie de coordonatele specificate.
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3.1.4 Alte formate

Insereaza fisiere in diferite formate Tn Houseplan 1.0 pentru a fi utilizate ca referinte de proiectare.

Select "Insert Tab > Import Panel > Other Formats" to open the dialog box shown below.

Organize v New folder
“"‘_ ‘ = B Desktop
— Documents
= 5‘2 Diamol bin.skp
¥ Downloads H‘ @ House+16x16x6.skp
® Music obj (1).0bj 3D Object
& Pictures B objobj 3D Object
g il ¥ Videos . pcm-house4.xyz XYZ File
et —— &= Local Disk (C) I testsample.rcp CP File
File name: ‘ . ‘ |all(*%)
all(*.)
(*.fbx)
SketchUp file(*.skp)
OSGB file(*.0sgb)
OSG file (*.0sg)
OBl file (*.obj)
RVT file (*.rvi)
v X 3DS file (*.3ds)

tif (~tif)
dem (*.dem)

1. Selectati fisierele de tip *.jpg, *.bmp, *.png si specificati locatia de inserare.

2. Selectati fisierul *.fbx, exista doua moduri de a le insera; Inserati la pozitia specificata sau tastati Y pentru a
introduce dupa coordonatele originale.

3. Selectati fisierele de tip *.osgb, *.osg, *.obj, *.3ds, , faceti clic pe butonul ,Deschidere” pentru a deschide
caseta de dialog afisata mai jos.

Import Settings X

Scene Units: Meters

File Units: | Meters v

Confirm Exit

(1) Unitati de scena: Afiseaza unitatile de desen curent.

(2) File Units: Setati unitatile desenului care urmeaza sa fie importat.
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4. Selectati fisierul *.skp, faceti clic pe butonul ,,Deschidere” pentru a deschide caseta de dialog prezentatda mai
jos.
(1) Import obiecte ascunse: Optiunea
Import Settings
este bifatd implicit, componentele

Import hidden objects
ascunse vor fi create si importate;

[Jimport the two-sided model
dacad nu este bifata, componentele

[CJ1mport Edges/Profiles

ascunse nu vor fi importate.

(2) Importati modelul cu doua fete:daca | =~

este bifat, partile din fata si din spate
ale modelului skp vor fi create si
importate; daca nu este bifata, doar o parte a modelului skp va fi analizata, creata si importata.
(3) Import margini/profile: Daca este bifat, marginile si profilele modelului skp vor fi create si importate;
daca nu sunt bifate, marginile si profilele nu vor fi importate.

5. Selectati fisierul *.rvt si faceti clic pe butonul , Deschidere” pentru a-l importa.
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6. Selectati fisierul *.tif, faceti clic pe butonul ,,Deschidere” si urmati instructiunile din linia de comanda pentru a
introduce o valoare pentru a determina nivelul de randare pentru a finaliza importul TIF.
7. Selectati fisierul *.dem si faceti clic pe butonul ,,Deschidere” pentru a-l importa.

Note:

@ Datele osgb importate sunt date de model. Pentru a importa date de fotografie oblica, va rugdm sa

utilizati functia ,,Fotografie oblica”..

@ Import descrierea versiunii: SketchUp acceptd pana la versiunea 2022; Formatul fbx acceptd pana la
versiunea 2020.

®) Pentru primul import al modelului format rvt, trebuie s3 fiti intr-o stare de retea si sd solicitati

permisiunea de la server.

@ Fisierul tif este importat cu nivelul de randare a maparii, cu cit valoarea este mai mica, cu atdt maparea

este mai clard; cu cat valoarea este mai mare, cu atat maparea este mai neclara.
(® DEM este un model digital de elevatie, care permite simularea digitald a terenului de la sol din date

limitate de altitudine a terenului.

3.2 Panoul de imagini
3.2.1 Fotografie oblica

Importa date de fotografie oblice sau le imbina in proiectul curent. Selectati "Insert Tab > Imagery Panel >
Oblique Photograph" pentru a deschide caseta de dialog prezentata mai jos.

1. Import: faceti clic dreapta pe spatiul liber

pentru a deschide meniul contextual, faceti

Project Path
Please right dick to import pro...

clicpe , Importati” pentru a deschide caseta
de dialog prezentata mai josFaceti clic pe
butonul pentru a selecta fisierul de fotografie

oblic, faceti clic pe butonul ,Coordonatele Oblique photography: e

originale” pentru a importa scena in functie
Original coordinate Specify coordinate

de coordonatele in-situ; faceti clic pe butonul

»Specify Coordinate” pentru a importa scena
in functie de coordonatele specificate.
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2. Faceti clic dreapta pe numele nodului stratului pentru a deschide meniul contextual, asa cum se aratd mai
sus.

(1) Redenumire:  Schimbati numele

proiectului.
Noté: reguli de denumire: dupa Oblique Photograph X
importare, tuturor datelor i se adaugi Project | Path |
Oblique photography data... | f:/downloads/oblique photoar...
prefixul ,,date oblice”, urmat de Rename
Delete
sortarea numerelor, dela 1, 2,...
Positioning

Numele dintre paranteze citeste
numele folderului de fotografie oblica, Import

iar numele nu poate fi schimbat.

(2) Stergere: stergeti datele oblice
importate si pastrati fisierele sursa.

(3) Pozitionare: Faceti clic pe ,Pozitionare” pentru a localiza aceste date oblice in scena.
Note:

@ Sunt acceptate numai datele de proiect de fotografie oblica ale fisierelor osgb cu acelasi nume ca si

fisierele secundare din cale (de exemplu: Tile_1 / Tile_1.0sgb).

(@ Dupa importarea unui proiect, trebuie sd specificati o noua cale atunci cdnd calea este invalida. Cand

nu este valid3, locatia cdii este afisata in albastru.
3.2.2 Date din norul de puncte

Aceasta functie importa date norului de puncte (colectie de vectori intr-un sistem de coordonate 3D) in
Houseplan 1.0.

Dj Point Cloud Data" pentru a deschide urmatoarea caseta
de dialog.

Selectati "Insert Tab > Imagery Panel >

Point Cloud

Point doud data: F:\Downloads\Point Cloud Data [I]

v

Dilute ratio: 50 2o

Original coordinate Specify coordinate

1. Date cloud de puncte: Faceti clic pe [I] butonul pentru a selecta un fisier in format * las.
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2. Raport de diluare: Raportul dintre numarul de puncte de date care trebuie redus in timpul procesarii datelor
din norul de puncte. Cu cat valoarea este mai mare, cu atat este mai mare numarul de puncte de date si
procesul de transformare este mai lent; cu cat valoarea este mai mica, cu atat numarul punctelor de date este

mai mic si procesul de transformare este mai rapid.

3. Coordonata originala: Faceti clic pe butonul ,Coordonata originald” pentru a importa scena in functie de
coordonatele originale.

4. Specificati coordonatele: faceti clic pe butonul ,Specificati coordonatele” pentru a importa scena in functie de
coordonatele specificate.

Note:

@ Dupé introducerea datelor norului de puncte, atunci cand utilizati din nou aceasta functie, daca
valoarea de dilutie este aceeasi cu ultima valoare, aceasta poate fi introdusa direct in scena in
coordonatele in-situ sau in coordonatele specificate; daca valoarea de dilutie este modificata, datele

trebuie convertite din nou.

@ Interval de diluare: 1-100.
3.2.3 Clasificarea datelor

O cantitate mare de date model este clasificata automat, iar numarul de fisiere de date dupa clasificare este
redus semnificativ si mai organizat. Aceasta functie poate rezolva problemele de eficienta scazuta a Tncarcarii si

consumul ridicat de redare a scenei atunci cand utilizatorii proceseaza loturi mari de date.

Select "Insert Tab > Imagery Panel > Data Classification" to open the dialog box shown below.

Data Classification

Destination Path: C:/Users/Administrator. CTPDI Data Source; F:/Downloads/Manual Data
=) EdExdusive_Vila_Project A S

>

3wld";g- Manual Data_DX

‘egetaion
Hi

Briver channel :anua: EBZ_J;

ERoad anual Data_.

B Terrain Manual Data_zW

M sprite

Compile Exit
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Faceti clic dreapta in margine pentru a deschide meniul de clic dreapta, asa cum se arata mai jos.

Data Classification X

Destination Path: Data Source:

Select Data source
Right dlick to create new projects

Create new projects

Import projects

Compile Exit

1. Proiect nou: Faceti clic pe ,Creati proiecte noi” si va aparea urmatoarea caseta de dialog.

Data Classification

Destination Path: e Data Source:

Select Data source
Right click to create new projects

Project name: Exdusive_Villa_Project

Save path:  F:/Downloads/Manual Data @
Confirm Exit
- S
Compile  Exit

Introduceti numele proiectului, selectati calea de salvare, faceti clic pe butonul ,,Confirmare”, iar cinci

straturi vor fi create automat, asa cum se arata in figura.
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Data Classification

Destination Path: C:/Users/Administrator.CTPDN = ,,, | Data Source:

=] Select Data source
Bsuilding
B vegetaion
BRriver channel
BRroad
M Terrain

M sprite

Compile Exit

Caseta de selectare controleaza afisarea si ascunderea acelui strat.
2. Pentru a deschide datele compilate, selectati ,,Import Project”, care va deschide urmatoarea caseta de dialog.
Data Classification

Destination Path: C:/Users/Administrator.CTPDN | ., | Data Source:

= BExdusive_villa_Project Select Data source
BEdsuilding
Vegetaion
River channel
Road
B Terrain

Bl sprite Artifidial models: C:\Users\Administrator. CTPDNUM @

Original coordinate Specify coordinate

Dupa selectarea fisierului proiect.zml compilat, faceti clic pe butonul ,Coordonate originale” pentru a
insera scena conform coordonatele sale originale; faceti clic pe butonul ,Specify Coordinate” pentru a insera
scena Tn conformitate cu coordonatele specificate.

3. Faceti clic dreapta pe numele nodului stratului pentru a deschide meniul contextual, asa cum se arata in
imaginea urmatoare.
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(1) Rename:  Schimba numele

proiectului. Data Classification

(2) Delete: Sterge straturi, pastreaza Destination Path: C:/Users/Administrator.CTPDN Dats Source:s

fisierele surs3 locale si datele pot Bl v Exdusive_Villa_Project | ([PSeea]
Sy |
fi restaurate dupa stergere. B4 vegetaion Bk
BaRiver channel Ciexe,
(3) Pozitionare:Localizeaza BdRoad Positioning
Terrain

. A o v i
locatia elementului Tn scena. Bsprite

4. Procesul de compilare.

(1) Faceti clic dreapta pe un
nou proiect intr-un spatiu liber din zona de date compilate.

(2) Importati sursa de date, faceti clic pe L | butonul si selectati datele sursa care urmeaza sa fie
compilate.
(3) Selectati stratul de date compilat si apoi verificati sursa de date corespunzatoare in tabelul din dreapta

pentru a mapa stratul la sursa de date.

(4) Faceti clic pe butonul ,Compilati” pentru a compila datele stratului curent.
Note: Sursa de date trebuie sa salveze ca fisiere osgb pentru cladiri, plante, rauri, drumuri, teren si viniete intr-o
scena separat.

3.2.4 Orthoimagery

Reesantioneazda desenele distorsionate la o noud ortoimagine corecta. Imaginea originalda cu teledetectie cu

distorsiuni este reesantionat in tonuri de gri in functie de relatia geometrica corecta. Selectati "Insert Tab > Imagery

Panel > Orthoimagery " pentru a deschide caseta de dialog prezentata mai jos.

Orthoimagery
Show | Name ’ Result path
Compile
Import
Rename
New Positioning
Delete
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1. New: Faceti clic dreapta pe

show | Name [ Result path

el b pey g dEEEe T

contextual, faceti clic pe ,,Nou” si apare

Name:

urmatoarea caseta de dialog. Dupa ce

. . Confi
ati introdus numele datelor de imagine, Sl

faceti clic pe butonul ,Confirmare”

pentru a crea noi date de imagine; faceti
clic pe butonul ,Anulare” pentru a anula operatia si a inchide caseta de dialog.
2. Faceti clic dreapta pe lista de date pentru a deschide meniul contextual, asa cum se arata.

(1) Compile: Faceti clic pe ,,Compilati” si
va aparea urmatoarea caseta de
dialog.

Compile Result

Path:

@ Cale: calea proiectului generat.
Data Source:

Sursa datelor: calea originala a

Terminated

datelor. Apasa pe butonul,
selectati calea rezultatului si sursa de
date, faceti clic pe butonul ,Compilare” pentru a incepe compilarea; faceti clic
pe butonul , Terminat” pentru a incheia compilarea.

(2) Import: Faceti clic pe ,Import” pentru a deschide caseta de dialog prezentata mai jos.

Import The Results

QOutcome path:

[ Original coordinate ] Specify coordinate

Apas pe pentru a selecta rezultatul generat, faceti clic pe butonul ,Coordonata originald” pentru a insera scena

conform coordonatelor originale; faceti clic pe butonul ,Specify coordonate” pentru a insera scena in
conformitate cu coordonatele specificate.

(3) Redenumire: Schimba numele datelor imaginii.
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(4) Pozitionare: Localizeaza aceste date de imagine in scena.
(5) Stergere: Sterge datele actuale ale imaginii.

Note:

@ Atunci cidnd selectati rezultatele deja generate pentru import facand clic pe butonul ' acestea

pot fi importate numai in coordonatele in-situ.

(@ Bifati Afisare pentru a afisa datele din scena; debifati Afisare pentru a ascunde datele din scena.

(® Datele sursa pentru proiectia ortogonala sunt in format tif, jpg (cu coordonate).

3.2.5 Aplatizarea imaginii oblice

N
Aplatizeaza zona selectata a unei fotografii oblice. Selectati "Insert Tab > Imagery Panel > Flatten Oblique
Image" element si exista trei tipuri de aplatizare.

1. Definiti zona aplatizata desenand polilinii..
2. Definiti zona aplatizata tastand ,S” si apdsati Enter pentru a desena polilinii 3D.
3. Definiti zona aplatizata tastand ,D” si apasati ,S” pentru a selecta linia sau planul Tnchis.

Note:

(@ Cand desenati o zond orizontald, planul orizontal este format la indltimea primului punct in momentul

desendrii si este aplatizat conform conturului desenat.

(@ Cand desenati o zond tridimensionald, un plan este definit de primele trei puncte si aplatizat conform

conturului desenat.

(® Cand definiti zona de aplatizare, aplatizati imaginea dupa conturul si inaltimea obiectului selectat.

@ Definiti zona aplatizata ca sa fie mai mica sau egala cu zona aplatizata a imaginii, mai mica decat conturul

bazei imaginii, iar partea de jos a imaginii nu trebuie sd depdseasca.

Dupa aplatizare, selectati modelul de fotografie oblica din scena si faceti clic pe butonul’ " " de dupa campul
»,Zona aplatizata” din bara de proprietati pentru a deschide caseta de dialog afisata. Caseta de dialog arata
numele tuturor zonelor aplatizate. Selectati numele si zona aplatizata corespunzatoare din scena este evidentiata;

faceti dublu clic pe nume pentru a localiza rapid zona selectata. Faceti clic dreapta pe nume pentru a deschide

meniul contextual:
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1. Sterge: zona aplatizata selectata este stearsa si datele de

. . . Flatten The Area
fotografiere oblice pentru acea zona sunt restaurate la

starea pre-aplatizata. Name ,
2. Stergeti tot: Toate zonele aplatizate sunt sterse si datele de Delete
Delete all

fotografie oblice din scena sunt restaurate la starea initiala.
Rename

3. Redenumire: modifica numele zonei aplatizate.

3.2.6 Filtru oblic de date

Sterge sau salveaza zona de fotografiere oblica conform diferitelor metode de taiere.

Selectati'lnsert Tab > Imagery Panel> IE Oblique Data Filter PeNtru a deschide urmatoarea
caseta de dialog

Oblique Data Filter

g0 &30 R Height: |Permeate

Save selected as Delete selected Delete unselected

1. Exista patru moduri de a desena intervalul de editare:
(1) Dreptunghi: Click 1S pe buton pentru a desena o zona de editare dreptunghiulara.
(2) Poligoane: Click S pe buton pentru a desena o zona de editare poligon.
(3) Cercuri: Click @ pe buton pentru a desena o zona de editare circulara.

(4) Selectati: Click B pe buton pentru a selecta un grafic ca zona de editare; desenul selectat poate fi doar
o linie sau un volum.

Note:

@ Zona de editare poate fi ajustata in madrime prin tragerea si fixarea punctului de clipare, iar pozitia

acestuia poate fi mutata.

@ Cand este selectatd o zona de editare personalizata, volumul referintei initiale este eliminat si este

creata o noua zona de editare, iar noua zona de editare este, de asemenea, trasa cu puncte de clip.
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® in scend poate exista o singurd zon3 de editare, iar cand este desenatd o noud zond de editare,
ultima este stearsa automat.

2. Permeat: Desenati o zona de editare plana care include toate datele de pe plan si Tn intervalul infinit de mapare
deasupra si dedesubtul planului.

3. Alegeti automat: desenati o zona de editare si alegeti cel mai inalt punct din interval ca naltime a modelului
pentru a genera o zona de editare 3D.

4. Tn3ltime: Cand desenati o zona de editare, dacd o valoare a Tniltimii este introdusd manual, zona de editare
3D este generata cu valoarea data.

5. Delete Selected: Datele originale din zona de editare sunt sterse si scena este incdrcata cu datele ramase.

6. Stergeti neselectat: datele originale din afara zonei de editare sunt sterse si scena este incarcatd cu datele
ramase.

7. Salvare ca selectat: Datele din zona de editare sunt salvate separat, iar datele originale sunt pastrate.

3.3 Panou de iesire

3.3.1 Publica

Creeaza un fisier .exe care poate fi executat independent si poate realiza roaming video, schimbarea mediului si
afisarea proprietatilor.

Selectati " Insert Tab > Output Panel > Publish  pentru aintrain ecranul Publicare.previzualizare
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1. Meniu: treceti cursorul in partea de jos pentru a afisa meniul; mutati cursorul pentru a ascunde meniul, asa
cum se arata mai sus.

(1) Galerie: faceti clic pe butonul ,Galerie” pentru a activa/dezactiva galeria din partea stanga. Cand galeria
este activata, plasati cursorul in partea stanga a ecranului pentru a afisa galeria; mutati cursorul pentru
a-l ascunde. Faceti clic pe orice videoclip din galerie pentru a calatori sau pentru a va pozitiona in punctul

de vedere corespunzator.

Interactive simulation publishing

LookRoundOt,

-

a M g
é
i DR

LookRoundOZl

LookRound03"

Start Roam

@ Faceti clic pe butonul  pentru a seta parametrii de roaming al caii.

@ Faceti clic pe butonul pentru a previzualiza vizualizarea traseului.
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® Faceti clic pe butonul pentru a desena cai bazate in scenariul de publicare.
@ Faceti clic pe butonuI[El pentru a opri previzualizarea vizualizarii caii.

® Faceti clic pe butonulll—LI pentru a intrerupe previzualizarea si faceti clic din nou pentru a continua
previzualizarea..

® Faceti clic pe butonul @ pentru a sterge calea de impamantare desenata sau calea utilizata in
galerie.
(3) Mediu efect: Gestionati efectele mediului Tn scena publicarii. Pentru mai multe detalii, consultati functia
,Fila Scena > Panoul Mediu > Mediu”..

Environment

Weather

Clear sky Sunrise Sunset

Lighting

E‘fed parametér

Night vision settings

Night vision settings

Light up type: @ Enclosed Balcony & Glass Door

8 Glass Window Light Strip

Lighting rate: 4 [ ]
0.2 04 0.6 08

Brightness: 40

@ Vremea: Faceti dublu clic pe o imagine a vremii pentru a aplica efectele meteo corespunzatoare.

@ lluminare: setati efectul de umbra in scena si ajustati parametrii de azimut si unghi de altitudine ai
soarelui.

Cand umbrele sunt activate, ajustarea azimutului si al altitudinii va afecta efectul umbrelor.
® Parametrii efect: faceti clic pe ,,Parametrii efectului”, puteti modifica parametrii solar, ambiental,

efect de ceata, lumina volumetrica si HDR pentru a imbunatati efectul ambiental.
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@ Setari de vedere pe timp de noapte: categoria de iluminare, rata de iluminare si luminozitatea pot
fi modificate separat pentru a regla efectul de iluminare in modul de noapte.

(4) Proprietati: Faceti clic pe butonul ,Proprietati” pentru a activa/dezactiva coloana de proprietdti din

partea dreapta a ecranului. Faceti clic pe un element al cladirii si coloana de proprietati va afisa informatii

aferente.

(5) Data Management: Specify

Data -~ -~=ment

the path to correctly load

the oblique photography

data in the scene.

(6) Publicare: Faceti clic pe butonul ,Publicare” pentru a

impacheta fisierul si a salva ca .exe (aplicatie executabila).
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< > LR 7 « Des.. > Newf... Search New folder

Organize v New folder

Date modified

| v EThisPC

No items match your search.

> M Desktop
> =) Documents

> *_ Downloads

File name: | Sample0l.exe

Save astype: Publish type(*.exe)

A Hide Folders Cancel

Orbit(0)

Eye view(D)

Full view(A)

Pan(P)

—— ' View control(J))

o Previous view(l)
Front face(F)
Window view(W)

e W s P

r.d

I T VN TR

(1) Orbit: Muta dinamic observatorul in jurul modelului, mentindnd acelasi punct de focalizare. Apdsarea
,Ctrl + rotita din mijloc a mouse-ului” permite si vizualizarea orbitei. Daca ati selectat o entitate si apoi
utilizati aceasta functie, vizualizarea este rotitd cu acea entitate ca punct central.

(2) Eye view: Activeaza perspectiva vederii ochiului uman. Apdsati si trageti butonul din stdnga in scena

pentru a vedea n jur din perspectiva umana.
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(3) Vizualizare completa: Afiseaza toate entitatile din spatiul de lucru in masura maxima posibila.
(4) Pan: Muta pozitia vederii fara a modifica pozitia sau scara obiectelor din desen. Apasati si mentineti
apasata rotita din mijloc a mouse-ului, pentru a permite si

operarea Pan.

3D Perspective

(5) Controlul vizualizarii: Comuta vizualizarea n perspectiva 3D a

spatiului de lucru curent din diferite directii. Faceti clic pe

sageata albastra corespunzatoare pentru a seta directia

”
|

vizualizarii si faceti clic pe butonul ,Plane” in orice vizualizare,
vizualizarea se va transforma in starea plana.
(6) Vizualizare anterioara: Revine la vizualizarea anterioara efectuata.

(7) Fata frontala: selecteaza planul de pe volum pentru a-si afisa vederea frontala.

(8) Vizualizare fereastra: Maximizeaza afisarea zonei selectate si permite afisarea completa si revenirea la
vizualizarea anterioara.

3. Title: Faceti dublu clic pe titlul din coltul din stanga sus al scenei pentru a deschide caseta de dialog prezentata
mai jos.

Interactive simulation publishing H ouse DeSig N M Otio N

Edit Title ‘

Text: House Design Motion

Font:  Microsoft YaHei UL N /

Text height: 32

Color:

(1) Text: Setati numele titlului..
(2) Font: Seteaza fontul titlului.
(3) Tndltimea textului: Seteazd dimensiunea fontului.

(4) Culoare: Setati culoarea fontului.
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4. Full-screen faceti clic pe-buton in coltul din dreapta sus pentru a intra pe ecran complet si apasati Esc
pentru a iesi. Faceti dublu clic pe butonul stang al mouse-ului pentru a intra sau a iesi din ecranul complet; pe
ecran complet, plasati cursorul in partea de sus pentru a afisa bara de titlu; bara de titlu va fi ascunsa dupa ce
cursorul iese din ea.

5. Minimize: Faceti clic pe = buton n coltul din dreapta sus pentru a minimiza software-ul in bara de activitati.

6. Close: Faceti clic pe. butonul din coltul din dreapta sus pentru a iesi din scena de publicare si a reveni la
scena software.

@ O galerie este o colectie de evidentieri si cai video salvate intr-o scena.

(@ Galeria nu afiseaza evidentierile salvate in vizualizarea axonometrica. Evidentierile si cdile de roaming

sunt salvate cu scena de mediu asociata.

(® Este necesar sa resalvati galeria dupa modificarea scenei pentru a actualiza imaginea de previzualizare.

@ Etichetele pentru entitatile de particule in scenariile publicate si in fisierele .exe publicate vor fi ascunse
automat.

(® Page Up/Page Down va permite sd comutati galeria.

3.3.2 Export

Exporta urmatoarele formate de fisiere; *.dwg, *.bmp, *. jpg, *.png, *.osgb, *.fbx, *.skp, *.3ds, *.obj. Select
"Insert Tab > Output

: Export" openurmatoarea caseta de dialog.

Panel>

Exporting

™ . <« Des... > Newf... ~ C Search New folder el
Organize ¥ New folder = « )
Name Date modified Type
v~ [l This PC
) Untitled3.dwg 2023/9/12 9:28 Auto
> @l Desktop |
> &) Documents
> & Downloads
File name: | Sample01.dwg o
Save as type: | Auto CAD file (*.dwg)
Auto CAD file (*.dwg)
3D Studio (*.3ds)
~ Hide Folders FBX file (*.fbx)
JPEG Image (*.jpg)

OB file(*.obj)

PNG Image (*.png)

SKP file (*.skp)

Windows BitMap (*.bmp)
b)
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1. Selectati formatul *.dwg, faceti clic pe butonul ,Salvare” si selectati versiunea CAD de exportat.

2. Selectati formatele *.3ds, *.fbx, *.0bj, *.0sgb, faceti clic pe butonul ,Salvare” si va aparea urmatoarea caseta

de dialog.
(1) Scene Units: Afiseaza unitatile de desen curent

(2) File Units: Setati unitatile desenului de exportat
(3) Cand se bifeaza Model Centrat: Coordonatele

Export Settings X

Meters

modelului vor fi centrate. Adica, coordonatele
Scene Units:

punctului central din partea de jos a casetei de

File Units: Meters v

delimitare a modelului sunt setate la (0,0,0)

pentru export Model Centered

n . . L . | Change Origin
(4) Cand se bifeaza Modificare origina: Originea ' L
modelului este schimbata, iar punctul specificat Confirm Exit
\ J

este setat ca origine a modelului.

(5) Cand atat Model Centered and Change origin sunt
debifate: Originea si pozitia modelului nu vor fi modificate, iar modelul va fi exportat in functie de
pozitia actuala din desenul curent.

Note: Optiunile Centrat pe model si Modificare origine se exclud reciproc, doar una poate fi bifata sau

ambele sunt debifate.

3. Selectati formatul *.bmp, *.jpg, *.png, faceti clic pe butonul ,Salvare” si va aparea urmatoarea casetd de

dialog.

(1) Output size: seteaza latimea si indltimea imaginii

Image Export Settings X

exportate n pixe"- Output size Maximum size
Wide: pixel Wide:4096 pixel
(2) Maximum size: Sistemul va afisa numarul maxim 72 o e
i iaii inii i i Image size: Image size:
de pixeli ai imaginii exportate acceptati de sistem. o o
(3) Watermark pattern: LT T
_ Watermark
Tile Spadng X |10 y |10
@® Watermark: Dac3 este bifatd, imaginea exportata
Watermark
va avea watermark. Transparency
Confirm Cancel

@ Tile, spatiere: Selectati ,Tile” pentru a afisa

modelul filigran conform spatierii implicite;

selectati ,Spacing” pentru a afisa modelul de filigran in functie de distanta specificata.
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® Watermark image: aceti clic pe butonull *** | pentru a selecta o imagine in format *.bmp sau
* jpg ca imagine watermark.

@ Transparency: Trageti cursorul pentru a seta transparenta imaginii watermark-ului, 1 este
opac, 100 este complet transparent.

(4) Faceti clic pe butonul ,,Confirmare” pentru a exporta imaginea in formatul corespunzator.

4Selectati formatul *.skp, faceti clic pe butonul ,,Salvati” si va aparea

rmatoarea caserd de dlaloe.

(1) Export Version: Selectati standardele versiunii fisierului .skp
Version

exportate. Export Version:  5U2019

(2) Unit Conversion: Convertiti unitatile atunci cand exportati Unit

Unit Conversion:  Meters
pentru a pastra aceleasi unitati ca in SketchUp.

Option
A . . Model Centered
(3) Model Centered: Cand sunt bifate, obiectele exportate vor
B4 Export Line
fi centrate automat la coordonatele originii. Ignore Material
Change Origin

(4) Export Line: Se exporta linii, spline.

Confirm Cancel

(5) Ignore Material: Modele exportate fara materiale.
(6) Change Origin: Cand este bifata, originea modelului este
schimbatd, iar punctul specificat este setat ca origine a modelului.

Note:
(@ Daca pentru export este selectat un fisier in format *.dwg, *.osgb, *.3ds, *.obj, *.skp sau *.fbx, entitatile

din stratul de fundal al desenului curent nu sunt exportate.

(@ Cand exportati randari, se recomanda sa activati ,Anti-aliasing, Shadow, Light Projection".

3.4 VR Panel

3.4.1VR

Cu Houseplan 1.0 si dispozitivele VR, utilizatorii se pot scufunda in scena 3D pe care au creat-o, realizand o
experienta de navigare a scenei virtuale n timp real, care le permite sa observe in detaliu din diferite perspective.

nainte de a utiliza instrumentul VR, asigurati-va ca aplicatia SteamVR a fost instalatd corect pe computer si c3

programul SteamVR si dispozitivul VR sunt pornite si conectate la aceeasi retea, apoi selectati "Insert Tab > VR Panel

> mVR" pentru a deschide urmatoarea caseta de dialog:
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0 Start VR/AR.

Faceti clic pe butonul ,,OK” pentru a intra Tn scena VR. Si faceti clic din nou pe functia ,,VR” pentru a incheia
navigarea VR..
Functionarea controlerului:

1. Teleportare: apasati si mentineti apdsat declansatorul situat in fata controlerului. Odata ce lumina verde se
aprinde, directionati lumina catre punctul tintad dorit, apoi eliberati declansatorul pentru a initia teleportarea
2. Recenter: Apasati butonul lateral al controlerului pentru a reveni la pozitia initial3;
3. Controlul directional:

1) Deplasati thainte/inapoi: tineti controlerul orizontal si impingeti joystick-ul controlerului thainte/inapoi;

2) Panare la stdnga/dreapta: Tineti controlerul orizontal si impingeti joystick-ul controlerului la
stdnga/dreapta n consecinta;

3) Deplasati-va in sus/jos: tineti controlerul vertical si impingeti joystick-ul controlerului Tnainte/inapoi
pentru a obtine miscarea dorita;
Operatiunile mentionate mai sus sunt demonstrate folosind controlerul castilor Quest 3 ca exemplu. Operatiunile
pentru alte casti sunt similare cu cele ale castilor Quest
Note:
Houseplan 1.0 accepta in prezent dispozitive VR precum Quest si HTC. Pentru informatii detaliate despre cum sa

utilizati dispozitivul si controlerul acestuia, va rugdam sa vizitati site-ul oficial al dispozitivului VR respectiv.
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4 Edit Menu

Acest capitol prezinta caracteristicile de baza ale modificarii cantitatii, marimii, formei si pozitiei contururilor

modelului. Utilizarea acestor caracteristici poate ajuta utilizatorul sa imbunatateasca cu usurinta efectele proiectului.

4.1 Modificati panoul

4.1.1 Copiere

Copiazad un obiect la distanta si directia specificate. Selectati "Edit Tab > Modify Panel > i Copy", selectati

obiectul, specificati punctul de baza si punctul tinta si copiati continuu.

4.1.2 Taiere

Copiaza un obiect in clipboard si decupeaza. Selectati "Edit Tab > Modify Panel > E Cut" si selectati obiectul
de taiat.

4.1.3 Lipire

Insereaza un obiect din clipboard in spatiul de lucru. Selectati "Edit Tab > Modify Panel > Paste" si exista
doua moduri de a lipi. Puteti introduce obiectul direct Tn pozitia desemnata sau introduceti ,Y” si apasati Enter pentru

a insera la coordonatele originale.

4.1.4 Sterge

Sterge un obiect selectat. Selectati "Edit Tab > Modify Panel > Erase".

4.1.5 Mutare

Muta un obiect la distanta si directia specificate. Selectati "Edit Tab > Modify Panel > Move" pentru a
selecta obiectul. Exista doud moduri de a o muta.

1. Deplasati direct prin sistemul de coordonate global: selectati obiectul si specificati punctele de baza si tinta de
mutat.

2. Introduceti ,M” si apasati Enter, selectati planul de referinta, selectati entitatea care trebuie mutata si specificati

punctele de baza si tinta pentru a se deplasa de-a lungul planului de referinta.
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4.1.6 Rotire

Roteste un obiect Tn jurul punctului de baza specificat. Selectati "Edit Tab > Modify Panel > Rotateselectati

obiectul, specificati punctul de baza. Exista doua tipuri de rotatie.

1. Rotirea se realizeaza prin specificarea directa sau introducerea unei valori pentru a determina unghiul de
rotatie.

2. Pentru a roti entitatea la un unghi de referinta, introduceti ,R” si apasati enter.

(1) Dupa introducerea directa a unei valori pentru a determina unghiul de referinta, specificati sau
introduceti o valoare pentru a determina noul unghi.

Note: Unghiul la care se roteste entitatea finala = unghi nou - unghi de referinta.

(2) Specificati unghiul pentru a determina unghiul de referinta, cum ar fi: specificati punctul de baza
¢, specificati unghiul de referinta dupa primul punct a, specificati al doilea punct b, specificati noul
unghi cu referire la un punct d de pe margine, si rotiti muchia ab pentru a fi paraleld cu muchia

cd. Efectul este prezentat in figura urmatoare.

Before g

Aft
er Reference

4.1.7 Scara

Scala obiectul selectat, pastrand proportia obiectului neschimbata dupa scalare. Selectati "Edit Tab > Modify
Panel > H Scale", selectati obiectul, specificati punctul de baza. Exista douda moduri de a mari.
1. Scalati prin specificarea directd sau introducerea unei valori pentru a determina raportul de scalare.
2. Scaleaza entitatea dupa lungimea de referinta. Introdu R si apdsati enter.
(1) Dupa introducerea directa a unei valori pentru a determina lungimea de referintd, specificati sau

introduceti o valoare direct pentru a determina noua lungime.
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(2) Specificati lungimea pentru a determina lungimea de referinta, cum ar fi: specificati punctul de baza c,
specificati lungimea de referinta dupa primul punct a, specificati al doilea punct b, specificati un punct
d pe muchia de referinta pentru a determina noua lungime , si scalati muchia ab la o lungime egala cu

muchia cd. Efectul este prezentat in figura urmatoare.

After Before Reference

Note: Factor de scard = lungime nouad / lungime de referinta, exemplu; introduceti 0,5 pentru a reduce la 0,5 ori
lungimea initiala.

4.1.8 Oglinda

Creeaza o copie in oglinda a obiectului selectat. Selectati "Edit Tab > Modify Panel > Mirror", selectati
obiectul. Daca introduceti ,,N”, dupa oglindire, obiectul sursa nu este sters; daca introduceti ,Y”, dupa oglindire,

obiectul sursa este sters. Exista doua tipuri de oglindire.
1. Oglindirea prin referire directa la linia care uneste cele doua puncte specificate.
2. Tastati ,Z” si apasati Enter pentru a utiliza axa Z ca referinta.

Efectul este prezentat in figura urmatoare.

Page 97 of 241



Houseplan 1.0 Make stunning 3D scheme with speed and ease

4.1.9 Offset

Creeaza cercuri concentrice, linii paralele si curbe izometrice ale obiectului selectat. Selectati "Edit Tab > Modify

AL
Panel > === Offset" si exist3 dou tipuri de compensare.

1. Specificati direct sau introduceti o valoare pentru a determina distanta de decalare: Selectati obiectul de
compensat si specificati punctul pentru a determina partea pe care urmeaza sa fie efectuata decalajul.

2. Faceti ca entitatea de linie nou generata sa treaca prin punctul specificat: Introduceti ,T” si apasati Enter,

selectati obiectul de compensat si apoi specificati punctul de trecere.

4.1.10 Trim

Decupeaza obiectele 2D intersectate. Selectati "Edit Tab > Modify Panel > = Trim", selectati mai intai linia de

delimitare, apoi selectati obiectul de tdiat. Efectul este prezentat in figura urmatoare.

/ Boundary line
» /Tn'm object : ,\

» l
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De asemenea, puteti selecta mai multe entitati de linie cu puncte de intersectie Tn acelasi timp si apoi selectati

Efectul este prezentat in figura urmatoare

obiectul de taiat.

". Trim object

5

b e -
> Noay e
3¢ k)
-
7

’ N

Before

After
Note:

@ Obiectele de taiere pot fi segmente de linie, polilinii, arce, nori si spline.

4.1.11 Extinde

@ Taierea poate avea succes numai atunci cand linia selectata se intersecteaza cu linia de delimitare.

convergente.

Extinde limitele sau marginile selectate. Obiectele sunt extinse astfel incat marginile altor obiecte sa poata fi
Selectati "Edit Tab > Modify Panel >Extend" element, selectati linia de delimitare, apoi selectati obiectul de

extins. Efectul este prezentat in figura de mai jos.

Extension line

|

Before

After
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De asemenea, puteti selecta mai multe entitati de linie cu puncte de intersectie in acelasi timp, executati

comanda Extindere si selectati obiectul de extins. Efectul este prezentat in figura urmatoare.

4.1.

4.1.

Estension line —

Before After

Note:

(@ Obiectele de extensie pot fi segmente de linie, polilinii sau arce.

(@ Extinderea poate avea succes numai atunci cand extensia liniei selectate are o intersectie cu linia de
delimitare.

12 Break

Rupe obiectul selectat intre doua puncte. Puteti crea un spatiu intre doua puncte specificate pe un obiect,

impartindu-l Tn doua obiecte. Selectati "Edit Tab > Modify Panel > Break", selectati obiectul, utilizati pozitia
pe care ati facut clic ca prim punct de intrerupere, apoi specificati al doilea punct de intrerupere; pentru a re-
desemna primul punct de intrerupere, introduceti ,,F” pentru a specifica primul si al doilea punct de intrerupere
de rupere.

Note: Entitatile de linie acceptate sunt segmente de linie, polilinii, arce, nori, spline si elipse.

13 Tntinde

intinde obiectele traversate de o fereastra de selectie sau poligon. Obiectele care sunt partial inchise de o

fereastra de trecere sunt intinse. Selectati "Edit Tab > Modify Panel > [ Stretch", selectati obiectul 2D de mutat
sau intins, specificati mai Tntai punctul de baza si apoi al doilea punct. Efectul este asa cum se aratda mai jos.
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1002117

G BH= G0

Before After

Note:

@ Caseta selectati unul sau mai multe puncte ale unei entitati de linie pentru a se intinde local.

@ Punct sau caseta selectati intreaga linie pentru a o muta in intregime.

4.1.14 File

Adauga colturi rotunjite la obiectele 2D intersectate sau la volum. Selectati "Edit Tab > Modify Panel > Fillet".
1. Rotunjirea entitatilor de linie: Selectand doua linii neparalele, setati raza colturilor rotunjite.

2. Rotunjirea colturilor
volumului 3D este generata prin
selectarea marginilor volumului
3D; Efectul este prezentat in cele

ce urmeaza figura

3. Tastati ,R” si apasati Enter
Before After

pentru a seta raza coltului

rotunjit.

4.1.15 Tesit

Adauga tesituri obiectelor 2D intersectate sau volumului. Selectati "Edit Tab > Modify Panel > Chamfer"

articol.
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1. Tesirea obiectelor

2D intersectate, selectand

douda non-linii  paralele,

generate la distanta de tesire |::>
stabilita.

2. Tesirea volumului 3D este

Before After

generata prin  selectarea
planului principal tesit si a
muchiilor tesite.

3. Introduceti ,D” si apdsati Enter pentru a seta distanta de tesire.

4.1.16 Neted

Transforma o polilinie Tntr-o spline. Selectati "Edit Tab > Modify Panel > Smooth" si selectati o polilinie.

4.1.17 Explode

Descompune obiectele selectate. Selectati "Edit Tab > Modify Panel > Explode" si selectati obiectele pentru
a exploda.

Note:

(@ Rupere in planuri atunci cdnd obiectul selectat este un volum.

@ Se imparte in linii atunci cAnd obiectul selectat este un plan..

(® Rupere in segmente de linie atunci cand obiectul selectat este o polilinie.
@ Selectarea unei spline o transforma intr-o polilinie.

(G Selectati entitatile grupate pentru a le degrupa.

4.1.18 Matrice

4.1.18.1 Copiere matrice

Genereaza rapid mai multe copii ale obiectelor sau ale altor componente la o distanta sau un numar stabilit.
Selectati "Edit Tab > Modify
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|ll] Array > lll| Array Copy" pentru a deschide urmatoarea casetd de dialog.

Array Copy
Reference | Entire row
Original position _|Reference Amount 5 _|Base point
Select lines " IFollow Amount 5 | Base point
Draw line | Follow Amount 5 _|Basepoint  Two-dimensional

Panel
1. Pe etaj: Generarea de copii Tn functie de etajul cladirii sau de deschidere.

(1) Referinta.
@ Bifati "Reference" pentru a utiliza planul vertical al cladirii selectate ca plan de referinta.

(2 Dac3 "Reference" nu este bifat, planul vertical al cl&dirii pe o razd de 2 metri este utilizat ca plan de

referinta.

(2) Intreaga coloana.

(D Bifati "Entire column" pentru a genera o copie a coloanei cu entitatea selectat in-situ..

@) Debifati "intreaga coloan3" pentru a genera o coloand sau un strat de copii pornind de la locatia

entitatii si urmand pozitia cursorului.

De exemplu, bifati "Reference" si debifati "Entire column". Faceti clic pe butonul "By Layer" (Dupa strat),
selectati mai ntai planul vertical al cladirii ca referinta, apoi selectati entitatile care urmeaza sa fie aranjate,
astfel Tncat cursorul sa se deplaseze in sus si Tn jos (dupa strat) si sa precizeze punctul final pentru a genera mai

multe copii ale entitatilor intre cele doua puncte. Efectul este prezentat in figura urmatoare.
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~
Before After

2. Punct de ridicare: Genereaza mai multe copii incepand cu entitatea selectata.
(1) Referinta..

(D Bifati "Referintd" pentru a genera o copie in directia liniei de referinta selectate.

@ Cu "Reference" debifat, specificati doud puncte pentru a determina o linie si generati o copie de-a

lungul acestei linii.

(2) Suma.

(D Suma: genereaza copii ale sumei introduse in caseta de text (inclusiv entitatea originald).
n 2
i

2@ Distanta: Faceti clic pe "Amount

doua copii adiacente si generati copii la aceasta distanta.

(3) Punctul de baza.

n fontul albastru si treceti la "Distance". Setati distanta dintre

(D Bifati "Base point" (Punct de bazd) pentru a specifica pozitia in raport cu entitatea original3,

utilizand acel punct ca punct de plecare pentru referinta.
Punctul central al entitatii este utilizat ca punct de baza fara a bifa caseta "Punct de baza".
De exemplu, bifati "Reference", "Number" si "Base". Faceti clic pe butonul "Home", selectati marginile
cladirii, entitatile etc., apoi selectati entitatile care urmeaza sa fie aranjate, specificati punctul de baza,
deplasati cursorul si specificati punctul final pentru a genera mai multe copii ale entitatilor intre cele doua

puncte. Efectul este prezentat in figura urmatoare.
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Copy Source entity
..... =2 Z | Jm i
X direction l
1 &
[y
=
(=]
=
Reference line

3. Selectati Linie: Genereaza o copie de-a lungul traseului selectat.

(1) Urmariti.

(D Bifati "Follow" si copia rezultat3 este rotitd pentru a se potrivi cu orientarea traseului.

2 Dacé optiunea "Follow" (Urmérire) este debifata, copia este generata la unghiul originalului..
(2) Suma.

(D Suma: genereaza copii in suma introdusa in caseta de text.

2@ Distanta: Faceti clic pe "Quantity" (Cantitate) in font albastru si comutati la "Distance" (Distant3).
Setati distanta dintre douad copii adiacente si generati copii la aceasta distanta.

(3) Base point.
(D Check "Base point" to specify the position relative to the original entity, i.e. the position of the final

copy relative to the path.

@ Dacd "Punct de baza" nu este bifat, punctul central al entitatii este punctul de baz, adicd punctele
centrale ale copiilor se afld toate pe linia de traseu.

De exemplu, bifati "Follow", "Number" si "Base point". Faceti clic pe butonul "Select Line" (Selectare linie),
selectati mai intai linia de traseu, apoi selectati entitatea care urmeaza sa fie aranjatd, in functie de pozitia
relativa a punctului de baza si a entitatii originale, de-a lungul liniei de traseu pentru a genera o copie. Efectul

este prezentat in figura urmatoare.
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G a ‘
Before After

Nota: Daca punctul de baza specificat este decalat cu o distanta fata de entitatea originala, copia finala
generata este, de asemenea, decalata cu o distanta corespunzatoare fata de traseu.
4. Desenati linia: Genereaza o copie de-a lungul liniei 2D sau 3D..
(1) Urmariti.
(D Bifati "Follow" si copia rezultats este rotitd pentru a se potrivi cu orientarea traseului.
2@ Dacd optiunea "Follow" (Urmérire) este debifata, copia este generatd la unghiul originalului..
(2) Suma.

(D Cantitate: cantitatea implicitd. Genereazi copii ale cantititii introduse in caseta de text.

@ Distanta: Faceti clic pe "Amount" Tn fontul albastru si treceti la "Distance". Setati distanta dintre

doua copii adiacente si generati copii la aceasta distanta.
(3) Punctul de baza.
(@ Bifati "Punct de baza" pentru a specifica pozitia in raport cu entitatea original3, adic3 pozitia copiei
finale in raport cu traseul.

(@ Dacd "Punct de baza" nu este bifat, punctul central al entitatii este utilizat ca punct de bazi, adic3

punctele centrale ale copiilor se afla toate pe linia de traseu.
(4) Bidimensionala.

@D Bidimensional: n mod implicit, liniile de traseu sunt desenate in acelasi mod ca si polilinii
bidimensionali.

@ 3D: Faceti clic pe fontul albastru "2D" si comutati la "3D". Deseneazi linia de traseu n acelasi mod

ca o polilinie tridimensionala.
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De exemplu, bifati "Follow" (Urmeaza), "Number" (Numar) si "Base point" (Punct de baza) pentru a desena
in 2D Tn mod implicit. Faceti clic pe butonul "Draw Line" (Trasare linie), selectati entitatea care urmeaza sa fie
aranjata, specificati mai intai punctul de baza, apoi specificati locatia primei copii care urmeaza sa fie generata
si utilizati-o ca punct de plecare pentru a crea entitatea. Apoi, desenati traiectoria in acelasi mod in care

desenati o polilinie si faceti clic dreapta pentru a incheia generarea. Efectul este prezentat in figura
urmatoare.

Before

4.1.18.2 Matrice planara

CIC]
Genereaza mai multe copii ale obiectului selectat. Selectati "Edit Tab > Modify Panel > Array > BB planar

Array" pentru a deschide caseta de dialog prezentata mai jos.

Planar Array X
Apply
Number of rows : & Row spacing : 1
Number of columns : 4 Column spacing : 1

Angle: 0 Select :

1. Setarile parametrilor.
(1) Setarea numarului si a spatierii exemplarelor.

(2) Setati unghiul matricei, fie manual, fie facand clic pe fontul albastru "Angle" si specificand doua puncte
pentru trasarea liniei, folosind unghiul dintre linie si directia pozitiva a axei X ca unghi al liniei.
2. Faceti clic pe "Select" (Selectare) in albastru si selectati obiectele (alte entitati decat drumurile si terenul).

3. Faceti clic pe butonul "Apply" (Aplicati) pentru a finaliza matricea si a genera mai multe copii.

Page 107 of 241



Houseplan 1.0 Make stunning 3D scheme with speed and ease

4.1.19 Grup

4.1.19.1 Grupul de entitati

Grupeaza mai multe obiecte intr-un intreg pentru a facilita operatiile de mutare, rotire, copiere sau stergere a
acestora. Selectati "Edit

Tab > Modify Panel > Group > Entity Groupsi selectati mai multe obiecte pentru grupare.

Note:

@ Grupurile nu sprijina cladirile si componentele.

@ Apasati ctrl + shift pentru a selecta o singura entitate din cadrul grupului.

(@ Poate grupa entitati care fac deja parte dintr-un grup.

@ Selectati o entitate in timp ce apasati tasta "ctrl + Alt" pentru a o separa de grup.
4.1.19.2 Dezgrupare Entitate

p—— r_
Eliminad relatia de grupare. Selectati " Edit Tab > Modify Panel > Group > L— Entity Ungroupapoi selectati

obiectele grupate pentru a le dezagrega. De asemenea, puteti utiliza functia "explode" pentru a dezagrega entitatile.
Atunci cand se degrupeaza entitati in grupuri cu mai multe niveluri, fiecare actiune unica degrupeaza numai grupul

cel mai exterior.

4.1.20 Text

Insereaza text Tn spatiul de lucru. Selectati "Edit

Tab > Modify
D Enter text
Panel > Text" pentru a deschide urmatoarea caseta
de dialog.
Note:
(@D Atunci cand cursorul se afld pe un arc de Font:  txt.shx < I hEdiz) 2,50
Color: E,ZSS,ZSS Thickness: 0.00

cerc, textul este ajustat la unghiul planului *”*

Confirm

tangent.
@ in paleta de proprietiti, se pot modifica
pozitia, unghiul, proprietatile de afisare pe ecran si spatierea textului.

(® Puteti face dublu clic pe text, sau faceti clic pe elementul "Content" din paleta de proprietati si selectati
butonul pentru a modifica continutul textului.
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4.2 Panou de masurare

4.2.1 Distanta

Masoara distanta dintre doua puncte. Selectati "Edit Tab > Measurement Panel > [.] Distance ", specificati doua

puncte si afisati valoarea distantei pe linia de comanda. in timpul m&surdrii, distanta este afisata in timp real in program.

4.2.2 Unghiul liniei

Masoara unghiul dintre doua drepte aflate in acelasi plan. Selectati "Edit Tab > Measurement Panel > Line Angle",
selectati doua linii si afisati valoarea unghiului pe linia de comanda.

Note:

@ Atunci cand se selecteaza un arc, se masoara unghiul liniei tangente.

@ Unghiul liniei este afisat in timp real in program in timpul masuratorii.

4.2.3 Unghiul planului

Masoara unghiul dintre doud entitati plane oarecare. Selectati "Edit Tab > Measurement Panel > Plane
Angle", selecteaza doua planuri si afiseaza valoarea unghiului pe linia de comanda.

Note:

@ Nu accepta masurarea planurilor curbe.

@ La masurare, unghiul planului este afisat in timp real in program.

4.3 Panou de pozitionare

4.3.1 Miscare normala

Deplaseaza un obiect selectat de-a lungul directiei normale a planului sau marginii selectate. Selectati "Edit Tab >
Positioning Panel >

ﬁ Normal Move", urmati instructiunile din linia de comanda, plasati cursorul pe planul sau marginea obiectului

selectat, evidentiati-I si trageti-l pe orizontala sau verticala.
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Note:

@ Cursorul poate fi fixat pe planurile sau marginile entitdtilor. De exemplu, partile laterale si partea
superioara/inferioara a unei cladiri pot fi fixate, precum si marginile entitatilor, cum ar fi balcoanele,

planurile etc..

@ Atunci cand un plan este fixat, intregul plan este evidentiat si se afiseaza cursorul cu cruce rosie. In acest
moment, trageti de-a lungul planului in directia verticald, in sens Tnainte sau fnapoi, asa cum indicd

sageata, pentru a obtine o functionare continua.

(® Atunci cand se fixeaza pe marginea sau pe planul unei forme curbe, se deplaseaza de-a lungul directiei
perpendiculare a liniei tangente.

@ Tn timpul tragerii, deplasati cursorul pe alte planuri pentru a alinia entitatile. in general, selectati un plan
aflat in aceeasi directie ca o referintda. De exemplu, atunci cand selectati planul superior al unei cladiri
pentru a o deplasa, daca tineti apasat butonul din stanga, deplasati cursorul in planul superior al unei alte

cladiri sau al altei entitati pentru ca varfurile ambelor sa fie la aceeasi inadltime.

(® Entitatile de linie nu sunt acceptate.

4.3.2 Nivelare inferioara

Adjusts the height of the selected object's floor from its base point. Select "Edit Tab > Positioning Panel >
Bottom Leveling", according to the command line prompt, first select the reference plane and enter the height
relative to the reference plane, then select the object. You can adjust the elevation of the entity based on the

reference plane and the relative height.
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Before

La selectarea entitatilor, introduceti "W". Puteti selecta mai multe entitati si ajusta fndltimea Tn mod uniform.

Note:

@ Atunci cand este selectat un plan de referinta, planul este afisat cu rosu atunci cand se face clic pe
planul unui volum. Atunci cand nu exista niciun plan in locatia n care s-a facut clic, se creeaza automat

un plan orizontal in rosu, centrat pe punctul in care s-a facut clic, pentru a indica planul de referinta.

v A v

(@ Daca este setata indltimea relativd, cota nivelata = indltimea planului de referinta + indltimea relativa.
De exemplu, daca planul de referinta este specificat la o Thaltime de 10 m si Tnaltimea relativa este

stabilita la 2 m, se selecteaza o cladire a carei inaltime a punctului cel mai jos este de 12 m.

(® Drumurile nu sunt acceptate. Drumurile pot fi modificate prin intermediul paletei de proprietati pentru
indltimea sau elevatia de Tnceput si de sfarsit.

4.3.3 Rotirea axei

PRI
Roteste un obiect selectat dupa axa si unghiul specificate. Selectati "Edit Tab > Positioning Panel >.Axis
Rotation", Tn functie de linia de comanda, plasati cursorul pe marginea entitatii in sine si faceti clic sau introduceti

unghiul de rotatie Tn jurul acestei margini ca axa. Puteti face clic continuu pentru a roti.
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Introduceti "S" pentru a roti obiectul folosind liniile de margine ale altor entitati ca axe. De exemplu, dupa
introducerea lui "S", selectati mai intai entitatea A ca obiect de rotire, faceti clic dreapta pentru a incheia selectia,
moment Tn care cursorul este plasat pe linia de margine a entitatii B si se face clic pe ea, adica linia de margine a lui
B este utilizata ca axa de rotire, pentru a roti A.

Note:

(D Obiectele rotite accepta linii, planuri (cu exceptia planurilor de grild), poligoane editabile si text.
(@ Textul nu poate fi rotit pe propria axa. Textul poate fi rotit prin selectarea unui alt obiect ca axa de rotatie.

(® Axa de rotatie accepta selectarea majoritatii entitatilor, cu exceptia entitatilor speciale, cum ar fi scenele
de fundal si textul.

4.3.4 Rotire pe orizontala

Se ia punctul central al unei drepte sau al unui plan si se roteste astfel incat sa fie paralel cu planul XOY. Select
"Edit Tab > Positioning Panel >

E Rotate to Horizontal" si selectati obiectul pentru a-l roti pe orizontala.

Before After
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Note:

@ Daca punctul se afla pe o dreapta, se roteste segmentul de dreapta pe care s-a facut clic la orizontald cu
punctul sdu median; daca punctul se afla pe planul unui plan sau al unui volum, se roteste planul pe care

s-a facut clic la orizontala cu centrul sau.
@ Planurile de grila nu sunt acceptate.
4.3.5 Rotire verticala

Se ia punctul central al unei drepte sau al unui plan si se roteste astfel incat sa fie perpendicular pe planul XOY.
Selectati "Edit Tab > Positioning

Rotate to Vertical " and select the object to rotate horizontal ly.

-
:>.

Before After

Plane >

4.3.6 Entitati adiacente

Adapteaza planul sau linia selectata la pozitia specificatd. Selectati "Edit Tab > Positioning Panel > &f#8l Adjacent
Entities", se selecteaza mai Intai planul sau marginea obiectului 1 ca referinta, apoi se selecteaza planul sau marginea

obiectului 2 pentru a se potrivi cu obiectul 1.
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Before After

Note:

@ Atunci cand este selectat planul unui volum, acesta este aliniat cu centrul planului.
(@ Atunci cand sunt selectate marginile entitatii, acestea sunt aliniate la punctul median al marginilor..

(® Entitatile de referintd si entitatile paralele pot fi oricare dintre: cladiri si componente, linii si alte entitati.
4.3.7 Alinierea entitatilor
Aliniaza planul sau linia selectata la pozitia specificata. Selectati "Edit Tab > Positioning Panel > i Align Entities"

selectati mai Tntai planul sau muchia obiectului 1 ca referintd, apoi selectati un plan sau o muchie a obiectului 2 si

aliniati-I cu obiectul 1.

Note: Obiectele de referinta si paralele pot fi oricare dintre: cladiri si componente, linii si alte obiecte.
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4.3.8 Aranjament
4.3.8.1 Aranjati de-a lungul liniei

Aranjeaza entitatile in ordine de-a lungul unei traiectorii. Selectati "Edit Tab > Positioning Panel >Arrange

Along Line" si urmati instructiunile din linia de comanda dupa cum urmeaza.

i
B
Before - -

Reference object Entity net distance
riter D [  pEmamy
Normal net distance
Reference line

1. Introduceti o valoare pentru a determina distanta normala a retelei. De exemplu; distanta dintre obiect si linia
de referinta atunci cand acesta este aliniat in final.

2. Selectati liniile de margine ale obiectelor ca linii de referintd. in continuare, introduceti valori pentru a
determina distanta dintre entitatile aliniate si selectati entitatile care urmeaza sa fie aliniate.

3.7n cele din urm3, selectati entitatea de referint3, iar celelalte entititi sunt dispuse echidistant cu entitatea de
referinta ca baza..

4.3.8.2 Copie directionala

Copiaza un obiect selectat in directie paralela sau perpendiculara pe linia de referinta. Selectati "Edit Tab >
Positioning Panel >

E Directional Copy", si urmati instructiunile din linia de comanda, dupa cum urmeaza.
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Reference line

1. Selectati linii sau muchii solide ca linii de referinta.

2. Selectati entitatea care urmeaza sa fie copiatad si, Tn acest moment, deplasati cursorul Tn directia paraleld,
perpendiculard sau pe axa Z a liniei de referinta, utilizind centrul entitatii ca punct de baza pentru a preciza

unde trebuie generata copia.. Introduceti S pentru a realoca punctul de baza pentru copiere.

5 Meniul de modelare

Acest capitol prezinta diverse caracteristici traditionale si avansate de modelare care permit utilizatorilor sa

creeze, sa modifice si sa rafineze cladirile si entitatile din schema in functie de efectul redat..

5.1 Panou de modelare avansata

Advanced Modeling are capacitati puternice de modelare, oferind operatiuni flexibile si versatile legate de

puncte, linii si planuri pentru a face fata cu usurinta si eficienta tuturor tipurilor de procese complexe de modelare..
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5.1.1 Modelare avansata

Advanced Modeling pentru a deschide caseta de dialog

Select "Modeling Tab = Advanced Modeling Panel >
prezentatd mai jos.

Advanced Modeling H
Vertex: 0 Edge: 0 Polygon: O Edged Faces v
/Create [ Vertex [ Edge | Polygon | Element [ Object |
[ Rectange | Box Convert
NGon Sphere
Polygon Cylinder
Circle Torus
Ellipse Cone
Donut Pyramid
Star
Polygon Object Convert
Transform: @ Select | Move _Rotate _Scale _Lock
State: Snap | |Orthogonal || Ignore BackFacing " Local
Constraint: | X Y | Z | XY YZ | X

Note: in filele vertex, edge, poligon, element si obiect din modelarea avansati, functiile sau instrumentele Copy,
Delete, Move, Rotate, Scale si Delete din fila "Edit" nu sunt disponibile.

5.1.2 Mod de afisare

Click '™ din coltul din dreapta sus al panoului pentru a extinde lista derulant3, dup3 cum se arat3 mai jos.

1. Fete cu margini: Poligoanele editabile sunt afisate in mod implicit ca
Edged Faces vt

n H n
model + wireframe". :
Wireframe
Facets
2. Wireframe: Se afiseaza sub forma de wireframe. Edged Faces

3. Fatete: Se afiseaza in modul model.

Note: Puteti utiliza tasta de comanda rapida F9 pentru a trece prin cele trei moduri de afisare.
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5.1.3 Varf, muchie, poligon

Afiseaza in mod dinamic numarul total
Vertex: 146 Edge: 306 Polygon: 162
de varfuri, linii si planuri ale poligoanelor
editabile.

Note: Contine atat cele selectate, cat si cele neselectate, cele ascunse nu sunt luate in calcul.

5.1.4 Transformare

5.1.4.1 Selectare

Select (Selectare) este o comanda de stare care trece implicit la starea selectatd. in mod normal, obiectele pot fi
addugate la setul de selectie prin "selectarea lor una cate una" sau prin "selectarea ferestrei" pentru operatiuni

ulterioare. Dupa cum se arata mai jos:

1. Pentru a adauga obiecte la setul de selectie, trebuie sa tineti apasata tasta "Ctrl" si sa selectati obiectul care
urmeaza sa fie adaugat.

2. Pentru a elimina obiecte individuale din setul de selectie, trebuie sa tineti apasata tasta "Alt" si sa selectati
obiectul care urmeaza sa fie eliminat.

3. Pentru a inversa selectia curenta a obiectelor, trebuie sa tineti apdsata tasta "Shift" si sa selectati obiectul pentru
a inversa selectia.

Note: Optiunile Select, Move, Rotate si Scale nu pot fi activate Tn acelasi timp; doar una dintre ele poate fi activata
in orice moment..
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5.1.4.2 Mutare

Selecteaza si deplaseaza obiectul. Atunci cand se afla in starea selectat, obiectul este deplasat in urmatoarele
moduri.

1. Mutarea directa, faceti clic pe un obiect si trageti mouse-ul direct pentru a muta obiectul.

2. Selectati si deplasati. Addugati mai intai obiectul care urmeaza sa fie deplasat la setul de selectie si deplasati-|

specificand punctul de referinta din setul de selectie ca punct de baza.

3. Faceti clic dreapta pe butonul Move (Deplasare) si setati distanta de deplasare a obiectului selectat in fereastra
pop-up.
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Move Transform Type-In

Directia de deplasare este determinata de mouse si de sistemul de coordonate de referinta curent. Pentru a
restrictiona miscarea obiectului Tn raport cu planul definit de axele X, Y sau Z sau de oricare doua dintre acestea,
faceti clic pe butonul corespunzator din bara de instrumente Constraints sau faceti clic direct pe axa pentru a bloca
temporar axa corespunzatoare..

Note:

(@ Puteti sd apasati tasta Shift si sa trageti axa, sd introduceti numarul de copii in caseta de dialog si sa faceti

clic pe butonul "OK" pentru a copia pe loturi obiecte de-a lungul directiei cu intervale egale..

@ Optiunile Select, Move, Rotate si Scale nu pot fi activate in acelasi timp; doar una dintre ele poate fi

activata Tn orice moment.

(® Aceastd comanda corespunde comenzii de mutare din UV Editor.

5.1.4.3 Rotiti

Selecteaza si roteste obiectul. Atunci cand ORotate este selectat, obiectul este rotit in urmatoarele moduri.

1. Rotatie directa, faceti clic pe un obiect si trageti mouse-ul direct pentru a roti obiectul.
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[-37.75,0.00,0.00]

2. Selectare si rotire, obiectul care urmeaza sa fie rotit este mai Intdi adaugat la setul de selectie si rotit prin

specificarea punctului de referinta din setul de selectie ca punct de baza.

[42.69,-94.83,69.45]
-/_,_,—H—_‘_\\\

3. Faceti clic dreapta pe butonul Rotate si setati unghiul de rotatie al obiectului selectat in fereastra pop-up.
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Rotate Transform Type-In

Z: 0.000

Directia de rotatie este determinatda de mouse si de sistemul de coordonate de referinta curent. Pentru a
restrictiona rotatia obiectului la planul definit de axele X, Y sau Z sau de oricare doud dintre acestea, faceti clic pe
butonul corespunzator din bara de instrumente Constraints sau faceti clic direct pe axa pentru a bloca temporar axa
corespunzatoare. in cazul in care axele XY, YZ sau XZ sunt blocate in acelasi timp, modelul va rimane neschimbat.

Note:

@ Puteti apasa tasta Shift si trageti axa, introduceti numarul de copii in caseta de dialog si faceti clic pe

butonul "OK" pentru a roti pe loturi obiecte cu unghiuri egale.

@ Optiunile Select, Move, Rotate si Scale nu pot fi activate in acelasi timp; doar una dintre ele poate fi
activata in orice moment.
® Aceastd comanda corespunde comenzii de rotatie din UV Editor..

5.1.4.4 Scala

Selecteaza si redimensioneaza obiectul. Atunci cand O scale se afla in starea selectat, obiectul este

redimensionat in urmatoarele moduri

1. Scalare directa, faceti clic pe un obiect si trageti direct mouse-ul pentru a scala obiectul.
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2. Selectare si scalare, obiectul care urmeaza sa fie scalat este mai Tntai adaugat la setul de selectie si scalat prin

specificarea punctului de referinta din setul de selectie ca punct de baza.

3. Faceti clic dreapta pe butonul "Scale" si setati scara de marire a obiectului selectat in fereastra pop-up.
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Scale Transform Type-In

100.000 y: 100.000 Z: 100.000

Directia de scalare este determinata de mouse si de sistemul de coordonate de referinta curent. Pentru a
restrictiona scalarea obiectului la planul definit de axele X, Y sau Z sau de oricare doua dintre acestea, faceti clic pe
butonul corespunzator din bara de instrumente Constraints sau faceti clic direct pe axa pentru a bloca temporar
axa corespunzatoare.

Note:

@ Puteti sd apasati tasta Shift si sa trageti axa, sd introduceti numarul de copii in caseta de dialog si sa faceti

clic pe butonul "OK" pentru a copia pe loturi obiecte cu proportii egale..

@ Optiunile Select, Move, Rotate si Scale nu pot fi activate in acelasi timp; doar una dintre ele poate fi

activata Tn orice moment..

(® Aceastd comandd corespunde comentzii scalei din UV Editor.

5.1.4.5 Blocare

Activeaza sau dezactiveazd blocarea selectiei, care Tmpiedica selectarea accidentald a altor entitati in scene

complexe.

Tn mod implicit, acest buton nu este bifat. Daca bifati butonul de blocare si activati aceasts functie, puteti face
clic sau trage cursorul oriunde Tn fereastra de vizualizare fard a pierde setul de selectie curent sau fara a adauga noi
obiecte nedorite la setul de selectie curent. Pentru a anula sau modifica selectia, debifati elementul de blocare.

Pe bara de instrumente, bifati butonul de blocare si activati unul dintre butoanele de mutare, rotire sau scalare.

Trageti oriunde in viewport pentru a muta, roti sau scala obiectele din setul de selectie.
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5.1.5 Stare

5151 Snap

Atunci cand creati si editati poligoane

. . A o v i |
editabile Th panoul Modelare avansats, &4 Endpoint Center of drde
. . . s . M Sna i Midpoint i Closest point
puteti activa functia snap pentru a va ajuta & snap & ridpo = e
. . . . Intersection Erlane
in operatiunea de pozitionare precisa.
Perpendicular point

Faceti clic pe caseta de selectare din partea
Mouse pick box(0-50):  ©

de jos a panoului pentru a activa sau
Mouse capture frame(2-20): 10

dezactiva functia snap. Faceti clic dreapta pe
Cursor length (1-100): 6

caseta de selectare MASnap pentru a

deschide caseta de dialog prezentata mai jos. Select all [ Confirm ] Cancel

Puteti seta optiuni de fixare, unde

"plan" se refera la suprafata unui plan sau a

unei entitati. Faceti clic pe butonul "Select All" (Selectati
totul) pentru a bifa toate casutele; faceti clic pe butonul
"Confirm" (Confirmare) pentru a aplica setarile. Nota: Atunci
cand va fixati la centrul cercului unui arc, trebuie sa treceti
cursorul peste linia de margine pentru a afisa centrul

cercului.

5.1.5.2 Ortogonal

Limiteaza operatiunea la orientarea orizontala sau verticala. Faceti clic pe
caseta de selectare. User

4 orthogonal i, partea de jos a panoului pentru a activa sau dezactiva functia v World
ortogonald. Faceti clic dreapta pe caseta de selectare 4 orthogonal pentru a
deschide urmatorul meniu.

1. Selectati "World": Operatiunea se efectueaza in directia coordonatelor mondiale (adica axele din coltul din
stanga jos al software-ului).
2. Selectati "User" (Utilizator): Operatiunea se efectueaza in directia axei definite de catre utilizator.
Puteti urma instructiunile din linia de comanda si introduceti unghiul cu directia X din sistemul de

coordonate mondial ca directie a axei X in sistemul de coordonate al utilizatorului; sau puteti selecta marginea
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sau linia ca directie ortogonald; puteti, de asemenea, sa trageti linia pentru a o obtine. Introduceti "D" si apasati
ENTER, specificati doua puncte si desenati directia ortogonald. Daca aveti nevoie sa stergeti directia ortogonala
definita, introduceti "C" si apasati ENTER.

Note:

@ Atunci cand functia ortogonald este activata, operatiile, cum ar fi desenarea, pot fi efectuate numai in
directiile axelor X, Y sau Z.

@ Atunci cand sunt activate atat snapping-ul, cit si ortogonala, snapping-ul are prioritate.
(® Céand se traseaza o linie pentru a o obtine, cele doua puncte sunt trasate cu directii si unghiuri diferite.

5.1.5.3 Ignorati BackFacing

Atunci cand aceastd optiune este activata, pot fi selectate numai punctele, liniile si planurile vizibile in spatiul de
lucru. Cand aceasta optiune este dezactivata, pot fi selectate toate punctele, liniile si planurile din fereastra de
vizualizare. Faceti clic pe caseta de selectare 4 1gnore BackFading din partea de jos a panoului pentru a activati sau

dezactivati aceasta functie.
5.1.5.4 Local

Pozitia nativa, si anume, coordonatele proprii ale obiectului. Faceti clic pe caseta de selectare B Local din partea
de jos a panoului pentru a activa sau dezactiva aceasta functie.

Note:

@ Cand coordonatele proprii sunt bifate, este afectata directia axiala a operatiei; cdnd coordonatele proprii

sunt debifate, este vorba de directia axiala Tn coordonate mondiale..

(@ Operatiile afectate sunt mutarea, rotirea, scalarea, oglindirea, aranjarea, alinierea, transformarea, etc..

(® Puteti vizualiza directia coordonatelor proprii ale entitatii utilizand functia "Axis Transformation" .
5.1.6 Constraint

Constrangeri, adica constrangeri axiale. Faceti clic pe butonul din partea de jos a panoului pentru a activa sau

dezactiva functia de constrangere pentru axa corespunzatoare, dupa cum arata figura urmatoare.

Constraint; | X Y Z XY YZ ZX

Note:
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@ Constrangerile de axa afecteaza axele functiilor de deplasare si de zoom. De exemplu, daca constrangeti
axa x, v puteti deplasa numai in directia axei x atunci cand efectuati o deplasare. in mod similar, dac axa

X este constransa, deplasarea poate fi efectuata numai in planul XOY.

(@ Atunci cand "Snap" este bifat, deplasarea se face in directia constrangerii, desi este posibila deplasarea
prin punctul de fixare.

(® De asemenea, puteti obtine efectul de constrangere tragdnd cursorul intr-o directie axiala fard a bifa

caseta "Constraint".

5.2 Creare fila

Converteste obiecte precum planuri si volume in entitati poligonale editabile.

5.2.1 Instrumente poligonale

5.2.1.1 Dreptunghi

Creeaza un plan dreptunghiular. Selectati "Create Tab > Polygon > Rectangle", specificati primul punct de colt,
trageti-l in locatia tinta ca un alt punct de colt.
Nota: Dupa activarea planului dreptunghiular desenat, aliasul sdu, culoarea stratului insotitor, netezirea, lungimea,

[atimea si alti parametri pot fi modificati in paleta de proprietati.

5.2.1.2 NGon

Creeaza un plan poligonal regulat. Selectati "Create Tab > Polygon > NGon", introduceti o valoare pentru a
determina numarul de laturi si apoi incepeti sa desenati. Exista trei moduri de a genera.

1. Deseneazd un poligon patrat in interiorul unui cerc: Specificarea punctului central si introducerea razei
genereaza un poligon patrat.

2. Desenati un poligon regulat pe baza lungimilor laturilor specificate: Introduceti sau introduceti "E" si apasati
Enter pentru a specifica doua puncte ca lungimi ale laturilor poligonului regulat.

3. Pentru a desena un poligon patrat tangent la un cerc: Introduceti sau introduceti "C", specificati punctul central,
introduceti raza si generati un poligon patrat..

Note:

@ Rezultatul generat este un plan editabil..

(@ Puteti modifica proprietatile planului poligonal pe paleta de proprietéti.
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aca planul poligonului desenat a fost editat, numarul de laturi si parametrii razei tangentei interne din
Daca pl | pol luid t a fost editat arul de lat t t t t d
paleta de proprietati nu pot fi modificati.

5.2.1.3 Poligon

Creeaza planuri poligonale. Rezultatul generat este un plan editabil. Selectati "Create Tab > Polygon > Polygon
> Polygon", specificati punctul de plecare si desenati poligonul direct; sau introduceti "S" pentru a desena
poligonul in spatiul 3D. Pentru a intrerupe operatiunea anterioara, tastati "U" si apasati enter.

5.2.1.4 Cerc

Creeaza un plan circular. Selectati "Create Tab > Polygon > Circle" pentru a crea un cerc cu centrul si raza
specificate..

5.2.1.5 Ellipse

Creeaza un plan eliptic. Selectati "Create Tab > Polygon > Circle" pentru a crea o elipsa cu centrul si lungimea axei
specificate.
5.2.1.6 Gogoasa

Creeaza uninel cu o sectiune transversala circulara. Selectati "Create Tab > Polygon > Donut", specificati centrul

cercului, apoi setati razele interioare si, respectiv, exterioare.

Note:

(@ Pentru a seta raza, specificati locatia cu ajutorul mouse-ului sau introduceti valoarea in linia de comanda.

(@ Paleta de proprietati va permite sa modificati parametrii, cum ar fi alias, culoarea stratului de insotire,
netezirea, raza cercului exterior, raza cercului interior, punctul central, etc..
5.2.1.7 Stea
Creeaza un plan inchis in forma de stea. Selectati "Create Tab > Polygon > Star", specificati punctul central,

introduceti o valoare pentru a determina numarul de unghiuri ale stelei, apoi setati razele exterioare si interioare.

Note:

@ Pentru a seta raza, specificati pozitia cu ajutorul mouse-ului sau introduceti valoarea in linia de comanda.

(@ Paleta de proprietati va permite sa modificati informatii despre parametri cum ar fi alias, culoarea stratului

insotitor, netezirea, punctele de colt, raza exterioard, raza interioara, punctul central etc.
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5.2.2 Instrumente de obiect

5.2.2.1 Cutie

Creeaza o cutie. Selectati "Create Tab > Object > Box", desenati partea de jos a cutiei, introduceti inaltimea.
ota: Paleta de proprietati va permite sa modificati informatii despre parametri cum ar fi alias, culoarea atasata
straturilor, netezirea, sectiunea de lungime, sectiunea de latime, sectiunea de Tndltime, lungimea, latimea,

inaltimea, centrul, elevatia etc.

5.2.2.2 Sfera

Creeaza o sfera. Selectati "Create Tab > Object > Sphere", specificati centrul sferei si introduceti raza.

Nota: Paleta de proprietati va permite sa modificati informatii despre parametri precum alias, culoarea atasata

straturilor, netezirea, numarul de laturi, raza, centrul, elevatia etc.

5.2.2.3 Cilindru

Creeaza un cilindru. Selectati "Create Tab > Object > Cylinder", desenati baza cilindrului si introduceti inaltimea.
Nota: Paleta de proprietati va permite sa modificati informatii despre parametri precum alias, culoarea atasata
straturilor, netezirea, numarul de laturi, sectiunea Tnhaltimii, sectiunea fetei, raza, Tnaltimea, centrul, elevatia etc.

5.2.2.4 Torus

Creeaza un volum de apelare. Selectati "Create Tab > Object > Torus ", specificati centrul cercului, introduceti raza
cercului si raza torului.

Note: Paleta de proprietati va permite sa modificati informatii despre parametri cum ar fi alias, culoarea atasata

straturilor, netezirea, numarul de laturi, sectiunea, unghiul de rotatie, raza cercului interior, raza cercului exterior,

centrul, elevatia etc.

5.2.2.5 Con

Creeaza un con. Selectati "Create Tab > Object > Cone", specificati centrul cercului, introduceti raza planurilor
superior si inferior, introduceti indltimea.

Nota: Paleta de proprietati va permite sa modificati informatii despre parametri cum ar fi alias, culoarea atasata

straturilor, netezirea, numarul de laturi, sectiunea Tnaltimii, sectiunea fetei, raza inferioara, raza superioara,

indltimea, centrul, elevatia etc.
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5.2.2.6 Piramida

Creeaza o piramida. Selectati "Create Tab > Object > Pyramid", specificati punctul central, introduceti numarul de
laturi, introduceti razele cercurilor exterioare superioare si inferioare si introduceti inadltimea.
Note: Paleta de proprietati va permite sa modificati informatii despre parametri cum ar fi alias, culoarea atasata

straturilor, netezirea, numarul de laturi, raza inferioara, raza superioara, inaltimea, centrul, elevatia, etc.

5.2.3 Instrumente de conversie

5.2.3.1 Conversia

Converteste obiecte precum volume, planuri si cladiri in poligoane editabile. Selectati "Create Tab> Convert >
Convert" si selectati entitatea pentru a o converti intr-un poligon editabil.
Nota: Toate entitatile, cu exceptia fotografiilor oblice, a norului de puncte si a datelor din imagini, pot fi convertite

in poligoane editabile, iar punctele, liniile si planurile lor pot fi editate.

5.3 Fila Vertex

5.3.1 Stergeti

Sterge punctul selectat. Selectati "Vertex Tab > Delete" (fila Vertex > Stergere) si selectati vertexul care urmeaza

sa fie sters. Planurile formate cu acest punct vor fi sterse impreuna dupa stergere.
5.3.2 Copiati

Copiazad punctul selectat. Selectati "Vertex Tab > Copy", selectati punctul, specificati punctul de baza si apoi

specificati punctul tintd pentru a crea o copie.

5.3.3 Selectati Invert (Inversare)

Selects all points in the current workspace other than the selected points. Select the "Vertex Tab > Select Invert"

item to select the object, all points other than the object are selected.

5.3.4 FFD

Adauga varfuri de control punctului selectat, facand reglarea formei unui obiect mai uniforma. Selectati ,Fila
Vertex > FFD” pentru a deschide caseta de dialog afisata.
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1. Control Points: Cand utilizati FFD Tn acest submod,
cadrul retelei va fi afisat Tn galben si punctele de
control de pe acesta pot fi selectate si manipulate
pentru a schimba forma obiectului. Un singur sau
mai multe puncte de control pot fi ajustate in
acelasi timp.

2. Lattice: Cand utilizati FFD n acest submod, cadrul
retelei va fi afisat in portocaliu. Cadrul poate fi
mutat, rotit sau scalat. in mod implicit, daci cadrul
este mutat sau scalat, numai varfurile din volumul

obiectului pot fi folosite pentru transformare.

Free Transformation X

© Control Points Lattice [ Set Volume
FFD Style

FFD 2x2x2

FFD 4x4x4 Custom

Currentmode:  Cuboid mode

Current selection:  FFD 3x3x3

Select

. Set Volume: Folosit in principal pentru a seta starea initiala a cadrului de zibrele. in acest mod, cand utilizati

FFD, cadrul va fi afisat Tn verde. Punctele de control pot fi ajustate fara a afecta forma obiectului. Acest lucru

ofera un control mai bun la transformarea obiectelor
neregulate.

4. FFD style: Setarea implicita este modul
dreptunghiular, cu trei stiluri FFD diferite: "FFD 2x 2x
2","FFD 3x 3x 3" si "FFD

4x 4x 4", De asemenea, puteti personaliza stilul facand
clic pe butonul ,,Personalizati” pentru a afisa caseta de
dialog afisata mai jos.

(1) Cuboid mode: Creeaza transformari
dreptunghiulare ale retelei de forma libera,
unde numarul de puncte de editare din axa XYZ
poate fi setat separat in parametrii
dreptunghiulari.

(2) Cylinder mode: Creeaza o forma cilindrica fara
zabrele. Punctele de editare radiale, laterale si

pe naltime pot fi setate separat.
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Points in X direction: 3

Pointsin Y direction: 3 }_:

Points in Z direction: 3

Cylinder parameters
Default Parameter: FED 4x6x4
Radial points: | 4

Side points: 6 }-@

Height points:

N




Houseplan 1.0 Make stunning 3D scheme with speed and ease

5. Setati parametrii, selectati poligonul editabil si caseta de editare FFD va aparea pe volumul selectat pentru a
intra Tn modul de editare a transformarii.

Note:

@ 1n timpul operatiunilor, dialogul de modelare avansatd nu va disparea. inchideti dialogul si comanda se
va incheia.

@ 1ntimpul operatiunilor, cele trei submoduri pot fi comutate unul la altul.

® Precizia punctului de editare FFD pe obiect este legata de numarul de segmente ale obiectului Tnhsusi. Cu

cat este mai mare numarul de segmente, cu atat este mai mare precizia.

@ Cu cat numarul de puncte de editare FFD este mai mic, cu atat intervalul controlat de un singur punct
este mai mare; cu cat sunt mai multe puncte de editare FFD, cu atat intervalul controlat de un singur

punct este mai mic.

® Ignorarea partii din spate este valabild pentru punctele de editare FFD.

® Numai un volum din scena poate fi transformat la un moment dat, nu puteti edita doud sau mai multe
entitati 3D Tn acelasi timp; daca trebuie sa executati comenzi de deformare pe mai multe entitati 3D Tn

acelasi timp, le puteti , Atasa” ca un singur volum si apoi utilizati transformarea FFD.
@ Cand editati FFD, mutati, rotiti si scalati sub fila ,,Editare” nu sunt disponibile..
5.3.5 Felie

Specifica o linie de tdiere pentru a genera un plan de tdiere. Vor fi generate noi varfuri si linii acolo unde modelul si
planul se intersecteaza. Selectati ,Fila Vertex > Slice” si selectati doua puncte.

5.3.6 Decupare

Decupeaza planuri pentru a crea noi varfuri si linii. Selectati ,Fila Vertex > Tdiati”, apoi faceti clic pe o entitate

Cascada Bigar, DN57B pentru a specifica Tn mod continuu pozitiile pentru a tdia planul entitatii.
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5.3.7 Tessellate

Teseleazd modelele alegand sa Tmpartiti planurile

. . o o Tessellate X
selectate cu conexiuni la mijlocul marginii sau cu conexiuni cu

varfuri. o Edge Face
Dupa selectarea unui varf, selectati ,Fila Vertex > Tessellate”, X -
Tension: 1 =
pentru a deschide urmatorul dialog.
Alegeti sa teselati fie marginea, fie fata, setati tensiunea si l Confirm Cancel

faceti clic pe Confirmare pentru a aplica.

5.3.8 Trage

Trageti selectati, cu care varfuri vor fi selectate automat cand cursorul trece peste ele. Selectati ,Vertex Tab

> Drag”, tineti apasat butonul stang al mouse-ului si treceti cu mouse-ul peste varfuri pentru a le selecta.

5.3.9 Target Weld

Trageti punctul selectat catre punctul tinta care urmeaza sa fie Tmbinat (cat mai aproape posibil) pentru a realiza
automat Imbinarea. Selectati

"Vertex Tab > Target Weld" si selectati punctul de pornire si punctul tinta de imbinat.

Note:

@ Punctul de pornire si punctul tinta trebuie sa fie pe aceeasi linie.

(@ Cand planurile pe care sunt situate punctele nu sunt inchise, punctele care nu se afla pe aceeasi linie pot

fi sudate.

(® Cand punctele de pe diferite entitati trebuie imbinate, mai multe entitati ar trebui sa fie , Atasati” inainte
de imbinare.

5.3.10 Pauza

Desparte un varf partajat in mai multe varfuri independente pentru editare separata. Selectati "Vertex Tab >

Break" si selectati varful de rupere.
5.3.11 Sudura

Sudeaza mai multe varfuri ale unui poligon editabil impreuna intr-un singur varf. Selectati "Vertex Tab > Weld",

selectati varful si introduceti distanta de sudura, iar varfurile din interval sunt sudate ca unul singur.
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5.3.

5.3.

5.3.

5.3.

5.3.

5.3.

Note:

@ O sudurd reusitd este obtinutad atunci cdnd distanta introdusa este mai mare sau egald cu distanta dintre

orice varfuri si pozitia medie a varfurilor combinate.

@ Nodurile selectate trebuie sa fie varfuri in acelasi plan pe entitate.

(® Cand varfurile de pe diferite entitati urmeaza sa fie sudate, mai multe entitati trebuie sa fie ,Atasate”
fnainte de sudare.

12 lesire

Toate punctele vor iesi din starea de editare. Selectati ,Fila Vertex> lesire” pentru a iesi din starea de editare.

13 Elimina

Elimind un punct selectat. Spre deosebire de Erase, eliminarea varfurilor nu distruge integritatea planului. Selectati
"Vertex Tab > Remove" element pentru a elimina punctul selectat.

14 Conectati

Conecteaza puncte de pe poligoane editabile cu linii. Selectati "Vertex Tab > Connect", si trageti linii facand clic pe
varfuri.

Note: Tn timp ce conecteaza varfuri, linia de legaturd nu se poate intersecta cu alte linii.

15 To Edge

Prin selectarea unui punct, linia asociata cu acel punct este selectata si comutata in modul linie.

Selectati"Vertex Tab > To Edge" element si selectati linia pentru a selecta linia care leaga acest punct.

16 Shrink

Reduceti selectia varfurilor catre directia circumferintei interioare din punctul selectat curent.

Selecteaza "Vertex Tab> Shrink" element, selectati varful si apoi micsorati selectia cu o tura spre interior de-a
lungul intervalului selectat.

Note:

@ Selecteaza automat varfurile de pe liniile care impart laturile cu acest punct.

(@ Optiunea Ignore Backfacing nu are nicio influentd asupra acestei comenzi.

17 Grow

Extinde selectia de varfuri a varfurilor selectate curent in directia periferica.
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Selecteaza "Vertex Tab > Grow" element, selectati varful, apoi extindeti selectia cu o rotire spre exterior de-a lungul

intervalului selectat.

Note:

@ Selecteaza automat varfurile de pe liniile care impart laturile cu acest punct.

@ Optiunea Ignore Backfacing nu are nicio influenta asupra acestei comenzi.
5.3.18 Tesitura

Fileteazd punctele selectate. Taiati marginea

selectata pentru a crea un nou plan. Selecteaza "Vertex Slicing amount:

Tab > Chamfer ", selectati varful care urmeaza sa fie feliat Segment: 1

Open sliced corners:

file. Setati cantitatea de feliere si parametrii segmentului in

caseta de dialog si faceti clic pe Confirmare.
Descrierea parametrului:
1. Cantitatea de taiere: Specifica dimensiunea planului de tesire.
2. Segment: Valoare de intrare intre 1 si 10.

3. Deschideti colturile tdiate: decide daca colturile tdiate sunt inchise.

Vertex Slicing X Vertex Slicing X
Slicing amount: 3 Slicing amount: 37-7:{-‘
Segment: 1:'% Segment: %
2 Open sliced corners: O Open sliced corners:
o ; o

5.4 Fila Edge

5.4.1 Sterge

Sterge linia de pe poligonul editabil selectat. Selectati ,Edge Tab > Delete” si selectati linia de sters. Planurile

formate cu aceasta linie vor fi sterse Tmpreuna dupa stergere.
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5.4.2 Copie

Copiaza liniile de pe poligoane editabile Tn polilinii 3D separate. Selectati ,Fila margine > Copiere”, selectati linia,

specificati punctul de baza si apoi specificati punctul tinta pentru a crea o copie.

5.4.3 Selectati Inversati

Selecteaza toate liniile din spatiul de lucru curent, altele decat liniile selectate. Selectati elementul ,Edge Tab >

Select Invert” pentru a selecta obiectul, toate liniile, altele decat obiectul, sunt selectate.

5.4.4 FFD

Adauga varfuri de control la marginea selectata pentru a ajusta uniform forma obiectului. Selectati ,Edge Tab >

FFD” pentru a deschide caseta de dialog afisata.

1. Control Points: Cand utilizati FFD in acest submod, Eree Tansfonnation %

cadrul retelei va fi afisat in galben, iar punctele de © Control Points Lattice Set Volume
. . . FFD Style
control de pe acesta pot fi selectate si manipulate
. . . . FFD 2x2x2 FFD 3x3x3
pentru a schimba forma obiectului. Un singur sau [I]
mai multe puncte de control pot fi ajustate in FFD 4x4x4 Custom
acelasi timp. Current mode:  Cuboid mode
2. Lattice: Cand utilizati FFD n acest submod, cadrul Current selection:  FFD 3x3x3

retelei va fi afisat Tn portocaliu. Cadrul poate fi
Select

-

mutat, rotit sau scalat. in mod implicit, dacd cadrul

este mutat sau scalat, numai varfurile din volumul
obiectului pot fi folosite pentru transformare.

3. Setare volum: Folosit in principal pentru a seta starea initiald a cadrului latice. in acest mod, cand utilizati
FFD, cadrul va fi afisat in verde. Punctele de control pot fi ajustate fara a afecta forma obiectului. Acest lucru

ofera un control mai bun la transformarea obiectelor neregulate.
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4. Stil FFD: setarea implicita este modul

. . . Custom FFD Parameter 4
dreptunghiular, cu trei stiluri FFD diferite: "FFD 2x

2)( 2",
puteti personaliza stilul facand clic pe butonul
»Personalizati” pentru a afisa caseta de dialog afisata Pointsin Y direction: 3 }.,

mai jos. Points in Z direction: 3

(1)

(2)

© cuboid mode i
"FFD 3x 3x 3" and "FFD 4x 4x 4De asemenea, Cxides smoce

Cuboid parameters

Points in X direction: 3

Cuboid mode Creeaza transformari
Cylinder parameters

dreptunghiulare ale retelei de forma libera,

Default Parameter: FFD 4x6x4
unde numarul de puncte de editare din axa XYZ Radialpoints: |4
poate fi setat separat in parametrii Side points: & }{g
dreptunghiulari. Height points: 4
Modul cilindru: creeaza o forma cilindrica fara _—
Confirm Cancel

retea. Punctele de editare radiale, laterale si pe >

fnadltime pot fi setate separat.

5. Setati parametrii, selectati poligonul editabil si caseta de editare FFD va aparea pe volumul selectat pentru a

intra Tn modul de editare a transformarii.

Note:

©)

@
®

in timpul operatiunilor, dialogul de modelare avansat3 nu va dispérea. inchideti dialogul si comanda se

va incheia.

in timpul operatiunilor, cele trei submoduri pot fi comutate unul la altul.

Precizia punctului de editare FFD pe obiect este legata de numarul de segmente ale obiectului Tnsusi. Cu

cat este mai mare numarul de segmente, cu atat este mai mare precizia.

Cu cat numarul de puncte de editare FFD este mai mic, cu atat intervalul controlat de un singur punct
este mai mare; cu cat sunt mai multe puncte de editare FFD, cu atat intervalul controlat de un singur

punct este mai mic.

Ignorarea partii din spate este valabila pentru punctele de editare FFD.
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® Numai un volum din scena poate fi transformat la un moment dat, nu puteti edita doua sau mai multe
entitati 3D Tn acelasi timp; daca trebuie sa executati comenzi de deformare pe mai multe entitati 3D in

acelasi timp, le puteti , Atasa” ca un singur volum si apoi utilizati transformarea FFD.

@ Cand editati FFD, mutati, rotiti si scalati sub fila ,Editare” nu sunt disponibile.
5.4.5 Felie

Specifica o linie de tdiere pentru a genera un plan de tdiere. Vor fi generate noi varfuri si linii acolo unde modelul si
planul se intersecteaza. Selectati ,,Edge Tab > Slice” si selectati doua puncte.

5.4.6 Decupare

Decupeaza planuri pentru a crea noi varfuri si linii. Selectati "Edge > Cut", apoi faceti clic pe o entitate pentru

a specifica continuu pozitiile pentru a taia planul entitatii.

5.4.7 Tessellate

Teseleaza modelele alegdnd sa Tmpartiti planurile selectate cu

Tessellate X

conexiuni la mijlocul marginii sau cu conexiuni cu varfuri. Dupa
© Edge Face
selectarea unui varf, selectati "Edge Tab > Tessellate", si apare
. . o . . . . Tension: 1 :
urmatorul dialog. Alegeti sa teselate fie marginea, fie fata, setati
tensiunea si faceti clic pe Confirmare pentru a aplica. [ Confirm Cancel

5.4.8 Drag

Trageti selectati, cu care liniile vor fi selectate automat cand cursorul trece peste ele. Selectati
,Fila margine > Trageti”, tineti apdsat butonul stang al mouse-ului si treceti cu mouse-ul peste linii

pentru a le selecta.

5.4.9 Gard

Selectare gard. Selectati toate liniile care intersecteaza linia pe care o desenati. Selectati ,,Edge Tab > Fence”, trageti

o polilinie si toate liniile care se intersecteaza vor fi selectate.
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5.4.10 Creati forma

Extrage liniile de contur. Selectati elementul ,,Edge Tab > Create Shape” si selectati linia pentru a genera o polilinie
3D.

Note: The 3D polyline generated can only be edited if you exit advanced modeling mode.

5.4.11 Masura

Selectati o linie sau un plan pe un poligon editabil, introduceti numarul de segmente egale si adaugati varfuri sau

linii uniform pentru a Tmparti linia sau planul. Selectati elementul , Edge Tab > Measure” si apare caseta de dialog:

Object Method
O Line One line

_IPlane

' Solid

Equipartition parameter

Segment: | 2 = e +
Shrink: |0 o +

Slider: 0 - +

pply Cancel

1. Obiect: Puteti alege linii, plane si solide.
(1) Line: " O linie”, o impartire egala a liniei selectate.
(2) Plane:
@ O linie, un plan: O impartire egald a planului selectat in functie de directia verticala a liniei selectate.

@ Multi-linie: impartiti in mod egal planurile asociate pe baza poliliniei selectate.
(3) Solid:

@ O linie: volumul este impartit in mod egal in functie de directia verticala a liniei selectate.

@ Doua linii: volumul este impartit in mod egal in functie de cele doua linii alese.
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-

2. Parametrul de echipare: Puteti introduce valoarea direct sau puteti face clic pe [¥!butonul pentru a ajusta cate
segmente doriti sa adaugati sau puteti trage glisorul pentru a-| ajusta.
(1) Segment: valoarea implicita este 2, inseamna o impartire egald Tn 2 parti.
(2) Shrink: Muta toate liniile sau punctele de segment nou generate, fie spre centru, fie spre capete.
(3) Slider: Compenseaza toate liniile de segment nou generate sau punctele ca intreg pe plan.

Note: Pentru echipartitia planelor, liniile multiple trebuie sa fie coplanare; iar pentru echipartitia volumelor

ambele linii trebuie sa apartina aceleiasi entitati si sa fie coplanare.

5.4.12 lesire

Toate liniile vor iesi din starea de editare. Selectati ,Edge Tab> Exit” pentru a iesi din starea de editare.

5.4.13 Elimina
Elimina o linie dintr-un poligon editabil. Selectati elementul ,, Edge Tab> Remove” pentru a elimina linia selectata.
Note: Dupa selectarea obiectului
(D Faceti clic dreapta sau apasati pe spatiu: elimina linia si punctele sale finale, iar cele doud planuri care au
o latura comuna cu linia sunt combinate Tntr-un singur plan.
(@ Apasati Enter: elimina linia si pastreaza punctele finale.

5.4.14 To Vertex

n modul linie, selectati punctul de pe linia selectat3 si comutati in modul punct. Selectati ,Edge Tab > To Vertex”

si dupa selectarea liniei, punctul de pe linie este selectat.

5.4.15 La poligon

Tn modul linie, selectati planul asociat liniei selectate si comutati in modul plan. Selectati , Edge Tab > To Polygon”

si dupa selectarea liniei, planul asociat este selectat.

5.4.16 Micsorare

Reduceti selectia liniilor in directia spre interior a liniei selectate curent. Selectati elementul ,,Edge Tab > Shrink”,

selectati linia si apoi micsorati selectia cu o turd spre interior de-a lungul intervalului selectat.
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5.4.17 Grow

Extinde selectia de linii Tn directia exterioara a liniei selectate curent. Selectati elementul ,,Fila margine > Crestere”,

selectati linia, apoi extindeti selectia cu un cerc de-a lungul intervalului selectat.

5.4.18 Tesitura

Feliaza marginea selectatd pentru a crea un nou plan. Selecteaza "Edge Tab> Chamfer", selectati linia de taiat si va

aparea urmatoarea caseta de dialog.

Setati cantitatea de feliere si parametrii
Vertex Slicing

segmentului in caseta de dialog si faceti clic pe Sicng amount:  5.000

Confirmare. Segment: 1 2

Parameter Description: Open sliced corners:

1. Cantitatea de taiere: Specifica dimensiunea planului
tesit.

2. Segment: intreg intre 1 si 10.

3. Deschideti colturile tdiate: decide daca colturile tdiate sunt inchise.

5.4.19 Pod

n cadrul aceluiasi model, comanda Bridge poate crea un plan intre margini, iar noul plan de punte va face parte

din reteaua originala. Selectati ,Fila Edge > Bridge” si va aparea urmatorul dialog:

Bridge

Segments: 1 = Type: |Linear v[
Taper: 0.000 = Offset: 0.000 =
Twist 1: 0 2l Twist2: 0 =

Setati numarul de segmente, tipul, conicitatea, decalajul, twist 1 si twist 2 parametrii, faceti clic pe ,Confirmare”
pentru a aplica.

Descrierea parametrului:
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1. Segmente: Seteaza numarul de segmente egale pentru planul generat de punte.

2. Tip: Seteaza tipul de plan generat de punte, Liner si Curve sunt disponibile.

3. Conicitate: Seteaza masura in care latimea podului devine mai mica sau mai mare spre centrul sdu. Valoarea
negativd o micsoreazad; valoarea pozitiva o reduce mai mare.

4. Offset: Determina pozitia conicitatii maxime. Variaza de la -99 la 99, cu implicit 0,0, cantitatea de conicitate este
cea mai mare in centrul podului.

5. Twistl, Twist2: Roteste ordinea conexiunii intre marginile celor doua selectii. Cele doua comenzi va permit sa

setati o valoare diferita de rasucire pentru fiecare capat al podului.

i

5.4.20 Inel

Creeaza un inel de margine pe baza selectiei curente a sub-obiectului si selecteaza rezultatele. Selectati "Edge

Tab > Ring " pentru a selecta o linie a unui patrulater si apasati enter, apoi este selectata linia opusa. De exemplu,

v . .. o .. . ” . v
daca selectati linia A linia 42 va fi selectata RING.
Advanced Modeling H X
Vertex: 0 Edge: 16 Polygon: 0 EdgedFaces v
Create | Vertex ) Edge I Polygon | Element | Object |
Delete Fence Grow
~ Copy _ Create Shape Chamfer
_Selectinvert | | Measwe | | _ Bridge
FFD Exit Ring
Slice Remove Loop
~ Cut i _ ToVertex Border
_ Tesselate | | ToPolygon | | Cep
Drag Shrink Insert Vertex
Transform: @ Select (IMove ( JRotate [ Scale [ILock
State: [ESnap [ Orthogonal [ |1gnore BackFadng | |Local
Constraint: | X | 3] [Z] [x] pz] ]
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Note: Comanda este disponibila numai pentru planul patrulater.

5.4.21 Loop

Creeaza o bucla de margine pe baza selectiei curente a sub-obiectului si selecteaza rezultatele. Selectati ,Fila

margine > Bucld”, iar dupa ce selectati linia si apdsati Enter, liniile de conectare sunt selectate.

Advanced Modeling H
Vertex: 0 Edge: 16 Polygon: 0 Edged Faces v
Create [ Vertex /) Edge [ Polygon | Element | Object |
Delete Fence Grow
Copy Create Shape Chamfer
Select Invert Measure Bridge
FFD Exit Ring
Slice Remove
Cut To Vertex ~ Border
Tessellate To Polygon Cap
Drag Shrink Insert Vertex
Transform: @ Select I Move _JRotate _)Scale [ lock
State: Snap || Orthogonal " Ignore BackFacing [ |Local
Constraint: | 7)(7\ 7Y7 ] ‘E ‘ \X? \\’Z @(\

Nota: Comanda este disponibilda numai pentru planul patrulater.

5.4.22 Granita

Selectati rapid liniile de margine. Selectati "Edge Tab > Border", dupa selectarea liniilor si apasati Enter, vor fi

selectate toate liniile de pe margine.

5.4.23 Cap

Tn modul linie, selectati linia de delimitare care trebuie sigilatd pentru a genera un nou plan. Selecteazi "Edge
Tab > Cap" si selectati linia inchisa pe poligonul editabil pentru a sigila.
Fereastra selecteaza poligonul editabil, iar sistemul cautd automat liniile inchise pe poligonul curent si le exclude

automat pe cele care au deja planuri.
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5.4.24 Inserati Vertex

Adaugati manual puncte la margine pentru subdiviziune. Selectati "Edge Tab > Insert Vertex " si specificati punctul
de inserare pe linie.

5.5 Fila Poligon

5.5.1 Sterge

Sterge planul selectat. Selectati "Polygon Tab > Delete" si selectati avionul de sters.

5.5.2 Copie

Copiaza planul selectat. Selectati "Polygon Tab > Copy selectati planul, specificati punctul de baza, apoi specificati

punctul tintd pentru a crea o copie.

5.5.3 Selectati Inversati

Selecteaza toate planurile din scena curentd, altele decat planul selectat. Selecteaza "Polygon Tab > Select Invert"

pentru a selecta obiectul, toate planurile, altele decat obiectul, sunt selectate.

5.5.4 FFD

Adauga varfuri de control la planul selectat pentru a ajusta uniform forma obiectului. Selectati “Polygon Tab >

FFD” pentru a deschide caseta de dialog afisata.

1. Control Points: Cand utilizati FFD in acest submod, Eree Transfonmation %

cadrul retelei va fi afisat in galben, iar punctele de © Control Points Lattice Set Volume
. . . FFD Style
control de pe acesta pot fi selectate si manipulate
. . . . FF FF

pentru a schimba forma obiectului. Un singur sau D 2hxe LTED ) ]

mai multe puncte de control pot fi ajustate in FFD 4x4x4 Custom

acelasi timp. Currentmode:  Cuboid mode
2. Lattice: Cand utilizati FFD n acest submod, cadrul Current selection:  FFD 3x3x3

retelei va fi afisat Tn portocaliu. Cadrul poate fi

Select

4

mutat, rotit sau scalat. Tn mod implicit, dacd cadrul

este mutat sau scalat, numai varfurile din volumul

obiectului pot fi folosite pentru transformare.
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3. Set Volume: Folosit in principal pentru a seta starea initial3 a cadrului latice. in acest mod, cand utilizati FFD,
cadrul va fi afisat in verde. Punctele de control pot fi ajustate fara a afecta forma obiectului. Acest lucru

ofera un control mai bun la transformarea obiectelor

neregulate.
Custom FFD Parameter X

4. Stil FFD: setarea implicita este modul
P © Cuboid mode Cylinder mode

dreptunghiular, cu trei stiluri FFD diferite: "FFD 2x Cuboid parameters

2)( 2!1’ "FFD 3)( 3)( 3|| and "FFD Points in X direction: 3

Pointsin Y direction: 3 i
4x 4x 4", De asemenea, puteti personaliza stilul facand

clic pe butonul ,,Personalizati” pentru a afisa caseta de Points in Z direction: 3

dialog afisata mai jos.
Cylinder parameters
(1) Cuboid mode: Creeaza transformari
Default Parameter: FFD 4x6x4
dreptunghiulare ale retelei de forma libers,
Radial points: =

unde numarul de puncte de editare din axa XYZ }

()]

Side points:

poate fi setat separat in parametrii
Height points: 4

Confirm ] Cancel

dreptunghiulari.

(2) Cylinder mode: Creeaza o forma cilindrica fara

zabrele. Punctele de editare radiale, laterale si
pe naltime pot fi setate separat.
5. Setati parametrii, selectati poligonul editabil si caseta de editare FFD va aparea pe volumul selectat pentru a
intra in modul de editare a transformarii.

Note:

@ Tn timpul operatiunilor, dialogul de modelare avansat3 nu va disparea. Inchideti dialogul si comanda se va

incheia.

@ n timpul operatiunilor, cele trei submoduri pot fi comutate unul la altul.

® Precizia punctului de editare FFD pe obiect este legatd de numéarul de segmente ale obiectului insusi. Cu

cat este mai mare numarul de segmente, cu atat este mai mare precizia.

@ Cu cat numarul de puncte de editare FFD este mai mic, cu atat intervalul controlat de un singur punct este
mai mare; cu cat sunt mai multe puncte de editare FFD, cu atat intervalul controlat de un singur punct

este mai mic.
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® Ignorarea partii din spate este valabild pentru punctele de editare FFD.

(® Numai un volum din scena poate fi transformat la un moment dat, nu puteti edita doud sau mai multe
entitati 3D Tn acelasi timp; daca trebuie sa executati comenzi de deformare pe mai multe entitati 3D in

acelasi timp, le puteti ,,Atasa” ca un singur volum si apoi utilizati transformarea FFD.

@ Cand editati FFD, mutati, rotiti si scalati sub fila ,Editare” nu sunt disponibile.
5.5.5 Slice

Specifica o linie de tdiere pentru a genera un plan de tdiere. Vor fi generate noi planuri acolo unde modelul si
planul se intersecteaza. Selectati "Polygon > Slice", si selectati doua puncte.

5.5.6 Decupare

Decupeaza planuri pentru a crea noi varfuri si linii. Selectati "Polygon Tab> Cut", apoi faceti clic pe o entitate pentru

a specifica continuu pozitiile pentru a taia planul entitatii.

5.5.7 Tessellate

Teseleaza modelele alegand sa impartiti planurile selectate cu

Tessellate X

conexiuni la mijlocul marginii sau cu conexiuni cu varfuri. Dupa
© Edae Face
selectarea unui varf, selectati ,Fila Poligon > Tessellate” si apare
. : o o : : . Tension: 1 5
urmatorul dialog. Alegeti sa teselati fie marginea, fie fata, setati -
tensiunea si faceti clic pe Confirmare pentru a aplica. [ Confirm Cancel

5.5.8 Trage

Trageti selectati, cu care planuri vor fi selectate automat cand cursorul trece peste ele. Selectati
"Polygon Tab > Drag", tineti apasat butonul stang al mouse-ului si treceti cu mouse-ul peste linii

pentru a le selecta.

5.5.9 Gard

Gard selectat. Selectati toate liniile care intersecteaza linia pe care o desenati. Selectati "Polygon Tab > Fence",

desenati o polilinie si toate liniile care se intersecteaza vor fi selectate.
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5.5.10 Neted

Netezeste entitatea selectata. Selectati ,Fila Poligon > Neted”, dupa selectarea poligoanelor editabile si va aparea

urmatoarea caseta de dialog.

Seteaza numarul de iteratii daca se
afiseaza efectul neted, dati clic pe
»Confirmare” pentru a aplica.

Descrierea parametrului:

Iterations: Controleaza numarul de varfuri
care sunt adaugate la poligon pentru a netezi

reteaua.

Show: Efectul neted va fi afisat.

Ascundere: efectul neted nu va fi afisat.

TurboSmooth

Iterations: O <

Show Smooth
© show

I Hidden

13

Note: Cand numarul de iteratii este 0, este activa doar netezimea afisajului.

5.5.11 Masura

Selectati o linie sau un plan pe un poligon editabil, introduceti numarul de segmente egale si adaugati varfuri sau

linii uniform pentru a imparti linia sau planul. Selectati elementul , Fila Poligon > Masura” si va aparea caseta de dialog:

Apply

1. Obiect: Puteti alege linii, plane si solide.

One line, One plane

Object Method
ILine
© Plane
() Solid
Equipartition parameter
Segment: |2
Shrink: |0
Slider: 0

Multidine
+
+
+

Cancel
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(1) Line: ,,0 linie”, o impartire egala a liniei selectate.

(2) Plane:

@ O linie, un plan: O impartire egald a planului selectat in functie de directia verticala a liniei selectate.

@ Multi-linie: Impértiti Tn mod egal planurile asociate pe baza poliliniei selectate.
(3) Solid:

@ O linie: volumul este impartit in mod egal in functie de directia verticala a liniei selectate.

@ Doua linii: volumul este impartit in mod egal in functie de cele doua linii alese.
-~

2. Parametrul de echipare: Puteti introduce valoarea direct sau puteti face clic pe [~ !butonul pentru a ajusta cate
segmente doriti sa adaugati sau puteti trage glisorul pentru a-| ajusta.
(1) Segment: Valoarea implicita este 2, Tnseamna o impartire egald in 2 parti.
(2) Shrink: Muta toate liniile sau punctele de segment nou generate, fie spre centru, fie spre capete.

(3) Slider: Compenseaza toate liniile de segment nou generate sau punctele ca intreg pe plan.
Note: Pentru echipartitia planelor, liniile multiple trebuie sa fie coplanare; iar pentru echipartitia volumelor

ambele linii trebuie sa apartina aceleiasi entitati si sa fie coplanare.

5.5.12 lesire

Toate avioanele vor iesi din starea de editare. Selectati ,,Fila Poligon> lesire” pentru a iesi din starea de editare.

5.5.13 Detach

Descompune planul selectat intr-un nou volum. Selectati ,Fila Poligon > Detasare” pentru a selecta un plan pentru

rupere, care este afisat implicit cu gri.

5.5.14 To Edge

in modul Poligon, selectati liniile din planul selectat si treceti la modul Edge. Selectati "Polygon Tab > To

Edge" iar dupa selectarea planului, liniile din plan sunt selectate si comutate la fila Edge.

5.5.15 To Element

in modul poligon, selectati elementele legate de poligonul selectat si comutati la modul element.

Dupa selectarea unui poligon, selectati "Polygon Tab > To Element", iar elementele aferente vor fi selectate si
comutate la fila Element.
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5.5.16 Shrink

Restrange selectia de planuri Tn directia catre interior a planului selectat curent. Selectati "Polygon Tab > Shrink"

element, selectati planul si apoi micsorati selectia cu o tura spre interior de-a lungul intervalului selectat.

5.5.17 Grow

Adauga in selectie planuri pe directia exterioara a planului selectat curent. Selectati "Polygon Tab > Grow" item,

selectati planul, apoi extindeti selectia cu un cerc de-a lungul intervalului selectat.

5.5.18 Flip Normal

ntoarce planurile cu directia inversa fatd de normal in setul de selectie, astfel incat materialul UV si poats fi afisat
corect. Selectati "Polygon Tab > intoarceti elementul Normal " si selectati avionul.

Note: Planul selectat este rasturnat cu 180° de-a lungul centrului sau, rezultatele modificarilor efectuate de alte

comenzi la poligonul editabil, cum ar fi Sudarea si Rupere, nu vor fi modificate.

5.5.19 Bridge

n cadrul aceluiasi model, comanda Bridge creeazd un plan de legdturd intre margini, iar planul de legdtura va

face parte din reteaua originala. Selectati "Polygon Tab > Bridge", iar urmatorul dialog va aparea:

Bridge X

Segments: 1 = Type: |Linear v‘
Taper: 0.000 2 Offset: 0.000 :
Twist 1: 0 = Twist2: 0 =

Confirm Cancel

Setati numarul de segmente, tipul de punte, conicitatea, decalajul, rasucirea 1 si rasucirea 2, faceti clic pe
Confirmare pentru a aplica..

Descrierea parametrului:
1. Segmente: Seteaza numarul de segmente egale pentru planul generat de punte.

2. Tip: Seteaza tipul de plan generat de punte, Liner si Curve sunt disponibile.
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3. Taper: Seteaza masura in care latimea podului devine mai mica sau mai mare spre centrul sdu. Valoarea negativa
0 micsoreaza; valoarea pozitiva o reduce mai mare.

4. Offset: Determina pozitia conicitatii maxime. Variaza de la -99 la 99, cu implicit 0,0, cantitatea de conicitate este
cea mai mare in centrul podului.

5. Twistl. Twist2: Roteste ordinea conexiunii dintre marginile celor doua selectii. Cele doua comenzi va permit

sa setati o valoare diferitd de rasucire pentru fiecare capat al podului.

-

Ny

5.5.20 Schit3

Decaleaza planul selectat in cadrul selectiei cu aceeasi proportie. Selectati elementul "Polygon Tab > Outline",

selectati planul poligonului si trageti cursorul sau introduceti o valoare pentru a determina distanta de decalare.

5.5.21 Extrudare poligon

Efectueaza extrudarea verticald sau orizontala a mai multor planuri de poligoane editabile dintr-un set de
selectie Tn functie de poligoane, grupuri sau normale locale. Selectati "Polygon Tab > Extrude Polygon" si selectati

planul. Setati parametrii in caseta de dialog si faceti clic pe butonul "Confirm" pentru a stoarce planul selectat.
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1. Polygons: Extrudare verticalda sau

v oA . . o ru
laterala in directia normala a Extrude x

planului selectat Tnsusi. Polygon © Group Part normal
2. Group: Extrudare verticala sau = x
P Height: 1.000 — Outline: 0.000 =

laterald Tn directia normala medie a

Apply ] Confirm

planurilor selectate.

3. Local normal: Planurile selectate

adiacente intre ele sunt imbinate Tn directia normalei lor combinate pentru extrudare verticala sau laterala..

5.5.22 Extrudare

Extrude planul selectat. Selectati "Polygon Tab > Extrude" obiectul selectat va fi evidentiat, trageti cu mouse-
ul sau introduceti valoarea exacta pentru extrudare. Daca introduceti "Y" pe linia de comanda, planul selectat va fi
pastrat; daca introduceti "N", planul selectat nu va fi pastrat; inainte de a apdsa Enter pentru a finaliza comanda,
puteti selecta orice plan suplimentar pentru a continua extrudarea.

NoteAliniati cursorul cu alte entitati atunci cand extrudeti, apoi planul de extrudare selectat poate fi extrudat la

aceeasi indltime ca si entitatea selectata.

5.6 Fila element

5.6.1 Stergeti

Sterge elementul selectat. Selectati "Element Tab > Delete" si selectati elementul care urmeaza sa fie sters. Sterge

un singur element de instanta si sterge si alte entitati de instanta ale aceleiasi surse.

5.6.2 Copiati

Copiaza elementul selectat. Selectati "Element Tab > Copy" (fila Element > Copiere), selectati elementul, specificati

punctul de baza si apoi specificati punctul tinta pentru a crea o copie.

5.6.3 Selectati Invert

Selecteaza toate elementele din scena curenta, altele decat elementul selectat. Selectati elementul "Element Tab

> Select Invert" pentru a selecta obiectul, toate elementele, altele decat obiectul, sunt selectate.
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5.6.4 FFD

Adauga varfuri de control la elementele selectate pentru a ajusta in mod uniform forma obiectului. Selectati

“Element Tab > FFD” pentru a deschide caseta de dialog

o Free Transformation X
prezentata.

© Control Points Lattice |  Set Volume
1. Control Points: Atunci cand se utilizeaza FFD Tn acest FFD Style
submod, cadrul retelei va fi afisat Tn galben, iar punctele FFD 2x2x2 FFD 3x3x3
de control de pe acesta pot fi selectate si manipulate FFD 4x4x4 Custom
pentru a modifica forma obiectului. Un singur punct de Current mode:  Cuboid mode
control sau mai multe puncte de control pot fi ajustate in Current selection:  FFD 3x3x3
acelasi timp. Select

2. Lattice: Atunci cand se utilizeaza FFD in acest submod,
cadrul retelei va fi afisat Tn portocaliu. Cadrul poate fi
deplasat, rotit sau redimensionat. in mod implicit, dacd rama este deplasata sau scalatd, numai varfurile din
cadrul volumului obiectului pot fi utilizate pentru transformare.

3. Set Volume: Se utilizeazd in principal pentru a seta starea initiald a cadrului de zibrele. In acest mod, atunci
cand se utilizeaza FFD, cadrul va fi afisat in verde.

Punctele de control pot fi ajustate fara a afecta forma Custom FED Pararmetes %

obiectului. Acest lucru ofera un control mai bun © Cuboid mode

Cylinder mode
atunci cand se transforma obiecte neregulate. Cuboid parameters
. Points in X direction: 3
4. FFD style: Setarea implicitd este modul
Pointsin Y direction: 3 }_:
dreptunghiular, cu trei stiluri FFD diferite: "FFD 2x 2x 8

Points in Z direction: 3

2","FFD 3x 3x 3" and "FFD

" . . . A Cylinder parameters
4x 4x 4", De asemenea, puteti personaliza stilul facand

clic pe butonul "Customize" pentru a afisa caseta de Default Parameter:  FrD 4264

dialog prezentata mai jos.
Radial points: 4

&

(o))

Side points:

Ao

@

(1) Cuboid modeCreeaza transformari de forma }

libera Tn forma de retea dreptunghiulara, unde

N

Height points:

numarul de puncte de editare pe axa XYZ poate

Cancel

fi setat separat in parametrii dreptunghiulari.
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(2) Cylinder mode: Creeaza o forma libera de retea de forma cilindrica. Punctele de editare radialg,
laterala si de Tnaltime pot fi setate separat.
5. Setati parametrii, selectati poligonul editabil, iar caseta de editare FFD va aparea pe volumul selectat pentru
a intra in modul de editare a transformarii.

Note:

@ 1n timpul operatiunilor, dialogul de modelare avansatd nu va disparea. inchideti dialogul si comanda se
va incheia.

n timpul operatiunilor, cele trei submodele pot fi comutate intre ele.

©® ©

Precizia punctului de editare FFD de pe obiect este legatd de numarul de segmente ale obiectului insusi..

Cu cat numarul de segmente este mai mare, cu atat mai mare este precizia..
@ Cu cat este mai mic numarul de puncte de editare FFD, cu atat este mai mare domeniul controlat de un
singur punct; cu cat sunt mai multe puncte de editare FFD, cu atat este mai mic domeniul controlat de

un singur punct.

® Ignorarea partii din spate este valabild pentru punctele de editare FFD.

® Doar un singur volum din scend poate fi transformat la un moment dat, nu puteti edita doud sau mai
multe entitati 3D Tn acelasi timp; daca aveti nevoie sa executati comenzi de deformare pe mai multe

entitati 3D in acelasi timp, le puteti "atasa" ca un singur volum si apoi sa utilizati transformarea FFD..

@ Cand editarea FFD, mutarea, rotirea si scalarea din fila "Editare" nu sunt disponibile..

5.6.5 Slice

Specifica o linie de tdiere pentru a genera un plan de taiere. Se vor genera noi planuri acolo unde modelul si planul
se intersecteaza..

Selectati"Element Tab > Slice", si selectati doua puncte.

5.6.6 Cut

Taie elemente pentru a crea noi varfuri si linii. Selectati "Element Tab > Cut", apoi faceti clic pe o entitate pentru

a specifica Tn mod continuu pozitiile de taiere a planului entitatii.
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5.6.7 Tessellate

Tessellate X

Teseleaza modelele alegand sa imparta planurile selectate cu :
© Edge Face

conexiuni de mijloc de muchie sau cu conexiuni de vertex..

Tension: 1 E
Dupa selectarea unui vertex, selectati "Element Tab > Tessellate", si _

se va afisa urmatorul dialog: Confirm ' Cancel

Alegeti pentru a tezauriza fie marginea, fie fata, setati tensiunea si

faceti clic pe Confirmare pentru a o aplica..

5.6.8 Drag

Selectare prin glisare, cu ajutorul careia obiectele vor fi selectate automat atunci cand cursorul trece pe deasupra
lor. Select "Element Tab > Drag",

tineti apasat butonul stang al mouse-ului si treceti deasupra obiectelor pentru a le selecta.

5.6.9 Fence

Gard selectat. Selectati toate elementele care intersecteaza linia pe care ati trasat-o. Select "Element Tab > Fence",

traseaza o polilinie, iar toate elementele care se intersecteaza vor fi selectate.

5.6.10 Smooth

Netezeste entitatea selectata. Selectati "Element Tab > Smooth", si se va deschide urmatorul dialog:
Stabileste numarul de iteratii si daca se afiseaza efectul de netezire, faceti clic pe Confirmare pentru a aplica.
Parameter Description:

Iterations: Controleaza numarul de varfuri

care sunt addugate la element pentru a netezi
| TurboSmooth Show Smooth
asa..
P — © show
_ ) Iterations: 0 - =
Show: Se va afisa efectul de netezire. — () Hidden
Hide: Efectul de netezire nu va fi afisat.
? Confirm Cancel

Note: Atunci cdnd numarul de iteratii este

0, este activa doar netezirea afisajului.
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5.6.11 Measure

Selecteaza o linie sau un plan pe un poligon editabil, introduceti numarul de segmente egale si adaugati varfuri
sau linii iTn mod egal pentru a imparti linia sau planul. Selectati elementul "Element Tab > Measure" si se deschide caseta

de dialog:

Measure X

Object Method
Line One line
Plane Two lines

© solid

Equipartition parameter

Segment: |2 = +
Shrink: |0 e~ +
Slider: |0 = - -

1. Obiect: Puteti alege linii, plane si solide..
(1) Line: "0 linie", o divizare egala a liniei selectate.

(2) Plane:

@ O linie, un avion: O divizare egala a planului selectat in functie de directia verticala a liniei selectate..

@ Multi-line: Imparte in mod egal planurile asociate pe baza polilinii selectate.
(3) Solid:

@ One line: Volumul este impartit in mod egal in functie de directia verticala a liniei selectate..

@ Two lines: Volumul este impartit in mod egal in functie de cele doua linii alese.
-

2. Equipartition parameter: Puteti introduce direct valoarea sau puteti face clic pe butonul [~ pentru a ajusta
numarul de segmente pe care doriti sa le adaugati sau puteti trage cursorul pentru a-l ajusta.
(1) Segment: Valoarea implicita este 2, ceea ce inseamna o impartire egala in 2 parti..

(2) Shrink: Deplaseaza toate liniile sau punctele de segment nou generate, fie spre centru, fie spre capete.
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(3) Slider: Decaleaza toate liniile de segment sau punctele nou generate ca intreg pe plan.
Note: Pentru equipartizarea planurilor, mai multe linii trebuie sid fie coplanare; iar pentru equipartizarea

volumelor, ambele linii trebuie sa apartina aceleiasi entitati si trebuie sa fie coplanare.

5.6.12 Exit

Toate elementele vor iesi din starea de editare. Selectati "Element Tab> Exit" pentru a iesi din starea de editare.

5.6.13 Detasati

Descompune elementul selectat intr-un obiect nou, independent. Selectati "Element Tab > Detach" si selectati
poligonul care urmeaza sa fie rupt, care este in mod implicit gri.

Note:

@ Entitatea de care este atasata relatia este separabila.

@ in cazul in care volumul este Tmpdrtit in parti separate prin operatii precum eliminarea punctelor si
a liniilor, una dintre parti (elemente) poate fi separata

5.6.14 To Polygon

Selecteaza poligoane legate de un element si comuta in modul Poligon.
Dupa selectarea unui element, selectati "Element Tab > To Polygon", si poligoanele aferente vor fi selectate, in

timp ce se va trece la fila Poligon.

5.7 Object Tab

5.7.1 Delete

Sterge poligoanele editabile sau alte entitati. Selectati "Object Tab > Delete" (fila Obiect > Stergere) si selectati
obiectul de sters..

5.7.2 Copy

Creeaza copii ale poligoanelor editabile. Selectati "Object Tab > Copy", selectati obiectul, specificati punctul de
baza si apoi punctul tintd pentru a crea o copie. Valoarea implicita este ca nu exista o copie de instanta. Introduceti
"Y" si apdsati Enter, iar entitatea generata de copie are o relatie de instanta cu entitatea originald. Puteti continua

sa copiati la nesfarsit inainte de a introduce si iesi din aceasta comanda.
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5.7.3 Selectati Invert

Selecteaza toate poligoanele editabile din scena curenta, altele decat volumul selectat. Selectati "Object
Tab > Select Invert" pentru a selecta obiectul, sunt selectate poligoanele editabile, altele decat obiectul.

Poligoanele editabile ascunse nu pot fi selectate invers.
5.7.4 FFD

FFD este un instrument special de editare a transformarilor de retea. Dupa selectarea unui model, va fi vizibil
un cadru de retea (un cadru de retea este un cadru care invaluie obiectul), iar forma obiectului poate fi ajustata cu
ajutorul punctelor de control de pe cadru pentru a produce o transformare lina si a evita ruperea.. FFD poate fi
folosit direct ca un instrument de editare sau ca un instrument de deplasare implicita a spatiului.. Selectati

"Object Tab > FFD" pentru a deschide caseta de dialog

prezentata. Free Transformation X

1. Control Points: Atunci cand se utilizeaza FFD in © Control Points Lattice Set Volume
acest submod, cadrul retelei va fi afisat in galben, PR Shie
iar punctele de control de pe acesta pot fi selectate HED) XA M]
si manipulate pentru a modifica forma obiectului. FFD 4x4x4 Custom
Un singur punct de control sau mai multe puncte de Current mode:  Cuboid mode
control pot fi ajustate in acelasi timp. Current selection:  FFD 3x3x3
2. Lattice: Atunci cand se utilizeaza FFD Tn acest
Select

submod, cadrul retelei va fi afisat in portocaliu. \

Cadrul poate fi deplasat, rotit sau redimensionat. Tn
mod implicit, dacd rama este deplasata sau scalata, numai varfurile din cadrul volumului obiectului pot fi
utilizate pentru transformare.

3. Set Volume: Se utilizeaza in principal pentru a seta starea initiala a cadrului de zdbrele. in acest mod, atunci
cand se utilizeaza FFD, cadrul va fi afisat in verde. Punctele de control pot fi ajustate fara a afecta forma

obiectului. Acest lucru ofera un control mai bun atunci cand se transforma obiecte neregulate.
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4. FFD style: The default setting is rectangular mode,

with three different FFD styles: "FFD 2x 2x 2", "FFD

3% 3% 3" and "FFD © Cuboid mode Cylinder mode
Cuboid parameters
4x 4x 4", De asemenea, puteti personaliza stilul facand
. " o . Points in X direction: 3
clic pe butonul "Customize" pentru a afisa caseta de
dialog prezentata mai jos. Pointsin Y direction: 3 }@
(1) Cuboid mode: Creeaza transformari libere de Points in Z direction: 3
forma dreptunghiulara, in care numarul de iy poraneters
puncte de editare pe axa XYZ poate fi setat Default Parameter: FED dxExcd
separat in parametrii rectangulari.. Radial points: 4
. v v e v sd 1 tS' = \@
(2) Cylinder mode: Creeaza o forma libera de retea AUE POMIS- LS )
de forma cilindrica. Punctele de editare radiala, Heightpolntsz | 1
laterala si de Tnaltime pot fi setate separat. l Conim ] Cancel

Custom FFD Parameter X

5. Setati parametrii, selectati poligonul editabil, iar

caseta de editare FFD va apdrea pe volumul selectat

pentru a intra in modul de editare a transformarii.

Note:

©)

@
®

® ©

in timpul operatiunilor, dialogul de modelare avansat3 nu va dispérea. inchideti dialogul si comanda se

va incheia.

n timpul operatiunilor, cele trei submodele pot fi comutate intre ele.

Precizia punctului de editare FFD de pe obiect este legata de numarul de segmente ale obiectului Tnsusi.
Cu cat numarul de segmente este mai mare, cu atat mai mare este precizia.

Cu cat este mai mic numarul de puncte de editare FFD, cu atat este mai mare domeniul controlat de un
singur punct; cu cat sunt mai multe puncte de editare FFD, cu atat este mai mic domeniul controlat de

un singur punct..

Ignorarea partii din spate este valabila pentru punctele de editare FFD.

Doar un singur volum din scend poate fi transformat la un moment dat, nu puteti edita doua sau mai
multe entitati 3D Tn acelasi timp; daca aveti nevoie sa executati comenzi de deformare pe mai multe

entitati 3D Tn acelasi timp, le puteti "atasa" ca un singur volum si apoi sa utilizati transformarea FFD..

Cand editarea FFD, mutarea, rotirea si scalarea din fila "Editare" nu sunt disponibile.
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5.7.5 Slice

Specifica o linie de tdiere pentru a genera un plan de tdiere. Se vor genera noi planuri acolo unde modelul si planul
se intersecteaza..

Selectati "Object Tab > Slice", si se selecteaza doua puncte.

5.7.6 Decupare

Taie un solid 3D editabil in mai multe entitati. Selectati "Object Tab > Cut" (fila Obiect > Taiere), selectati entitatea
care urmeaza sa fie taiata, specificati punctul de pornire si desenati o polilinie ca linie de taiere; sau introduceti S si
apasati Enter, apoi selectati o linie ca linie de taiere pentru a tdia entitatea 3D.

Note:

@ Doui puncte specificate Linia de tdiere nu este disponibild pentru a tdia obiecte 3D in vizualizarea 3D

(disponibila Tn vizualizarea fata, spate, sus, jos, stanga sau dreapta).

@ Liniile de taiere selectate sunt disponibile pentru a taia obiecte 3D atunci cand va aflati in vizualizarea fat3,
spate, sus, jos, stanga sau dreapta.

(® Linia de tdiere selectatd trebuie s3 treaca prin model.

5.7.7 Tessellate

Tessellate >

Teseleaza modelele alegand sa imparta planurile selectate cu
© Edge Face
conexiuni de mijloc de muchie sau cu conexiuni de vertex.
. _ o . Tension: 1 =
Dupa selectarea unui vertex, selectati "Object Tab > Tessellate" (fila _—
Obiect > Tezaurizare), iar urmatorul dialog apare. Alegeti sa teselati fie [ Confirm Cancel

muchia, fie fata, setati tensiunea si faceti clic pe Confirm (Confirmare)

pentru a o aplica.

5.7.8 Drag

Selectare prin glisare, cu ajutorul careia obiectele 3D vor fi selectate automat atunci cand cursorul trece pe
deasupra lor. Selectati "Object Tab >

Drag", tineti apasat butonul stang al mouse-ului si treceti deasupra obiectelor pentru a le selecta.
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5.7.9 Gard

Gard selectat. Selectati toate obiectele 3D care intersecteaza linia pe care o desenati. Selectati "Object Tab >

Fence", trageti o polilinie si faceti clic dreapta, toate obiectele 3D care se intersecteaza vor fi selectate.
5.7.10 Smooth

Netezeste entitatea selectatd. Selectati
"Object Tab > Smooth", si se va afisa TurboSmooth Show Smooth
urmatorul dialog: © show

Setati numarul de iteratii si dacd doriti s3 Iterations: 0 =
’ T ’ —_— (O Hidden

afisati efectul de netezire, faceti clic pe Confirmare

pentru a aplica.

Parametru Descriere:
Iterations: Controleaza numarul de varfuri

care sunt addugate la element pentru a netezi plasa.

Show: Se va afisa efectul de netezire.
Hide: Efectul de netezire nu va fi afisat.
Note: Atunci cand numarul de iteratii este 0, este activa doar netezirea afisajului.

5.7.11 Masura
Selecteaza o linie sau un plan pe un poligon editabil, introduceti numarul de segmente egale si adaugati varfuri
sau linii Tn mod egal pentru a Tmparti linia sau planul. Selectati elementul "Element Tab > Measure" si se afiseaza caseta

de dialog:

Object Method
) Line One line
I Plane Two lines
© solid
Equipartition parameter
Segment: |2 = i +
Shrink: |0 ol +
Slider: |0 == +
Apply Cancel

1. Obiect: Puteti alege linii, plane si solide.
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(1) Line: "O linie", o divizare egala a liniei selectate.
(2) Plane:

@ O linie, un avion: O divizare egald a planului selectat in functie de directia verticala a liniei selectate.

@ Multi-line: Tmparte in mod egal planurile asociate pe baza polilinii selectate.
(3) Solid:

@ One line: Volumul este impartit in mod egal in functie de directia verticald a liniei selectate.

@ Two lines: Volumul este impartit in mod egal in functie de cele doud linii alese.
2. Equipartition parameter: Puteti introduce direct valoarea sau puteti face clic pe butonul pentru a ajusta numarul

de segmente pe care doriti sa le adaugati sau puteti glisa cursorul pentru a le ajusta.
(1) Segment: Valoarea implicita este 2, ceea ce inseamna o Tmpartire egala in 2 parti.
(2) Shrink: Deplaseaza toate liniile sau punctele de segment nou generate, fie spre centru, fie spre capete.

(3) Slider: Decaleaza toate liniile de segment sau punctele nou generate ca un intreg pe plan.
Note: Pentru echipartirea planurilor, mai multe linii trebuie sa fie coplanare; iar pentru echipartirea volumelor,

ambele linii trebuie sa apartina aceleiasi entitati si sa fie coplanare.

5.7.12 Selectati dupa nume

Selecteaza obiectul dupa nume.

Selectati "Object Tab > Select by Name" si va aparea urmatoarea caseta de dialog.

Choose A Body By Name

|| case sensitive

Model001 Sort

Model002
Model003 © Alphabet sequence
By color
By size
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1. Screening:
(1) Caseta de cautare: Cautarea de nume de entitati, cu suport pentru cautari fuzzy, in care numele modelelor
care corespund criteriilor sunt selectate in lista.

(2) List of names: Numele entitatilor din lista pot fi selectate individual sau multi-selectate (prin apadsarea
tastelor ctrl sau shift)..

(3) Sort: Rezultatele cautarii pot fi sortate in ordine alfabetica, dupa valoarea RGB a culorii sau dupa marime.
2. All: selecteaza toate entitatile din lista.

3. Faceti clic pe butonul Confirm (Confirmare) pentru a selecta in scena entitatile filtrate in lista.

Note:

@ Faceti dublu clic pe numele entitatii pentru a o pozitiona in mijlocul vizualizérii si pentru a-i maximiza
afisarea.

@ Puteti selecta toate modelele cu aceleasi initiale introducdnd prima litera a numelui modelului din listd in

campul de cautare.
(® Selectia numelui este valabild numai pentru entitatile cu proprietati cu forma3 libera.
5.7.13 Attach

Ataseaza mai multe poligoane editabile Tntr-un singur volum pentru operatiuni de editare si cartografiere usoare.
Selectati "Object Tab > Attach" si selectati volumul si obiectele atasate.

Note:

(D Entitatile suplimentare nu pot selecta entitati de instanta care sunt omoloage subiectului.
(@ Subansamblurile de poligoane editabile, atunci cdnd sunt addugate, sunt toate elementele.

(® Pentru a detasa, puteti utiliza functia de detasare de la element.

5.7.14 Extrude Line

Extrude o linie selectata intr-un plan. Selectati "Object Tab > Extrude Line" si selectati linia pentru a deschide

caseta de dialog prezentata mai jos.
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1. Setarile parametrilor.

S Undefined Li

Squeeze direction

@ Selectati "Strangere orizontald" _Horizontal squeeze @) Vertical squeeze out
pentru a comprimarea liniei pe

orizontala intr-un plan. Squeeze parameter

@  Selectati  "Comprimare Z
Squeeze value: 1.000 =
verticald" pentru a comprima St 1 =

liniile in directia verticala pentru

a forma un plan. Sealing parameter

Sealing begin
(2) Squeeze parameters.

Sealing end
@  Squeeze value: Se
utilizeaza pentru a seta valoarea
. Confirm Cancel
valoarea de comprimare.
. >

@ Segment: Utilizat pentru a seta
numarul de segmente n directia
de strangere.

(3) Parametru de etansare: Atunci cand se selecteaza o linie Tnchisa pentru stoarcere, parametrul de
etansare poate fi setat pentru a controla daca inceputul si sfarsitul sunt inchise.
2. Faceti clic pe butonul "Confirm" pentru a genera poligoane editabile Tn conformitate cu parametrii setati.

Note:

@ Comanda "squeeze" poate fi executatd pe o singura linie la un moment dat.

@ Doar "Vertical Squeeze" poate fi selectat pentru liniile 3D, iar pentru liniile desenate in directia axei Z nu
exista efect de strangere.
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5.7.15 Lattice

Converteste un segment de linie sau o muchie a unui desen intr-o structurd cilindrica cu poliedre

optionale pe varfuri, utilizata in principal pentru a produce

cadre de cladiri. Selectati "Object Tab > Lattice" si selectati Sl X

[ i tobi . Paramet
Editable Polygons (Poligoane editabile) pentru a deschide arameter

Show points only
urmatoarea caseta de dialog.

Show lines only

© Both

1. Parameter settings.

(1) Parametru:
Line

@ Afisati numai punctele: Vor fi afisate doar Radius:  0.150 v

Number of sides: 5
punctele poligoanelor editabile.

Angle: 0,000 =
@ Afisati numai liniile: Vor fi afisate doar liniile 4 1gnore hidden edges

End sealin
poligoanelor editabile. -

Point
(® Both: Afiseaza atat punctele, cat si liniile

Tetrahedron @) Octahedron
poligoanelor editabile.

Icosahedron
(2) Line.

Radius: 0.150] =

@ Radius: Stabileste dimensiunea razei

Confirm Cancel

volumului generat de reteaua cristalina.

@ Number of sides: Stabileste numarul de

muchii ale sectiunii transversale, cu cat valoarea sa este mai mare cu atat este mai rotunjita.

® Angle: Setati unghiul liniilor de zdbrele.
@ Ignore hidden edges: Bifati aceasta casetd de selectare pentru a reda numai marginile vizibile;

debifati-o pentru a reda toate marginile.
® End sealing: Bifati aceasta caseta de selectare pentru a limita volumul generat de liniile zdbrelite
pentru a obtine o forma Tnchisa.
(3) Point.
@ Tetrahedron, octahedron, icosahedron: Pentru setarea formei de bazé a nodului.

@ Radius: Se utilizeaza pentru a seta raza nodului, adicd dimensiunea nodului.
2. Faceti clic pe butonul "Confirmare" pentru a o genera.

Note: Poligoanele editabile nu pot fi zavorate de doua ori, iar liniile zavorate nu pot fi rotite unghiular.
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5.7.16 Boolean

Doua corpuri care se intersecteaza pot fi intersectate, sustrase sau combinate pentru a produce un nou obiect.
Selectati "Object Tab > Boolean", selectati obiectul sustras, apoi selectati obiectul de referinta, puteti efectua direct
operatiile de scadere; introduceti "I", selectati doua obiecte pentru operatii de intersectie; introduceti "U", selectati
doua obiecte pentru operatii de fuziune.

Note:

@ Cele doua obiecte pe care se efectueaza operatia boolean3 trebuie si fie modele inchise.

@ Ordinea in care sunt selectate cele doua obiecte in timpul operatiei de scidere afecteaza rezultatul
operatiei.

5.7.17 Mirror

Genereaza o copie Tn oglinda a volumului selectat. Selectati "Object > Mirror", selectati obiectul, introduceti
"N", entitatea generata prin oglindire nu este o instanta a entitatii originale; introduceti "Y", entitatea generata
prin oglindire este o instanta a entitatii originale. Selectati obiectul care urmeaza sa fie oglindit pentru a deschide

caseta de dialog prezentata mai jos.

1. Parameter settings.

(1) Mirror axis: Se utilizeaza pentru a seta axa de simetrie sau Mirror axils
Ox XY
planul de simetrie al oglindirii. Unde "offset" este utilizat
¥ 7
pentru a seta distanta de decalaj a obiectului oglindit fata de 7 7x
obiectul original. Offset: 0.000 [%

Clone the current selection
(2) Clonarea selectiei curente: Utilizat pentru a seta dacd se

© No doning
pastreaza entitatea originala.
Copy
2. Faceti clic pe butonul "Confirmare" pentru a o genera. Instance

Note:

Confirm | Cancel

@ Oglindirea este afectata de pozitia in-situ si este oglindita de
propriile axe atunci cand pozitia in-situ este activata.

Atunci cand entitatea generata in oglinda este o instantd a entitatii originale, entitatea
originald va fi modificata atunci cand se efectueaza modificari interne, cum ar fi

punct/linie/plan/element; atunci cand nu este o instantd, acestea nu sunt afectate una
de cealalta.
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5.7.18 Instance

Entitatile si proprietatile acestora pot fi atribuite altor poligoane editabile. Atunci cand un obiect de instanta
este modificat, se modifica si alte obiecte de instanta legate de el. Selectati elementul "Object Tab > Instance" (fila
Obiect > Instanta), selectati mai Intai reprezentantul instantei, apoi selectati alte poligoane editabile, introduceti
pentru a confirma. Pentru a revoca instantierea, introduceti "U" si apasati Enter si selectati obiectul pentru care

doriti sa revocati instantierea.

Note:

@ Obiecte dupad instantiere, atunci cidnd se efectueazd modificiri interne, cum ar fi

punct/linie/plan/element, se vor modifica si alte obiecte instantiate.

(@ Daca instanta este mutata, rotitd sau redimensionata sub nivelul volumului, obiectul instantei nu se
modificd odata cu acesta.

5.7.19 Loft o 5
Face ca sectiunea selectata sa genereze un volum de-a lungul ‘
i o ) ) . Align Pivot
traseului specificat. Selectati "Object Tab > Loft" pentru a deschide ——— S
caseta de dialog prezentata mai jos. ;
®---- -- y SR @
1. Align Pivot: Sectiunea transversala a loftului este, in mod -
implicit, centrata pe traseu si poate fi aliniata proportional in L ° °
diferite pozitii, dupa cum se doreste. Parameters
2. Parameters: Angle: 0.000
. . . - Path: ¢ =
(1) Angle: Stabileste unghiul de rotatie al sectiunii = -
transversale a mansardei. St 12 x
(2) Path: Stabileste numarul de segmente de traseu. “ e
(3) Step: In cazul in care sectiunea este o linie, puteti seta Mirror Horizontal
finetea sectiunii transversale a graficului. Mirror Vertical
3. Oglinda orizontala / Oglinda verticala: Setati modul de | |
oglindire.

Dupa setarea parametrilor de mai sus, faceti clic pe "LE=2I" selectati
o traiectorie si selectati linii sau planuri de poligoane editabile ca obiect de lofting. Faceti clic pe Apply (Aplicatie) si

se va genera un poligon editabil prin lofting pe obiectul selectat.
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5.7.20 Array

Operatiunea array permite copierea simultanda a mai

X
multor corpuri identice si aranjarea Tn spatiu a acestor obiecte Offset distance: 0.000 =
intr-o anumita ordine si forma. Selectati elementul "Object Rotation angle:  0.000 =

Tab> Array", selectati obiectul si va apdrea urmatoarea Y
fereastra de dialog. Offsctetances | 0.000. I
Rotation angle: 0.000 :

1. Parameter Note: —

(1) Offset distance: Stabileste distanta dintre fiecare z

Offset distance:  0.000 =
obiect din matrice de-a lungul axelor X, Y si Z.

Rotation angle:  0.000 =

(2) Rotation angleStabileste unghiul la care este rotit
Number: 2 =

[ Confirm Cancel

obiectul matricei.

2. AmountAdica numarul de copii generate.

3. Dupd setarea parametrilor, faceti clic pe butonul
"Confirmare" pentru a o genera.

Note:

@ Matricea este afectata de pozitia in-situ, care, atunci cdnd este pornita, se matriceazd pe propriile axe.
(@ Ajustarea numarului si a unghiului de rotatie a axei Z pentru a obtine o matrice circulars.

® 1n cazul unei matrice inelard, pentru acelasi poligon editabil, dacd pozitia axei se modificd, forma matricei
se modifica.

5.7.21 Reglati Pivotul

Schimba pozitia axei poligonului editabil. Selectati "Object Tab> Adjust Pivot" (fila Obiect> Ajustati pivotul) si

selectati obiectul; se va deschide urmatoarea fereastra de dialog.
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1. Axial transformation.

) ) Adjust Pivot X
(1) Set axis center to center: Resetarea axei

e L. . Axis center transformation
la pozitia centrului obiectului.

Set axis center to center  Set axis center to bottom
(2) Set axis center to bottom: Plasarea axei

Custom Axis reset
in punctul de valoare Z minima a axei

obiectului. Confen Cancel

(3) Custom: Customize pozitia axei, trageti

axa sau axa pentru a o deplasa, consultati
"Deplasare" pentru detalii.
(4) Axis rest: Resetati locatia axei la valoarea implicita.

2. Faceti clic pe butonul "Confirm" pentru a aplica setarile axei.

5.7.22 Align

Deplaseaza obiectul selectat astfel incat sa aiba aceleasi coordonate X, Y sau Z ca si celelalte obiecte.

Selectati elementul "Object Tab > Align" (fila

Obiect > Aliniere), selectati obiectul de referinta, Center Aligned
apoi selectati obiectul curent; se va deschide Alignment position
© x Axis Y Axis 1 Z Axis
urmatoarea fereastra de dialog.
XY JXZ YZ

1. Alignment position: Alinierea valorilor

coordonatelor obiectului curent cu obiectul Cancel

de referinta prin diferite alinieri.

2. Faceti clic pe butonul "Confirm" pentru a
aplica setarile curente.
NoteActivarea pozitiei in-situ afecteaza doar coordonatele obiectului de referintd, Tn timp

ce obiectul curent este intotdeauna aliniat la propriile coordonate.

5.7.23 Shape Merge

Proiecteaza linia sau planul pe un plan selectat. Selectati elementul "Object Tab > ShapeMerge", selectati

poligoane editabile, apoi selectati linia sau planul.
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Note:

@ Linia sau planul selectat este proiectat pe planul cel mai apropiat de poligonul editabil.
@ Liniile sunt selectate trebuie s fie in acelasi plan si inchise.

(® Planul selectat trebuie sa fie plat.

5.7.24 Shell

Creste grosimea entitatii in directia normala locala sau in directia inversa. Selectati "Object Tab > Shell", iar
urmatorul dialog va aparea:

Parameters:
Shell X

Cantitatea interioard: Cresteti grosimea in directia opusa T

»

. Inner Amount: 0.000
normalei locale. e |1

»

Outer Amount: 1.000

4

Outer Amount: Cresteti grosimea de-a lungul directiei
normalei locale.

»

Segments: 1 =
Segments: Impartiti grosimea adaugata in segmente.
Select: Select
Select Edges: Selectati marginile segmentelor de grosime Select Edies Straghten Comers
ad3du gat 3 Inner Faces Outer Faces

Straighten Corners: Grosimea colturilor va fi aceeasi cu

l Confirm Cancel

grosimea introdusa in timpul executarii comenzii shell.

Fete interioare, fete exterioare: Selectati fetele interioare sau
fetele exterioare.

Dupa ce parametrii sunt setati, faceti clic pe "Confirm" pentru a aplica.

5.8 Panou de editare solida

5.8.1 Extrudare generala

Extrude un plan sau o linie selectata a unui volum.
Note:

@ Extrudarea generala sustine clddiri, linii, planuri si volume.
@ Liniile nu sunt implicate in extrudare.

5.8.2 Sectiunea transversala de extrudare

Selecteaza o zona Tnchisa pe un plan al unei entitati si o extrude intr-un volum.

Page 169 of 241



Houseplan 1.0 Make stunning 3D scheme with speed and ease

5.8.3 Make Arc

5.8.3.1 Siruriin arcuri

Arcuirea unui plan sau a unei parti de plan pe un volum. Selectati "Modeling Tab > Solid Editing Panel > Solid
Editing Panel". - Make Arc > - Strings into Arcs" articol. Exista doua tipuri de arcuri electrice.

1. Pentru a arcui intregul plan, selectati un plan sau un plan de pe volum si specificati sau introduceti o
valoare pentru a determina distanta de arcuire.

Efectul este prezentat in figura urmatoare.

2. Tastati "P" si apasati Enter pentru a specifica doua puncte pentru arcul local. Efectul este prezentat in
figura urmatoare.

-\

Before After

Note:

@ Arcul plan sustine planuri, volume, clddiri, balcoane convexe si balcoane concave.

(@ Atunci cand se executd un arc de plan pe o clddire, pot fi manipulate numai planurile
verticale ale acesteia.

® Tragerea nodului arcuit pentru a ajusta lungimea, pozitia si distanta arcului.

@ Arcuirea lungimii coardelor nu accepta planuri curbe.

Page 170 of 241



Houseplan 1.0 Make stunning 3D scheme with speed and ease

5.8.3.2 Tangents into Arcs

Arcusul unei muchii drepte a unei prisme sau a unui plan pe un volum. Selectati "Modeling Tab > Solid Editing

Panel". > - Make Arc >

- Tangents into Arcs", selectati marginea sau planul care urmeaza sa fie arcuit, introduceti raza coltului, puteti
specifica mouse-ul sau introduceti o
valoare mai mica sau egala cu raza maxima
pentru a determina raza de arcuire.

NoteArcurile tangente sustin planuri,

volume, cladiri, balcoane convexe si
Before After

balcoane concave.

5.8.4 Multi-plane Loft

Solidele 3D sunt create prin lofting intre mai multe sectiuni transversale. Selectati "Modeling Tab > Solid Editing

Panel > ” Multiplane Loft", exista douda metode de loft.

1. Lofting prin efectul de granulatie dreapta. Selectati liniile sau planurile care urmeaza sa fie generate n ordinea
selectata.

e
-
>

Before

2. Tastati "F" si apasati enter pentru a lovi cu efectul Smooth Fit Effect.
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S
- .
>

Before

Note: Modelele generate difera in ceea ce priveste ordinea in care sunt selectate sectiunile.

5.8.5 Single-plane Loft

5.8.5.1 Move

Plaseaza planul pe verticald si tangential fata de traiectoria selectata. Selectati "Modeling Tab > Solid

Editing Panel > D
Singleplane Loft > E]

Move", selectati linia sau
planul ca sectiune
transversala, apoi
specificati punctul de baza

al  sectiunii,  selectati Before After

traiectoria si  specificati

punctul de plasare a

sectiunii pe traiectorie. Nota:

in cazul in care sectiunea transversald si traiectoria sunt coplanare, nu se
poate genera niciun volum, astfel Tncat este necesar sa se utilizeze
"Placement".

@ Locatia sectiunii transversale este locul in care este generat volumul.
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5.8.5.2 Mirror
Oglindeste planul selectat
de-a lungul marginii specificate

pentru a-i ajusta locatia. Select " [:>

Modeling Tab > Solid Editing Panel b )

Before

Single-plane Loft > EE Mirror",

selectati linia sau planul ca sectiune transversala, selectati
traiectoria ca axa de oglindire si oglinditi sectiunea. Nota:
Sectiunea transversala trebuie sa se afle de o parte si de alta
a intervalului de traiectorie, Tn caz contrar oglindirea nu va

reusi..

5.8.5.3 Path Generation

Genereaza un volum

de-a lungul traseului

"Modeling Tab > Solid Editing

; & /.«~
specificat. Selectati IEI Path ’/

Panel > E] Single-plane

Loft > Before

Generation ", selectati linia
sau planul ca sectiune transversald, apoi

selectati traiectoria. Puteti selecta mai

multe linii ca linie de traseu.
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5.8.6 Lathe

Roteste o entitate 2D in jurul unei axe pentru a genera o entitate 3D. Selectati "Modeling Tab > Solid Editing

Panel > Lathe", selectati obiectul care urmeaza sa fie rotit, linie sau plan, specificati punctul de pornire al axei.

n instructiunile din linia de comandd exista trei moduri de a specifica axa.

1. Dupa specificarea punctelor de inceput si de sfarsit ale axelor, generati entitati in jurul axelor la unghiurile
introduse.

2. Apasati return si alegeti linia ca axa de rotatie.

3. Introduceti X, Y sau Z si apasati Enter pentru a forma o axa de rotatie paraleld cu o axa de coordonate. De
exemplu, introduceti X pentru a specifica punctul de baza al axei X prin care se genereaza o axa de rotatie
paraleld cu axa X in urma solicitarii liniei de comanda. Utilizand axa selectatd ca exemplu, efectul este prezentat

in figura urmatoare.

Before After

Note: O linie infasurata in jurul unei axe genereaza un plan, iar un plan infasurat in jurul unei axe genereaza un
volum.
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5.8.7 Split Entity

Tmparte o entitate in mai multe entititi. mSplit Entity " and select the plane
Selectati "Modeling Tab > Solid Editing Panel >
al obiectului care urmeaza sa fie divizat".

1. Creeaza un plan de divizare direct in

punctul specificat. Specificarea punctelor

si orientarea planului de divizare pentru a betors

diviza volumul.

2. Introduceti "S" si apasati Enter pentru a

diviza volumul cu linia de divizare

selectata.

3. Tastati "H" si apasati Enter pentru a
Before
desena linii de divizare in acelasi mod in

care ati desena o polilinie pentru a diviza

un volum.

Note:
Impértirea obiectelor nu accepta
construirea de componente.

@Divizarea liniilor nu accepta polilinii 3D si spiralele.
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5.8.8 Union

Creates a new solid by joining two or more solids. Select "Modeling Tab > Solid Editing Panel > Union", select

multiple intersecting entities and perform union operation.

..........
*a

..

Before After

Note:

@ Tmbinarea obiectelor acceptd planuri, volume, cladiri si bazine de flori.
@ Cladirea si volumul sunt fuzionate ca entitati pentru a produce cladirea.

() Entities, other than buildings, must be of the same type to be merged.

5.8.9 Subtract

Creeaza un nou solid prin scadere. Selectati "Modeling Tab > Solid Editing Panel > D Subtract " selectati

obiectul sustras, apoi obiectul de referinta pentru a efectua operatia de sustragere.
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Note:
(@ Obiectele care urmeaza sa fie sustrase si obiectele de referinta pot fi planuri, volume, cladiri, bazine de
flori si corpuri de apa..

@ Atributele entitatii nou generate dupa sustragere urmeaza obiectul sustras.

5.8.10 Intersect

x|
Creeaza un nou solid din suprapunerea a doud solide. Select "Modeling Tab > Solid Editing Panel > . Intersect",

selecteaza doud entitati care se intersecteaza si efectueaza operatia de intersectie.

!
A
I
.
.
.
.
.
;
.
W .
g
3
v

Note:

@ Obiectul de intersectie poate fi avioane, corpuri, cladiri, bazine de flori si corpuri de ap3.

@ Atributele entitatii nou generate dupa intersectie urmeaza primul obiect selectat.

5.9 Generate Panel

5.9.1 Conversia linie/plan

Transforma o dreapta al carei inceput si sfarsit sunt conectate si care inconjoara o zona inchisa intr-un plan sau

transforma un plan intr-o dreapta.
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Select "Modeling Tab > Generate Panel > === Line/Plane Conversion" and select the line or plane to convert.

Properties

n = Plane
Alias
\\ | Color attached to layers ! 124.184.158
N\

Building number offloors

Elevation

5.9.2 Polysolid

Deseneaza sau extrage muchii pe un volum si le intinde in planuri sau volume. Selectati "Modeling Tab > Generate

Panel > il Polysolid" pentru a deschide urmatoarea caseta de dialog.

Drawing Line And Surface Body

4 8 @

1. Free drawing: Deseneaza liber entitatile liniare si le intinde Tn planuri sau volume. Faceti clic pe butonul ()
pentru a desena o linie Tn acelasi mod ca o polilinie, faceti clic dreapta pentru a termina desenul. Dupa ce
cursorul care surprinde axa este evidentiat in galben, deplasati sau introduceti o valoare, faceti clic dreapta

pentru a termina si intindeti-o intr-un plan; pentru a o intinde Tntr-un volum, continuati sa deplasati mouse-
ul pentru a intinde sau introduceti o valoare.
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2. Desenati de-a lungul marginii: Deseneaza de-a lungul marginii entitatii pentru a obtine o entitate de tip linie

si o puteti intinde Tntr-un plan sau un volum. Faceti clic pe butonul ) , specificati un punct pe marginea
entitatii, deplasati cursorul de-a lungul marginii, faceti clic dreapta pentru a termina desenul si intindeti sau
introduceti distanta de intindere.

3. Selectati o componenta a cladirii: Deseneaza de-a lungul liniei de planseu a unei cladiri sau a unei

componente pentru a obtine o entitate liniara, care poate fi ntinsa intr-un plan sau un volum. Faceti clic pe

butonul , specificati un punct de pe linia de planseu a cladirii sau a componentei si intindeti sau
introduceti distanta de intindere.

Note:

@ Componentele cladirii sprijind selectia de balcoane, ferestre, usi, acoperisuri.

@ Atunci cand se alege un punct, alegerea unui punct de colt care este coplanar nu poate obtine
marginea.
4. Selectati obiectele: Selecteaza liniile, marginile planurilor si marginile volumelor pentru a le intinde in planuri

sau volume. Faceti clic pe butonul @, selectati obiectul si Tntindeti-l sau introduceti distanta de intindere.

\*f' ~
draw draw draw Generate
Line . Ploygon ™ Solid > ‘

5.9.3 Extract Single Plane

Extrage conturul planului specificat al entitatii si genereaza planul dupa acest contur. Selectati "Modeling Tab >
Generate

Panel > @l Extract Single Plane" si selectati entitatea din care doriti s3 extrageti planul.
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5.9.4 Plane Offset

Creeaza entitati plane care sunt echidistante de toate laturile planului original. Selectati "Modeling Tab > Generate
Panel >E

Plane Offset", selectati planul care trebuie decalat, specificati direct pozitia de decalare sau introduceti valoarea care
trebuie decalata.

Note: La introducerea unei distante, valorile pozitive sunt deplasate spre exterior, iar cele negative spre interior.
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6 Vizualizati meniul

Acest capitol prezinta o serie de instrumente de vizualizare 3D utilizate in mod obisnuit, care pot fi folosite de

catre utilizator pentru a ajusta impactul vizual al proiectului pentru rezultate optime Tn timpul procesului de proiectare.

6.1 Panoul Perspective

6.1.1 Pan

Deplaseaza pozitia vederii fard a modifica pozitia sau scara obiectelor din desen. Daca tineti apasata rotita din

mijloc a mouse-ului, se activeaza si operatiunea Pan.

6.1.2 Orbit

Deplaseaza dinamic observatorul in jurul modelului, mentinand acelasi punct de focalizare. Apasand "Ctrl +
rotita din mijloc a mouse-ului" se activeaza si vizualizarea orbitala. Daca aveti o entitate selectatd si apoi folositi

aceasta functie, vizualizarea este rotita cu entitatea respectiva ca punct central.

6.1.3 Centering

Efectueaza un zoom pentru a afisa cele mai mari extinderi ale tuturor obiectelor. Se calculeaza toate extensiile
obiectelor, iar coordonatele originale ale desenelor nu vor fi modificate. Selectati instrumentul Centering (Centrare)

pentru a remedia aceste probleme.

6.1.4 Full View

Afiseaza toate entitdtile din spatiul de lucru in cea mai mare masura posibila. Introduceti "Z" si apasati Enter la

linia de comanda. Daca introduceti E si apdsati Enter se poate obtine, de asemenea, functionarea completa a hartii.
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OE B B = Houseplan

Home Insert Edit \ i Vate Scene Video Services

K2 kA ~ r [es=]
veai | L ] P « O« e
Pan Orbit Centering Full |Frame E Eye Front Window Previous Hide Hide  Unhide

View _election Control View Face View View Selected Unselected
Perspective 3D Navigate View Tools Hide

6.1.5 Frame Selection

Maximizeaza afisarea modelului sau a structurii selectate. Selectati " View Tab > Perspective Panel > % Frame
Selectionpentru a centra obiectul selectat Tn vedere. Dacd nu exista obiecte selectate, efectul este acelasi ca in "Full

view".

6.2 Panoul de navigare 3D

6.2.1 Vizualizati controlul
3D Perspective

Comuta vizualizarea Tn perspectivd 3D a spatiului de lucru curent din
diferite directii. Dati clic pe sageata albastra corespunzatoare pentru a seta

directia de vizualizare si dati clic pe butonul "Flat" Tn orice vizualizare,

vizualizarea se va transforma in stare plata.
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6.3 Vizualizati panoul Instrumente

6.3.1 Vedere din ochi

Activati perspectiva de vizualizare cu ochiul uman. Selectati "View Tab > View Tools Panel > Eye View", urmati
instructiunile din linia de comanda, setati decalajul de inadltime si specificati locatia site-ului. Unghiul de vizualizare
se va deplasa automat la Thaltimea curenta a ochiului, iar valoarea implicita este suma thaltimii sitului si a Thaltimii
de decalaj. Puteti continua sa introduceti valori de ajustare, iar vederea va fi coborata sau ridicata.

Apasati si trageti butonul din stanga Tn scena pentru a vizualiza imprejurimile din perspectiva umana.

f
PR N

Biiiigs,)

I
i

Note:

@ Decalajul de inaltime inseamna inaltimea ochiului uman. Decalajul inaltimii + indltimea locului de amplasare
=Tnaltimea finala a ochiului.

(@ Dupéa desemnarea unei pozitii, puteti roti vizualizarea prin tragerea mouse-ului pentru a naviga sau puteti

utiliza tastele sageata T, |,

<, — de pe tastatura pentru a roti si deplasa operatiunea.

6.3.2 Front Face

Selecteaza planul de pe volum pentru a afisa vederea frontala a acestuia.

6.3.3 Window View

Maximizeaza afisarea zonei selectate si permite afisarea completa si revenirea la vizualizarea anterioara.

Selectati instrumentul Window View (Vizualizare fereastra) si specificati direct un interval de casete cu doua puncte
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pentru a mari vizualizarea Tn interiorul intervalului respectiv. La linia de comanda, introduceti "E" pentru a afisa

vizualizarea completd; introduceti "P" pentru a reveni la vizualizarea anterioara.

6.3.4 Vizualizare anterioara

Revine la vizualizarea anterioara efectuata.

6.4 Ascundeti panoul
6.4.1 Ascundeti selectia
Ascunde entitatile selectate. Selectati "View > View Tools > H Hide Selected" si selectati entitatile pe care doriti

sa le ascundeti.

6.4.2 Ascundeti neselectate

Ascunde entitatile neselectate. Selectati "View > View Tools > H Hide Unselected", selectati entitati si
ascundeti toate celelalte entitati.

6.4.3 Unhide

Dezvaluie entitatile. Selectati "View > View Tools > H Unhide" element pentru a afisa entitatile ascunse in

vizualizare.
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7 Meniul de materiale

Materialul se refera |a textura unui obiect si poate fi vazut ca o combinatie intre materialul si textura obiectului.
in programele de redare, este combinatia diferitelor proprietiti vizuale ale suprafetei, referindu-se la culoarea,

textura, netezimea, transparenta, reflexivitatea, refractivitatea, luminozitatea etc. ale suprafetei.

7.1 Panou material

7.1.1 Imagine

Calculeaza automat textura planului unei entitati si ataseaza materialul imaginii la entitate la punctul
corespunzator.

size. Select "Material Tab > Material Panel > Image", the following dialog box will appear.

Image Paint X

AN

O single-side (O Layered (O Multifaceted () Single entity

[#--Residential building
[+ Office building

. Commerdial building
- School

- HOSDi!BI

- Mobile structure
- Factory

- Andient building
- Building at night
- Favorites

[}
(3}

1. Aplicati materialul

Standard v

Parameter adjustment Reflection map Bump map
oiffuse: [l 120,120,120
Specular Color: - 0,0,0
Emissive
Smoothness:
Specular level:

Glow:

Anisotropy:  1x v

Opacity: 100 [ |

Alpha test: 0 =1

Color adjustment | UV Transformation () Double-sided display

(1) Single-side: Aplica materialul pe o singura parte a unei entitati si lipeste o intreaga imagine materiala pe

un singur plan. Faceti clic pe butonul "Single-sided" (O singura fata), cursorul se va transforma intr-un

pai si selectati materialul din caseta de dialog sau alegeti materialul entitatii existente..

(2) Layered: Vopseste materialele in functie de etajul cladirii.
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(3) Multifaceted: Vopseste mai multe laturi ale entitatii in mod continuu si calculeazd automat dimensiunea
texturii in functie de Tnaltime. Faceti clic pe butonul "Multi-sided", selectati materialul, selectati planul
de pornire al entitatii.

(4) Single entity: Vopseste materialul pe intreaga entitate.

2. Ajustarea materialului.

(1) Fereastra de previzualizare.

@ O fereastra de previzualizare poate fi addugata dupa ce se face dublu clic pe materialul implicit din

caseta de dialog sau dupa ce se deseneaza un material pe o entitate de scena.

@ Faceti clic dreapta pe imaginea de previzualizare pentru a reseta unul sau pentru a reseta toate
materialele din fereastra de previzualizare, pentru a vizualiza calea materialului si pentru a adauga

materialul in directorul Favorite sau pentru a suprascrie materialul original cu materialul ajusta.

- | DBBB S = > i Housepian 1.0[Trial day left 26] - [ Untitled! |

Material

©O O

Replace  Free  Match Glass Outside rial UV Bacdace
Texture Material Adjustment Material Effect Wall Region Optimization Editor  Cull
Edit Display

Properties
Apply Textures P

@ single-side O Element (O Layered O Single entity O Group O Multi-select ) MultiPolygon

vall space ek
Windows R 1

Door eset all

Glass screen vl Image path
Hendeal Add to Favorites

Housetop
sy Overwrite

Metal
Tiie
Parameter adjustment Reflection map Bump map

oituse: [ (259595
Speaular Color 158,158,158
emissve: [ 000
Smoothess: [62 > ]
Specular level:
Glow:
Anisotropy:
opacry: [1

Alpha test: | 0

W Tranformaion] Joosie:sded dpay

Scene Units: Meters Camera Speed ———F———

® Trageti si fixati materialul intr-o noua fereastra de previzualizare pentru a copia materialul.
(2) Efecte materiale: Caseta de dialog este predefinitd cu cinci efecte de material: standard, sticld, metal,

lemn si murdarie, care pot fi selectate in meniul derulant.
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(3) Parameter adjustment: Ajustarea

parametrilor materialului. Strilucirea Color Adjustment X
este eficientda numai pe timp de Hue: B o FE
noapte. Saturation: i o E
j ; ightness: S

(4) Color adjustment: Regleaza Brightness B 0
Contrast: | 0 ..:H

parametrii de culoare ai unui material,

faceti clic pe butonul "Color

Y

™

Adjustment" pentru a deschide caseta i

i

v

de dialog prezentata mai jos.

r

-

Utilizatorii  pot  ajusta  diferiti g

E

parametri de culoare, cum ar fi nuanta,

saturatia, luminozitatea si contrastul.

Dupa ajustarea parametrilor, faceti
clic pe butonul "Save" pentru a salva
valorile parametrilor ajustati si pentru a le aplica; faceti clic pe butonul "Reset" pentru a readuce toate
valorile parametrilor la valorile lor implicite.

(5) UV Transformation: Regleaza rata de animatie UV a materialului pentru ca acesta sa aiba un efect
dinamic. Faceti clic pe butonul "UV Transform" (Transformare UV). Ajustarea parametrilor modifica

efectele materialului in timp real.

UV Transformation

UV Animation
Speedu 0.0 211

SpeedV 0.0 A

(6) Afisaj pe doua fete: Se bifeaza pentru a afisa ambele parti ale entitatii dupa vopsirea materialului; se

debifeaza pentru a afisa o singura parte a entitatii dupa vopsirea materialului.
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(7) Reflection mapAdauga o harta de reflexie la material si ajusteaza parametrii pentru a face materialul
mai realist.

(8) Harta de denivelari: Adauga o harta de denivelari la material pentru a-i da o senzatie de denivelare.

3. Add material.

(1) Faceti clic cu butonul din dreapta al mouse-ului in lista de categorii pentru a deschide meniul contextual,
asa cum se arata mai sus.

@ New: Un nou tip de material.
Delete: Sterge tipul de material nou creat.
Edit: Modificd denumirea noului tip de material.

Import: Selectati dosarul si importati imaginile materiale din dosar.

© ® @ 0O

Import cpr: Selectati fisierul in format cpr si importati materialul.

(® Export cpr: Exportati materialul din catalog in format cpr
(2Faceti clic dreapta pe imaginea materialului sau pe un spatiu gol pentru a deschide un meniu contextual
pentru a elimina sau adauga materiale.

Note:

@ Imaginile externe pot fi in format jpg, png, dds.

@ Puteti trage o imagine externa in spatiul de lucru, selectati metoda de vopsire si obiectul pentru a o
picta.

7.1.2 Material

Vopseste materialul de pe entitate cu parametrii de textura impliciti. Selectati "Material Tab > Material Panel >

7
Material" pentru a deschide urmatoarea fereastra de dialog.
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Apply Textures

© single-side () Element () Layered () Single entity () Group () Multi-select (©) MultiPolygon
Wall space
Window
Glass screen wall
Handrail
Housetop 1 2
Glass
Metal Standard v
we i Parameter adjustment Reflection map Bump map
00
Road piffuse: [l 120,120,120
Slabstone
Bottom of the pool Specular Color: - 0,0,0
Parterre 3 4 Aat
Emissive: 0,0,0

Parapet wall - -
Ground Smoothness: =1
Favorites

Specular level: [ ]

Glow: 1
5 6 Anisotropy:  1x v
Opacity: |
J i Alpha test: =
g r\ Color adjustment | UV Transformation [_] Double-sided display
1

(1) Single-side: Vopseste un material pe o singurd parte a unei entitati, aplicind materialul pe plan in
conformitate cu textura implicita.

(2) Element: Vopseste materialul pe un singur element al entitatii atasate. Numai pentru elementele din
poligoanele editabile.

(3) Layered: Vopseste materialele in functie de etajul cladirii.

(4) Single entity: Vopseste materialul pe intreaga entitate.

(5) Group: Picteaza materialul pe entitatile dintr-un grup.

(6) Multi-select: Selecteaza mai multe entitati pentru a picta materialul in acelasi timp.

(7) Multiolygon: Vopseste materiale pe mai multe planuri ale entitatilor poligonale editabile.
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7.1.3 Acoperire

Paints coating onto entities. Select "Material Tab > Material Panel > ﬁ Coating" to bring up the following dialog box.

Base color(B):

M NN
C BB N B B B B
s B 8 B B B
EEEENENNN
B 0 B B B8 BN

Custom color(C):

AN . Hue@®): 0 RedR):
HEEN ' EB Saturation(S): 0 Green(G):
© single-side | Single entity ) Group CoIorIPunty(O) Brightness(L): ﬂ Blue(B):
Olayered () Multi-select

Add to custom color(A)

"Custom colors" sunt salvate in software, astfel Tncat sa puteti adauga culorile utilizate frecvent la "Culori
personalizate" pentru utilizare ulterioara.

La desenarea n culori, valorile RGB desenate pot fi inexacte din cauza efectelor luminii ambientale.
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7.2 Panou de editare

7.2.1 Reglarea texturii

Regleaza scara de afisare, orientarea
si pozitia materialelor entitatii. Selectati

"Material Tab >

Edit Panel > IS8 Adjust Texture pentru a

deschide fereastra
urmatoarea caseta de dialog.
1. Zoom: texturilor

Regleaza scara

materialelor.

2. Rotate: Regleaza orientarea texturii
materialului.

3. Panning: Regleaza pozitia texturii

materialului.

Adjust Textures X

Zoom
Horizontal | 0.708  *
- +
Vertical 0.708 2
- +
Rotate
Angle 0.000 3
-180 0 180
Panning
Horizontal |0.000 2
3
Vertical 0.000 *
+
£ce Ectng Body Editing Modify All | Mirror Horizontal

\

Mirror Vertical

4. Face Editing: Modificarea texturii materiale a unei singure fete.

5. Body Editing: Modificarea texturii aceluiasi tip de material pe o singura entitate.

6. Modify all: Modifica texturile tuturor materialelor de acelasi tip din scena.

7. Mirror Horizontal: Oglindeste materialul selectat pe o singura fata, un singur volum sau un material complet

in directie orizontala.

8. Mirror Vertical: Oglindeste materialul selectat pe o singura fata, un singur volum sau un material complet pe

directie verticala.

Note: Puteti utiliza functia "Materia
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7.2.2 Replace Material

Tnlocuieste materialele de acelasi tip pe mai

multe sau pe toate entitatile din scend. Selectati

"Material Tab > Edit Panel >

Replace Material ".

1. Multi-selectinlocuieste acelasi tip de material
pe entitatea selectata. Faceti clic pe butonul
"Multi-select", selectati materialul implicit
sau materialul entitatii din spatiul de lucru,
apoi selectati obiectul care urmeaza sa
inlocuiasca materialul si, in final, selectati
materialul care urmeaza sa fie inlocuit.

2. All: Tnlocuiti acelasi tip de material pe toate

entitatile. Faceti clic pe butonul "All" (Toate),

selectati materialul implicit sau materialul
care deseneaza entitatile din spatiul de lucru,
apoi selectati materialul care urmeaza sa fie

inlocuit. Nota: "Replace Material" inlocuieste

Replace Material

I Multiselect  © Al

Wall space

doar textura si efectul materialului, nu si UV-ul texturii.

7.2.3 Ajustare gratuita

Texturile materiale ale entitatilor sunt mapate pe proiectia corespunzatoare si ajustate pentru a rafina efectul

proiectului.. Select "Material Tab > Edit Panel > ¥4 Free Adjustment".
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Free Adjustment
|
OE® | B B |Osogeste Otitioceted Qo
|
Range
L 1.000 : - +
w | 1.000 al . +
H | 1.000 21 - +
Amount
y | 1000 ol = +
v 1000 3 .
Panning
U 0.000 : - +
v |0.000 al . +
w |0.000 o = +
Rotate
u |0.000 2
-180 0 180
v |0.000 2
- -180 0 180
w |0.000 =
-+ -180 0 180
Scale
U |1.000 = = +
v | 1000 = - +
w | 1.000 = = i

1. Metoda de proiectie a texturii materialului.

(1) Cube Reface materialul unei entitati sub forma unei proiectii dreptunghiulare.
(2) Cilindru: Reface materialul unei entitati sub forma unei proiectii cilindrice.
(3) Sfera: Reface materialul unei entitati sub forma unei proiectii sferice.
(4) Plan: Reface materialul unei entitati sub forma unei proiectii plane..
(5) Suprafata: Reface materialul unei entitati ca proiectie implicita.
2. Oglindirea.

(1) Mirror Horizontal: Oglinzi in directia U selectate cu o singura fata, cu mai multe fete, cu un singur corp sau
din toate materialele.

(2) Mirror Vertical: Oglindeste o singura fata, mai multe fete, un singur corp sau toate materialele selectate
in directia V.
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3. Reglare:
(1) Single-side: Selecteaza un singur plan si regleaza materialul pe un singur plan.
(2) Multifaceted: Selecteaza mai multe planuri si regleaza materialele pe mai multe planuri.
(3) Body: Selecteaza o singura entitate si ajusteaza materialul de pe aceasta entitate.
(4) All: Selecteaza mai multe entitdti pentru a ajusta materialele de pe toate entitatile.
4. Parameter adjustment.
(1) Range: Stabileste lungimea, |atimea si Tndltimea casetei de editare.
(2) Amount: Stabileste numarul de ori de cate ori se repeta textura materialului.
(3) Panning: Stabileste distanta de decalaj in directia UVW a texturii materialului.
(4) Rotate: Stabileste unghiul de rotatie in directia UVW al texturii materialului.
(5) Scale: Stabileste scara texturii materialului in directia UVW.

Note:
@ Ajustarea gratuita nu accepta selectarea entitatilor din fisiere (modele fbx/skp/osgb, harti de imagini,
entitati de potrivire, entitati de plante, animatii scheletice).
(@ Faceti clic pe textele albastre pentru a reseta parametrii.

7.2.4 Potriviti materialul

Potriveste si aplica un material selectat dintr-un plan, volum sau cladire existenta la altele. Selectati "Material Tab
> Edit Panel >

Match Material" pentru a alege un material. Puteti alege metoda de vopsire Tn functie de promptul de comanda.

Exista cinci tipuri de metode de vopsire.
1. Selectati direct materialul entitatii pentru a se potrivi in totalitate cu o alta entitate.
2. Alegeti un material, tastati "D" si apdsati Enter pentru a aplica materialul pe un singur plan.
3. Alegeti un material, tastati "L" si apasati Enter pentru a aplica materialul la un singur etaj al cladirii.

4. Alegeti un material, tastati "M" si apasati Enter pentru a aplica materialul la mai multe entitati.
Note: "Pick Material" nu numai ca imita textura si efectul materialului, dar imita si uv-ul texturii, ceea ce este

diferit de "Replace Material".
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7.2.5 Efectul de sticla

Aplica efectul de sticla pe o D Glass Effect".
componenta de sticla existenta.
Selectati "Material Tab > Edit Panel >

1. Single-select: Faceti clic pe materialul Single dlick to select the entity. Double dlick to select all glasses

de sticla pentru a aplica un efect de
sticla la componenta de sticla

selectata.

2.Select All: Faceti dublu clic pe

materialul de sticld pentru a aplica un
efect de sticld la toate componentele
de sticlda. Note: Sprijind selectia de balcoane, ferestre, usi, ferestre de mansarda si pereti cortind din sticla.

Efectul poate fi aplicat, de asemenea, materialelor din sticld de pe alte entitati.

7.2.6 Outside Wall Region

Zonarea planurilor verticale ale cladirii si a frontoanelor pentru a permite pictarea materialelor in vederea rafinarii
efectului proiectului. Selectati "Material

Tab > Edit Panel > Outside Wall Region".

1. Horizontal area: Deseneaza zone orizontale. Faceti clic pe
— QOutside Wall Region
butonul 'Q pentru a specifica pozitia de pornire sau

introduceti "C" pe linia de comanda pentru a selecta prin

podea.
(1) Dupa ce ati specificat punctele de inceput si de sfarsit,
urmati instructiunile din linia de comanda pentru a

selecta un alt plan vertical.

(2) Pentru a desena in functie de etaj, introduceti "C" si

apasati Enter, specificati direct sau introduceti
numarul de etaje pentru a determina etajul initial,
apoi determinati etajul final, apoi selectati alte planuri verticale, dupa cum vi se solicita pe linia de
comanda.
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2. Vertical Area: Deseneaza zone verticale. Este suficient sa faceti clic pe D si urmati instructiunile din linia de

comanda pentru a specifica pozitiile de inceput si de sfarsit.

3. Horizontal Surround: Deseneaza o zona prin podele. Faceti clic pe % pentru a specifica pozitia de pornire
sau introduceti "C".
in linia de comanda pentru a selecta in functie de etaj, in acelasi mod ca si pentru "Horizontal Area".

4. Proiectie grafica: Defineste liniile sau planurile inchise ca zone sau proiecteaza pe o cladire pentru a genera
automat zone.

Facand clic pe si selectati un plan sau o linie inchisa va permite ca obiectul selectat sa fie proiectat pe cladire
pentru a genera o zona.

5. Bring to top: Regleaza ordinea de afisare a zonelor care se suprapun. Faceti clic pe butonul i si selectati

zonele care se suprapun pentru a afisa zona selectata in partea superioara.

Note:

@ Snap trebuie sa fie activat atunci cadnd se deseneaza zone.

@ Zonarea podelelor poate fi desenata sau definitd numai pe partea supraterana a unei cladiri, iar acestea

apartin cladirii si se modifica atunci cand cladirea este mutata, stearsa sau copiata.

(® Acoperisurile nu accepta Zonarea podelelor pentru desenarea zonelor orizontale.

@ Pentru cartografierea imaginii, punctul de clic al cursorului trebuie sa fie proiectat pe cladire, iar obiectul

selectat trebuie sa se afle la £ 2 m de cladire pentru ca cartografierea sa aiba succes.

(® Faceti dublu clic pe Zonarea podelei pentru a glisa si a plasa punctul de clip pentru a edita sau apasati
Delete pentru a sterge.

(& Dati dublu clic pe o clddire pentru a selecta toate zonele de pe aceasta.
@ Cand se modifica indltimea unei clddiri, se schimba si zonele selectate dupa etaj.

Verificarea zonei etaj permite modificarea relatiilor ierarhice din coloana de proprietate din dreapta.

(9 Utilizati metoda de vopsea ,,cu un singur corp” atunci cand vopsiti materialul zonat.

7.2.7 Optimizarea materialelor
Optimizeaza si Tmbina aceleasi materiale. Selectati "Material Tab > Edit Panel >Materia| Optimization" pentru

a aplica aceasta functie.

Utilizati aceasta functie pentru a optimiza eficienta materialului atunci cand scena este mare.
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7.2.8 UV Editor

UV Editor poate ajusta texturile materialelor modelului. Interfata este un spatiu 2D, iar texturile UV se schimba
dinamic cu modelul 3D aferent. in timp ce ajustati coordonatele texturii, daca textura UV este complicata, trebuie
doar sa executati functia Mapping UVs pentru a actualiza coordonatele texturii 2D ale modelului 3D, iar fetele
curbate vor fi taiate in cochilii adecvate, care sunt afisate pe acelasi plan si disponibile pentru fi exportat in alt
software de desen pentru a aplica texturi pentru modelul 3D. Dupa aceea, Editorul UV accepta si efectuarea

ajustarilor minore necesare.

Select "Material > Edit Panel > UV Editor", and the following window will pop up:

UV Editor n'

State UV Snapshot Cut Sew  Unfold

T |-=Ribbon

A4

Mapping UVs

Layout
Y

© " [+ ][] | [DiO] [smmetiee ~|vn ~+| |~€—Status Bar

7.2.8.1 State

Comuta afisarea marginilor texturii, umbreste Tnvelisurile UV si comuta daca texturile sunt afisate n Editorul UV.
Selectati ,Editor UV > Stare”, iar meniul drop-down va fi dupa cum urmeaza:
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1. Texture Borders: Comutati afisarea marginilor texturii pe

carcasele UV. Dacd este activatd, marginile vor fi afisate cu Texture Borders

Distortion Shader

evidentiere galbena. I
’ mage

2. Distortion Shader: Determinati zonele intinse sau comprimate
colorand coaja. Rosu inseamna intins, iar verde inseamna

comprimat.
Cu cat rosul este mai inchis, cu atat este mai intins si invers. Alb inseamna normal.

3. Imagine: Comutati daca doriti sa afisati texturi Tn Editor UV.

7.2.8.2 UV Snapshot

Exportd imaginile UV curente in fisiere externe. Selectati ,Editor UV > Instantaneu UV” si va aparea urmatorul

dialog:
UV Snapshot X
File name: || |
Size(pixel): I
Color Value: -
Cancel

Parameter Description:
1. File name: Setati numele si calea de salvare a imaginilor UV curente. Clic ' *** | butonul, introduceti un nume de

fisier si specificati o locatie a fisierului.
2. Size (pixel): Setati dimensiunea hartilor UV curente.
3. Color Value: Setati culoarea marginii hartilor UV.

Dupa setarea acestor parametri, faceti clic pe Confirmare pentru a exporta.

Note:

(@ Exportul nu poate fi efectuat daca nu sunt selectate modele.

@ Tn modul punct, linie sau varf UV, intregul model din editorul UV va fi exportat chiar dacd este selectat

doar partial; Tn modul poly, ele sau UV shell, doar partea selectata va fi exportata.
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7.2.8.3 Mapping UVs
Maparea include maparea automata, plana, sferica si cilindricd. Selectati metoda de mapare adecvata pe baza

formei generale a modelului. Selectati ,,Editor UV > Maparea UV-urilor” si va aparea urmatorul dialog:

Mapping UVs X

Automatic UV 6

Planar UV X Y Z
" Spherical UV

| Cyindrical v

Parameter Description:

1. Automatic UV:

UV automat Tncearca sa gaseasca cea mai buna pozitie UV proiectand din mai multe planuri. Acesta
creeaza coordonate UV pentru obiectul sau poligonul selectat, implicit fiind sase planuri de proiectie. Faceti
clic pe butonul drop-down pentru a selecta numarul de planuri de proiectie si pentru a seta parametrii
planului de proiectie pentru a afecta rezultatul maparii UV automate. Cu cat sunt mai multe planuri de

proiectie, cu atat sunt mai putine plane intinse si comprimate. Asa cum se arata mai jos:

Model in the 3D scene Unfolded maps in the editor

Page 199 of 241



Houseplan 1.0 Make stunning 3D scheme with speed and ease

Cand utilizati maparea UV automata, vizualizarea 3D va afisa planuri de proiectie, gadget si axa de rotatie in

raport cu ecranul cu obiectul selectat in centru, asa cum se arata mai jos.:

Projection Plane

Gizmo

Rotation axis

relative to screen

uv
Coordinate Axes

(1) Planurile de proiectie sunt planuri de albastru cu o opacitate de 60%. Fiecare margine a unui plan de
proiectie este afisata fie in rosu, fie in verde, corespunzator axelor de coordonate UV, axelor ferestrei de
vizualizare a modelului mapat.

(2) Aparatul poate fi mutat, rotit si scalat pentru a ajusta caseta de delimitare a modelului 3D pentru a
modifica rezultatul maparii.

@ Move: Puneti cursorul pe axa, planul axial sau centrul axial al dispozitivului. Cand gizmo-ul este

evidentiat cu galben, tineti apasat butonul stang al mouse-ului pentru a trage.

@ Rotate: Faceti clic pe axa de rotatie fata de ecran pentru a activa. Puneti cursorul pe orice axd de
rotatie si, cand axa este evidentiata cu galben, tineti apasat butonul stdng al mouse-ului pentru a

trage.

® Scale: Faceti clic pe cubul de la capatul axelor si puneti cursorul pe un cub. Cand cubul este
evidentiat cu galben, tineti apasat butonul stang al mouse-ului pentru a trage.
2. Planar UV

Utilizati UV plan pentru a crea coordonatele texturii UV pentru obiectul selectat. Valoarea implicita este axa X.
Faceti clic pentru a selecta axa X, Y sau Z si pentru a genera un plan de proiectie pe baza acelei axe, asa cum se arata
mai jos:
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Model in the 3D scene Unfolded maps in the editor

Cand utilizati UV plan, chenarul va fi afisat cu obiectul selectat ca centru Tn vizualizarea 3D, asa cum se arata
mai jos:

Border
Frame

(1) Cadrul de margine este afisat in forma ,FH”. Mutati si scalati cadrul de chenar pentru a modifica raportul

latime/indltime in rezultatul mapat pentru a evita distorsiunile.

@ Move: Puneti cursorul pe cubul din centrul cadrului de chenar. Cand cubul este evidentiat cu

galben, tineti apdsat butonul stang al mouse-ului pentru a trage.

@ Scale: Puneti cursorul pe coltul sau pe mijlocul unei margini. Cand punctul este evidentiat cu
galben, tineti apasat butonul stang al mouse-ului pentru a trage.
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(2) Faceti clic pe liniile care se intersecteaza pe cadru pentru a activa gizmo si axele de rotatie in raport cu
ecranul. Faceti clic din nou pentru a le ascunde. Consultati UV automat pentru instructiuni detaliate
despre gizmo si axele de rotatie.

3. Spherical UV
Utilizati UV sferic pentru a crea coordonatele texturii UV pentru obiectul selectat. Aceasta proiectie se
intinde n jurul retelei. Cel mai bine este folosit pentru sfere Tnchise finalizate fara gauri. Efectul este prezentat

mai jos:

Model in the 3D scene Unfolded maps in the editor

Cand utilizati UV sferic, cadrul de delimitare va fi afisat in vizualizarea 3D cu obiectul selectat in centru, asa

cum se arata mai jos:
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(1) Existd cuburi de diferite culori pe cercurile de delimitare care pot fi folosite pentru a regla pozitia si

dimensiunea cercurilor de delimitare.

@ Green cube: Puneti cursorul pe cubul verde si, cdnd este evidentiat, tineti apdsat butonul stang
al mouse-ului pentru a trage cubul si cercul de delimitare va fi schimbat de-a lungul axei Z
locale.

@ Red cube: Puneti cursorul pe cubul rosu, iar cand este evidentiat, tineti apdsat butonul stang
al mouse-ului pentru a trage cubul si cercul de delimitare va fi schimbat de-a lungul axei X

locale.

® Blue cube in the center: Puneti cursorul pe cubul albastru din centrul cercului de delimitare si,
cand este evidentiat, tineti apasat butonul stdng al mouse-ului pentru a modifica scalarea

cercului de delimitare.

@ Blue circle: Puneti cursorul pe cercul albastru si, cand este evidentiat, tineti apasat butonul
stang al mouse-ului pentru a schimba rotatia cercului de delimitare.

(2) Faceti clic pe cuburile de pe liniile care se intersecteaza pentru a activa gizmo si axele de rotatie in raport
cu ecranul. Faceti clic din nou pentru a le ascunde. Consultati UV automat pentru instructiuni detaliate
despre gizmo si axele de rotatie.

4. Cylindrical UV
Utilizati UV cilindric pentru a crea coordonatele texturii pentru obiectul selectat. Aceasta proiectie se intinde

in jurul retelei. Cel mai bine este folosit pentru cilindri inchisi complet fara gauri. Efectul este prezentat mai jos:

Model in the 3D scene Unfolded maps in the editor
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Cand utilizati UV sferic, cadrul de delimitare va fi afisat in scena 3D cu obiectul selectat in centru, asa cum se

aratd mai jos:

(1) Exista cuburi de diferite culori pe cercurile de delimitare care pot fi folosite pentru a ajusta pozitia si

dimensiunea cercurilor de delimitare.

@ Green cube: Plaseaza cursorul pe cubul verde, iar cdnd este evidentiat, tineti apasat butonul stang

al mouse-ului pentru a trage cubul si cercul de delimitare va fi schimbat de-a lungul axei Z locale.

@ Red cube: Plaseaza cursorul pe cubul rosu, iar cand este evidentiat, tineti apasat butonul stang al

mouse-ului pentru a trage cubul si cercul de delimitare va fi schimbat de-a lungul axei X locale.

® Blue cube in the center: Plaseaza cursorul pe cubul albastru din centrul cercului de delimitare si,
cand este evidentiat, tineti apasat butonul stang al mouse-ului pentru a modifica scalarea cercului

de delimitare.

@ Blue cube connected to the center: Plaseaza cursorul pe cubul albastru si, cdnd este evidentiat,
tineti apdsat butonul stang al mouse-ului pentru a schimba rotatia cercului de delimitare.

(2) Faceti clic pe liniile care se intersecteaza pentru a activa gizmo si axele de rotatie in raport cu ecranul. Faceti
clic din nou pentru a le ascunde. Consultati UV automat pentru instructiuni detaliate despre gizmo si axele de
rotatie.
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7.2.8.4 Cut

Separa UV de-a lungul marginii selectate pentru a crea margini UV. Selectati "UV editor > Cut", plasati cursorul pe
marginea de tdiat, iar cand marginea este evidentiata in alb, tineti apasat butonul stang al mouse-ului si treceti cu
mouse-ul peste ea.

Note:

(@D Functia de taiere poate fi utilizata in vizualizarea UV si vizualizarea 3D.

@ Tnainte de finalizarea comenzii de tdiere, linia de tiiere selectat este verde in mod implicit. Plasati peste

linia verde si va fi cusut.
7.2.8.5 Sew

Coase UV de-a lungul marginii selectate pentru a coase impreuna doua linii separate. Selectati "UV editor > Sew",
plasati cursorul pe marginea de cusut, iar cand marginea este evidentiata Tn alb, tineti apdsat butonul stang al mouse-

ului si treceti cu mouse-ul peste ea.

Note: Cand cursorul trece peste marginile cusute, coaserea se face automat.

7.2.8.6 Unfold

Desfaceti UV de-a lungul liniilor de tdierePrin desfasurarea UV intr-un spatiu 2D, desenul texturii poate fi usor
realizat si aplicat pe model. Selectati "UV Editor > Unfold", si selectati modelul de desfasurat.
Note: UV alcatuieste grila UV, similar modului in care varfurile alcatuiesc ochiurile poligonale. Procesul de

desfasurare este ca si cum ai tdia o bucata de panza si o asezi deasupra unei mese.

7.2.8.7 Layout

Aranjeaza automat carcasele UV pentru a maximiza utilizarea spatiului de la 0 la 1. De asemenea, poate seta
dimensiunea carcaselor UV. Selectati

,Editor UV > Aspect”, iar meniul drop-down este afisat mai jos:

Layout Along
Texel Density

1. Layout Along: Aranjati automat carcasele UV pentru a maximiza utilizarea spatiului de la 0 la 1. Faceti clic pe

Layout Along si va aparea urmatorul dialog:
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Layout Along X

Texture Map Size(pixel): |1024 :

Shell Padding: | 10.000

Preserve 3D Ratios: [ ]

Apply Reset

(1) Texture Map Size (pixel): Setati rezolutia Tn spatiul UV pentru a calcula valoarea de umplere a pixelilor.

(2) Shell Padding: Setati distanta dintre pixeli intre carcasele UV.

State UVSnapshot  MappingUVs  Cut  Sew  Unfold  Layout

Texture Map

Shell Padding: [ 100.000

Preserve 30 Ratios: |

(3) Preserve 3D Ratios: Comuta, shell-urile vor fi scalate in functie de zona corespunzatoare pe modelul 3D;
untoggled: scoicile vor fi scalate in functie de dimensiunea scoicilor dupa desfacere.

Dupa setarea parametrilor, faceti clic pe Aplicare pentru a obtine aspectul. Faceti clic pe Resetare pentru a
reseta la valorile implicite.

2. Densitatea texelilor: Seteaza dimensiunea carcasei UV specificdnd cantitatea de texeli incluse pe unitate. Faceti

clic pe Texel Density si va aparea urmatorul dialog:
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Texel Density X
Pixels per unit: |3.140

Get Set

Dupa setarea densitatii, faceti clic pe Get pentru a afisa densitatea texel a partii selectate; faceti clic pe Set

pentru a scala carcasa UV pentru a se potrivi cu densitatea de texel specificata.

7.2.8.8 Instrument

Este posibil ca marginile texturii sa nu poata fi detectate pentru modelele externe desfasurate importate Tn acest
software. Sau modelele realizate cu acest software ar putea uneori sa nu poata afisa marginile texturii. Puteti rezolva
problema utilizand comanda Refresh Shell.

Selectati "UV Editor > Tool", iar meniul drop-down este afisat mai jos:

1. Refresh Shell: Obtine marginile de textura ale cochiliilor UV.
Refresh shell

2.Orient to EdgesSelecteaza o margine pe carcasa ca referintd, Oriant to Edges

rotiti aceasta margine pentru a o face paralela cu axa u sau axa

v pentru a regla directia carcasei. Directia de rotatie poate fi

setatd prin unghiul dintre muchia selectatd si axa u sau v. in mod normal, directia de rotatie este spre partea
cu unghiul mai mic. Daca unghiul este exact de 45 de grade, directia va fi pe axa u.

Note: Orientarea spre margini poate fi utilizata numai in modul linie.

7.2.8.9 Status Bar

Tnainte de a intra Intr-un submod, starea implicitd nu permite editarea in vizualizarea modelului desfisurat. Faceti
clic pe un buton din bara de stare pentru a intra in modul de editare. Diferite butoane corespund diferitelor obiecte de

editare.

. N - ) . . N . . N .
1. Point: Dupa ce faceti clic pe@ butonnumai punctele pot fi selectate in editor si ale caror puncte partajate sunt

selectate Tn acelasi timp automat.
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.Line: Dupa ce faceti clic pel * buton, numai liniile pot fi selectate Tn editor si ale caror linii partajate sunt

selectate Tn acelasi timp automat.
. Polygon: Dupa ce faceti clic pel:l buton, numai poligoane pot fi selectate in editor.
. Element: Dupa ce faceti clic _‘ butonul, numai elementele pot fi selectate Tn editor.

. UV Vertex: Folosit alaturi de Point. Clic pe \il buton, si butonul de punctare @l este selectat automat.
Selectati punctele din vizualizarea 3D si sunt selectate si toate varfurile UV corespunzatoare din editor. lar
punctele partajate ale punctelor selectate in editor nu vor fi selectate automat.

. UV Shell: Butonul nu poate fi folosit singur. Trebuie utilizat impreuna cu butonul Point, Line sau Poly. Dupa ce

re==n

faceti clic t-4| butonul si oricare dintre butonul Point, Line sau Poly si selectati o parte a modelului in editor,

care va fi afisata Tn puncte, linii sau poligoane.

. UV Symmetry: Faceti o alta piesa cu o relatie de simetrie in vizualizarea UV pentru a obtine aceeasi modificare
ca si piesa selectata.

De exemplu, dupa efectuarea modificarii obiectelor sursa, facand clic pe IU_MI buton, selectdnd obiectele sursa
si faceti clic dreapta, apare o linie simetricd Tngrosata, puteti selecta liniile simetrice Tngrosate sau puteti tineti
apasat Ctrl Tn timp ce trageti cu butonul stang al mouse-ului pentru a ajusta pozitia axei Tngrosate pe verticala
si pe orizontala pentru a determina unde se afla Tnvelisul simetric plasat in spatiul de lucru UV Editor. Apoi,

specificati planul simetric Tn entitatea 3D si faceti clic dreapta.
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UV Editor n

State UV Snapshot Mapping UVs Cut Sew  Unfold Layout Tool
~—

~ ~

@\E‘E\E 1Symmetrlzevmqn

8. Symmetrize: Aceasta optiune este pentru modelele care au o relatie de simetrie in vizualizarea 3D. Dupa
selectarea axei de simetrie, se selecteaza o parte a modelului si se selecteaza si partea simetrica a modelului in
acelasi timp. Puteti face clic pe butonul drop-down pentru a selecta axa si apoi puteti opera in editor.

9. Material: Tabloul de verificare este materialul implicit al software-ului, folosit in principal pentru a verifica daca
carcasele UV sunt intinse.

Tn plus, informatiile despre material vor fi afisate si in lista derulanta.
Note: Cand intrati in modul punct, linie sau element in editor, selectati un punct/linie/invelis UV si va fi selectat

si punctul/linia/invelis UV corespunzator din vizualizarea 3D.
7.2.8.10 Toolbar

1. Move: Facand clic pe buton, pe langd selectarea unei entitati in fereastra UV Editor pentru operatia de
mutare, puteti selecta si o entitate in vizualizarea 3D pentru mutare, care corespunde comenzii Mutare din
modelarea avansata. Obiectul este mutat in urmatoarele moduri.

(1) Deplasati direct, faceti clic pe un obiect si trageti direct mouse-ul pentru a muta obiectul.
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(2) Selectati si mutati. Adaugati mai intai obiectul care urmeaza sa fie mutat in setul de selectie si mutati-I

prin specificarea punctului de referinta din setul de selectie ca punct de baza.

(3) Faceti clic dreapta pe butonul Mutare si setati distanta de miscare a obiectului selectat in fereastra pop-
up..
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Move Transform Type-In

7. 0.000

Directia de miscare este determinatd de mouse si de sistemul de coordonate de referinta curent. Sistemul
de coordonate 2D este afisat in fereastra UV Editor, obiectul se poate misca numai in plan 2D, are legatura cu
miscarea interfetei de modelare avansata. Pentru a restrictiona miscarea obiectului in axa X sau Y, faceti clic
direct pe axa pentru a bloca temporar axa corespunzatoare, puteti utiliza si comenzile legate de ,,constrangere”

din fereastra de modelare avansata pentru a bloca axa.

2. Rotate: Ficand clic pe M buton, pe 1anga selectarea unei entitti in fereastra UV Editor pentru operatia de
rotatie, puteti selecta si o entitate in vizualizarea 3D pentru rotire, care corespunde comenzii Rotate din
modelarea avansata.

Obiectul este rotit in urmatoarele moduri.

(1) Rotire directa, faceti clic pe un obiect si trageti direct mouse-ul pentru a roti obiectul.
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[0.00.0.00,-41.92]

(2) Selectati si rotiti, obiectul care trebuie rotit este addugat mai intai la setul de selectie si rotit prin

specificarea punctului de referinta din setul de selectie ca punct de baza.

[0.00,8100.-109/38]

(3) Faceti clic dreapta pe butonul Rotire si setati unghiul de rotatie al obiectului selectat in fereastra pop-up.
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Rotate Transform Type-In

Directia de rotatie este determinata de mouse si de sistemul de coordonate de referinta curent; fereastra UV
Editor arata un sistem de coordonate 2D, obiectul poate fi rotit doar Tn planul 2D, are o legdtura cu rotatia interfetei
de modelare avansata. Pentru a restrictiona rotirea obiectului Tn axa X sau Y, faceti clic direct pe axa pentru a bloca
temporar axa corespunzatoare, puteti utiliza si comenzile legate de ,constrangere” din fereastra de modelare
avansata pentru a bloca axa.
3. Scale: Apasa pe E] buton, selectati un obiect, pe 1anga selectarea unei entitati in fereastra UV Editor pentru
operatia de scard, puteti selecta si o entitate Tn vizualizarea 3D pentru scard, care corespunde comenzii Scale
din modelarea avansata. Obiectul este scalat in urmatoarele moduri.

(1) Scalare directa, faceti clic pe un obiect si trageti direct mouse-ul pentru a scala obiectul.
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(2) Selectati si scalati, obiectul care urmeaza sa fie scalat este addugat mai intdi la setul de selectie si scalat

prin specificarea punctului de referinta din setul de selectie ca punct de baza.

(3) Faceti clic dreapta pe butonul ,Scale” si setati scara de zoom a obiectului selectat in fereastra pop-up.

Scale Transform Type-In

X; 100.000 y; 100.000  z: 100.000 9,: 200.000

Directia de scalare este determinata de mouse si de sistemul de coordonate de referinta curent; fereastra
UV Editor arata un sistem de coordonate 2D, iar obiectul poate fi scalat doar in planul 2D, care este legat de
scalarea interfetei de modelare avansata. Pentru a restrictiona obiectul la scara in axa X sau Y, faceti clic direct
pe axa pentru a bloca temporar axa corespunzatoare, puteti utiliza si comenzile legate de ,constrangere” din

fereastra de modelare avansata pentru a bloca axa.
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4. Ring Select: Faceti clic pe buton, setati intervalul, selectati un obiect si vor fi selectate liniile
corespunzatoare.

5.Loop Select: Faceti clic pe I buton, setati intervalul, selectati un obiect si vor fi selectate liniile
corespunzatoare.

Pvd R . .
6. Target Select: Faceti clic pe buton, tineti apasat butonul din stanga si treceti cursorul peste puncte pentru a
le selecta.

7. Borders: Faceti clic pe EER buton, selectati un obiect, faceti clic dreapta pentru a selecta puncte, linii, poligoane

si varfuri UV pe inelul cel mai exterior al invelisului UV.

7.3 Panou de afisare

7.3.1 Backface Cull

Comanda Backface Cull determind daca fetele din spate ale planurilor poligonale sunt eliminate si nu sunt afisate.

e ame
i i

Selectati"Material Tab > Display Panel > =8 Backface Cull" pentru a aplica aceasta functie. Directia Tn care se

confrunta poligonul normal determina daca este afisat atunci cand Backface Cull este activat.

Poligoanele care sunt orientate in altd parte fata de fereastra de vizualizare sau poligoanele care se afla in
interiorul unui obiect si cu fata catre fereastra de vizualizare nu sunt afisate, daca faceti din nou clic pe caracteristica

Backface Cull, acestea pot fi afisate din nou.
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8 Meniul scenei

n procesul de planificare si proiectare a unui proiect, aspectul scenei este deosebit de important. Reflect3 stilul
si efectul de design al planului final si, de asemenea, reflecta capacitatea de peisaj si estetica designerului. Acest
capitol vorbeste despre crearea de drumuri si entitati de santier, aranjarea entitatilor de fundal si inserarea
elementelor de animatie scheletice, astfel incat utilizatorul sa poata utiliza Tn mod flexibil functiile atunci cand

aranjeaza scena si sa faca proiectul sa prezinte un efect delicat si realist.

8.1 Drum

8.1.1 Drum Urban

Drumurile urbane sunt principalele cai de circulatie Tn oras sau in afara cartierelor rezidentiale. Houseplan 1.0
ofera sabloane pentru

Page 216 of 241



Houseplan 1.0 Make stunning 3D scheme with speed and ease

urban roads to facilitate quick drawing . Select "Scene Tab > Road Panel > |I!I] Urban Road" to open the following dialog box.

Urban Road >

One-dane Twodane Threedane Fourdane

Sidewalk: 2.0000

Lane: 8.0000 White singleline ~  Dotted line

Sidewalk: 2.0000

Total width: 112.0000

Confirm Cancel

1. Draw urban roads: Selectati tipul de banda si setati parametrii in caseta de dialog, faceti clic pe butonul
»,Confirmare”, apoi desenati direct Tn punctul specificat in scendMATERIAL Poate fi desenat continuu;
introduceti ,U” pentru a reveni la pasul anterior si faceti clic dreapta pentru a incheia desenul.

2. Line to RoadIimportati sau desenati entitatea linie reprezentand drumul in scena, selectati tipul de banda si
setati parametrii in caseta de dialog, faceti clic pe butonul ,,Confirmare”, introduceti C in linia de comanda,
selectati linia si faceti clic dreapta pentru a finaliza. Entitatea de linie selectata va fi convertita intr-un drum
urban.

3. Parameter Description: in caseta de dialog, comutati pagina Fild pentru a selecta tipul de band3 (de exemplu,
,drumuri cu doua benzi”), setati latimea trotuarului, latimea benzii, I3timea de separare si alti parametri.
,Litimea totald” se calculeazd automat in functie de Iitimea trotuarului etc. Tn partea dreapts, verificati
trotuarul care urmeaza sa fie afisat si setati culoarea, liniile simple si duble si stilul de linie intrerupta a
trotuarului. Daca doriti sa setati o latime diferita, puteti modifica separat valoarea de mai jos.

Note:

@Cénd desenati un drum curbat, ,arc tangent” inseamna ca sectiunea drumului cu arc este tangenta la

sectiunea anterioara a drumului, ,,arc convex” inseamna ca capetele drumului cu arc sunt desenate
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inainte de a specifica raza lor si , trei- arc de punct” Tnseamna al doilea si al treilea punct al arcului in
secventd pentru a genera drumul arcului.

@Cénd un drum este desenat cu un punct de cotiturd, se ofera un interval de raza a arcului pe baza
unghiului dintre doua drumuri, raza implicita a arcului fiind latimea drumului.

@Cénd drumurile care sunt desenate si transformate din linii se incruciseaza, suprafata drumului si
trotuarul si alte componente sunt fuzionate automat. Cand segmente de drum sunt mutate sau sterse,
drumul cu care au fost fuzionate initial se ocupa, de asemenea, automat de granitele.

@ Pentru drumurile care sunt desenate si convertite din linii, acestea sunt formate din sectiuni individuale
si colturi de drum, necesitand selectarea tuturor sectiunilor pentru miscarea generala.

@Pentru drumurile care sunt desenate si convertite din linii, dupa ce ati selectat o sectiune de drum,
trageti punctul de mijloc pentru a muta sectiunea de drum si trageti punctele de inceput si de sfarsit
pentru a schimba pozitia capetelor acestora. Tragerea se va fixa la indltimea punctului tintd, de
exemplu, daca drumul are o cota de Tnceput de 10, daca pornirea este trasa in planul 0, cota de inceput
se va schimba si ea la 0.

@Fillet: Se referd la coltul curbat ascutit al suprafetei drumului generat intre drumurile care se
intersecteaza. Coltul este selectat si raza acestuia poate fi modificata setandu-I in paleta de proprietati
sau tragand si plasand punctul de editare

@. n coloana de proprietate:

O Faceti clic pe tip pentru a comuta la alt tip de drum. La trecerea inapoi la drumurile urbane, ldtimea
trotuarului trebuie setata manual.
O Latimea si suprafata exclud trotuarele.

O Este posibila modificarea cotelor de finceput si de sfarsit pentru a da drumului o forma
tridimensionala.

O Plasticitatea afecteaza dimensiunea plasei triunghiulare calculatd in interiorul drumului. Cu cat
valoarea este mai mica, cu atat randarea drumului va fi mai detaliatd, dar si performanta va fi mult
redusa. O valoare adecvata de plasticitate poate fi setata dupa caz.

8.1.2 Residential Street

Drumurile rezidentiale se refera la principalele drumuri de acces intr-o zona dominata de cladiri rezidentiale, iar
aceasta functie este utilizata pentru a cartografi sau genera rapid drumuri rezidentiale prin transformarea liniilor.
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Selectati " Scene Tab > Road Panel >|nl Residential Street" pentru a desena un drum sau a converti drumul
conform promptului liniei de comanda.

1. Draw residential roads: Puteti desena un drum curbat conform liniei de comanda: introduceti ,,A” pentru a
desena ca ,arc tangent”, introduceti ,,B” pentru a desena ca ,,arc convex”, introduceti ,C” pentru a desena ca
»arcin trei puncte”. Poate fi desenat continuu; introduceti ,U” pentru a reveni la pasul anterior si faceti clic
dreapta pentru a incheia desenul.

2. Line to Road: Importa sau deseneaza entitatea linie reprezentand drumul in scena, selecteaza tipul de banda
si seteaza parametrii in caseta de dialog, apasa butonul ,Confirmare”, introduceti C in linia de comand3,
selectati linia si faceti clic dreapta pentru a finaliza. Entitatea de linie selectata va fi convertita intr-o strada
rezidentiala.

Note: aleta de proprietati va permite sa modificati informatii despre parametri precum tipul, latimea, cota

punctului de pornire, cota punctului final, Iatimea bordurului, lungimea, suprafata, modelarea etc.

8.1.3 Editati drumul

8.1.3.1 Colt rotunijit

Genereaza sectiuni rotunjite ale ambelor drumuri. Selectati "Scene Tab > Road Panel > I 2 I Edit Road >
Rounded Corner", conform solicitarilor din linia de comanda, selectati doua sectiuni de drum si specificati sau

introduceti raza de viraj. Puteti conecta doua sectiuni de drum pentru a genera colturi rotunjite.

iz oo

S

K .8

Before After

Note:

@ Nu se pot rotunji colturile pe sectiuni paralele.
@ Raza maxima de viraj este calculata automat pe baza unghiului dintre cele doua drumuri, iar raza implicita

este generata de latimea drumului.
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8.1.3.2 Extindeti drumul

Utilizeaza drumul o linie ca limita, astfel incat drumul selectat sa se extinda pana la granita. Selectati "Scene Tab >
Road Panel >

: 188!
Edit Road > Extend Road", in conformitate cu solicitarile liniei de comanda, mai intai selectati sectiunea de
drum sau linia care va fi folosita ca limita, apoi selectati sectiunea de drum care trebuie extinsa. Puteti extinde drumul

selectat pana la granita..

Note: Cand selectati o sectiune de extensie, cursorul trebuie sa indice la capat mai aproape de granita, altfel
extensia esueaza.

8.1.3.3 Fillet

Modifica raza de viraj a celor doua I I Edit Road > m Fillet",
drumuri de legatura. Selectati "Scene
Tab > Road Panel conform prompturilor
din linia de comanda, respectiv selectati
drumul pe cele doua margini drepte

conectate, introduceti sau utilizati

cursorul pentru a specifica raza arcului.
Note: Desenarea unui drum
necesita selectarea marginii drepte a drumului de pe aceeasi parte a doua sectiuni conectate si ca cele doua

sectiuni sa se imbine.
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8.2 Panoul de dotari

8.2.1 Zona de constructii

Suprafata cladirii se refera la zona care poate fi utilizata pentru planurile de constructie, aceasta caracteristica este
utilizata pentru a desena si a defini zona cladirii.

Selectati " Scene Tab > Facilities Panel > Building Area" Si exista doua modalitati de a o genera.

1. Deseneaza zona de constructie direct prin trasarea de polilinii..

2. Introdu D si apasa Enter pentru a selecta planul orizontal sau linia inchisa si pentru a o defini ca zona de
constructie.

8.2.2 Vegetatie

8.2.2.1 Bazin cu flori

Un bazin cu flori este o zona Tmprejmuita pentru cresterea florilor si plantarea copacilor, o structura mica
inconjurata de zidarie din caramida sau structura din beton pentru plantarea florilor sau arbustilor. Bazinul este
umplut cu sol de plantare si este prevdzut cu gauri de drenaj; inaltimea sa, Tn general, nu depaseste 600 de milimetri.

Aceasta caracteristica este folositd pentru a desena si a defini bazinele cu flori.

Selectati "Scene Tab > Facilities Panel > Greening >

1. Desenati direct bazinul de flori in acelasi mod ca un poligon.

Flower Pool" si exista trei modalitati de a-l genera.

2. Eintroduceti ,S” si apasati Enter pentru a desena bazinul de flori in acelasi mod in care este desenat un poligon
tridimensional.

3. Introduceti ,D” si apdsati Enter pentru a selecta planul sau linia inchisa si definiti-o ca bazin de flori.
Note: Paleta de proprietati din partea dreapta a ecranului va permite sa reglati parametrii pentru Tnaltimea si

[atimea laterala a jardinierului.

8.2.2.2 Gard viu

Gardul viu, cunoscut si sub numele de copac de perete sau spalier, un copac sau alta planta care creste prostrat
in pete de-a lungul unui perete sau spalier, se refera si la peretele sau spalierul de care este atasat un astfel de copac.

Aceastd functie este utilizatd pentru a desena si a defini garduri vii.

Selectati "Scene Tab > Facilities Panel > Greening > Ex%%3 Hedge", introduceti valori pentru a determina

latimea si respectiv inaltimea gardului viu, exista trei moduri de a genera.
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1. Desenati gard viu direct desenand polilinii.
2. Introduceti ,,D” si apasati Enter, selectati o linie si definiti-o ca gard viu.

3. Pentru a desena un gard viu de-a lungul unei linii, introduceti ,Y” si apasati Enter si urmati instructiunile liniei
de comanda pentru a o desena.

Note: Parametrii pentru Tnaltimea si latimea gardului viu pot fi ajustati in bara de proprietati din dreapta.

8.2.3 Ap3

Un volum de apa este unul dintre elementele recurente intr-un cadru peisaj. Aceasta functie este utilizata pentru

a desena si a defini o suprafata de apa sau o piscina.
Select "Scene Tab > Facilities Panel > Water" to open the dialog box shown below.

Draw Water Bodies

© Map reflection " Real time reflection
Water surface color: - 39,77,122

specular Color: [l 120,120,120

Smoothness: 255 i |
Specular level: 0.1 -§~ [ |
S atey Reflection intensity: 6 2 |
Fresneloffset: 0.4 |34 [ |
Fresnel index: 4 HH [ |
Ocean Water speed: 0.5 = -1
Water ripple ratio: 0.5 :: B

Ripple height: 0.0000 |

Opadty: 0.25 |-+ a

1. Drawing water surface: click on the ="' button and there are three ways to generate it.

(1) Desenarea suprafetei apei in acelasi mod n care se deseneaza poligoane.
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(2) Introduceti ,,D”, apasati Enter si selectati planul orizontal, linia inchisa orizontala si definiti-o ca suprafata
de apa. Pentru a genera automat o suprafata de apa, introduceti ,Z” si apasati Enter, selectati entitatea
pe care doriti sa o generati automat suprafata apei si specificati-o direct sau introduceti valoarea inaltimii
pentru a o introduce.

Note:

@ Generarea automata este in general utilizatd pentru a genera suprafete de apd in zonele joase ale
terenului.

@ Entitatile care sustin generarea automata a suprafetei de apa sunt terenul, avioanele si drumurile.
2. Desenati piscine: Consultati ,Desenati suprafata apei” pentru mai multe detalii.

3. Vopsea: Click pe £ buton, selectati tipul de volum de apa din caseta de dialog (apa limpede, iaz, lac, apa
plata si mare), puteti picta la volumul de ap3, avion sau orice altd entitate. Faceti clic dreapta in scend, puteti,
de asemenea, sa desenati materialul pentru volumul de ap3, sa pictati la volumul de apa etc.

Descrierea parametrului::

1. Reflectarea hartii: reflexiile apei conform unei harti prestabilite.

2. Real time reflection: Reflectiile suprafetei apei in conformitate cu mediul real.

3. Water surface color: Seteaza culoarea apei.

4. Specular color: Adaugati o harta speculara la suprafata apei.

5. Smoothness: Controleaza gradul de netezime al materialului atunci cand este expus la lumina.

6. Specular level: Controleaza nivelul de luminozitate speculara.

7. Reflection intensity: Marimea efectului de reflexie; cu cat valoarea este mai mare, cu atat efectul de reflexie
este mai puternic.

8. Fresnel offset: reflectanta suprafetei care se confrunta direct cu privitorul (sau lumina incidenta); aceasta
valoare este mai mica pentru materialele apoase.

9. Fresnel index: Dezintegrarea curbei Fresnel.

10. Water speed: Rata cu care curge apa.

11. Water ripple ratio: Controleaza proportia ondulatiei de apa, cu cat valoarea este mai mare, cu atat este mai
densa ondulatia apei.

v A v

12. Ripple height: Seteaza inaltimea de ondulare a suprafetei apei.

13. Opacity: Seteaza opacitatea suprafetei apei.
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8.2.4 Pasi

8.2.4.1 Scari de-a lungul liniilor

Pasii de-a lungul liniei sunt pasi care sunt generati de-a lungul contururilor existente. Aceasta functie este

folosita pentru a defini pasii. Selectati "Scene Tab > Facilities Panel > Steps > Stairs Along Lines", mai intai
introduceti valoarea pentru a determina numarul de pasi si latimea planului superior al pasilor, apoi setati daca sa
generati pasi la ambele capete, selectati o linie sau un punct pe marginea entitatii, specificati direct sau introduceti
o valoare pentru a determina lungimea pasului; daca doriti sa inchideti pasii de-a lungul marginii entitatii,
introduceti ,C” si apasati Enter.

Note: Latimea planului superior al treptelor este latimea treptei de sus.

8.2.4.2 cari cu pozitie fixa

Pasii in loc sunt pasi generati personalizati pe baza unui schita existent. Aceasta functie este folosita pentru a
defini pasii. Selectati "Scene

Tab > Facilities Panel > Steps >| Fixed Position Stairs", selectati partea planului pentru a genera pasi si
introduceti valoarea pentru a determina numarul de pasi care trebuie generati.

Note:

@ Muchiile unui plan care genereaza un pas pot fi muchii multiple.

@ Cand distanta fata de cladire este mai mica de 0,2 m, ,Pasul in loc” este asociat automat cu cladirea.

8.2.5 Gard

Un gard este din punct de vedere arhitectural o structura de despartire spatiala puternic rectilinie, utilizata pentru

a inchide, a imparti sau a proteja o zona, ingloband Tn general peretele unui volum de cladire. Selectati "Scene Tab >

L
Facilities Panel > - Fence".
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1. Bounding wall
Bounding wall

(1) Faceti clic pe 12|

buton entru a ’
P Bounding wall Gate

desena gardul intr-o

polilinie directa.

(2) Faceti clic pe

Bounding wall02

buton pentru a selecta

o linie ca gard.

W!HHWUH\HHIWH’

(3) Selectati tipul de gard

si faceti clic 8 buton

Bounding wall03 Bounding wall04

pentru a selecta si Wall height: [ 2.0000

schimba tipul de gard.

(4) Fence Height: Faceti clic pe sageata derulantd sau introduceti o valoare direct pentru a modifica

indltimea gardului.

2. Gate: Comuta la fila Poarta, doar faceti dublu clic sau trageti tipul de poarta selectat si plasati-l in scena.
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Bounding wall

Bounding wall Gate

LR T

Entrance door01 Entrance door02
Entrance door03 Entrance door04

8.3 Panoul de mediu

8.3.1 Label

Porneste/opreste etichetele particulelor si luminilor pentru o selectie usoara a particulelor, entitatilor luminoase.
Selectati "Scene Tab > Environment

Panel > | Label" pentru a opri/dezactiva etichetele particulelor si entitétilor luminoase. Inchideti fila cdnd publicati

efecte si inregistrati videoclipuri in roaming pentru a evita afectarea efectului.

8.3.2 Particle Entity

Adauga fantani dinamice, fum, vapori si alte entitati de particule la scena pentru a finaliza efectul scenariului.
Selectati "Scene

Tab > Environment Panel > n Particle Entity".
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Particle Entity
=
Fountain - ‘;ﬁ.;’ .
Smoke b, Bl
Spray y
Water Vapor Defoliation 01 Defoliation 02

Defoliation 03

1. Plasati entitate: faceti dublu clic pe o entitate de particule din galerie sau trageti-o direct pe spatiul de lucru.
2. To edit an entity library: Faceti clic dreapta pe lista de categorii de entitati:

(1) New: Creeaza o noua categorie de entitate de particule.

(2) Delete: Sterge entitatea particule nou creata.

(3) Clear: Elimina toate entitatile de particule nou addugate din categoria selectata.

(4) Edit: Redenumeste categoria de entitate de particule nou creata.

3. Add: Faceti clic dreapta pe un spatiu liber din fereastra bibliotecii, faceti clic pe ,,Addugati” si selectati entitatea
de particule in spatiul de lucru pentru a o adauga.

4. Delete: Faceti clic dreapta pe miniatura si faceti clic pe ,Stergeti” pentru a sterge entitatea de particule
adaugata.

5. Descrierea parametrului:
(1) Particle amount: Cu cat valoarea parametrului este mai mare, cu atat numarul si densitatea sunt mai mari.

(2) Particle lifetime: In timp ce particula exista, cu cat valoarea este mai mare, cu atat densitatea particulelor

este mai mica si cu atat particula exista mai mult.
(3) Initial speed: Cu cat valoarea este mai mare, cu atat viteza este mai mare.

(4) Acceleration: Exista trei valori reprezentand viteza lui xyz n trei directii, cu cat valoarea este mai mare, cu
atat viteza este mai rapida, de exemplu: cu o viteza pe axa x de 5 si 0 viteza pe axa z pe axa y de 0, particula

este deviata in directia axei x.
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(5) Initial scale: Se refera la dimensiunea particulei de la inceput, cu cat valoarea este mai mare, cu atat este
mai mare particula.

(6) Final scale: Marimea la sfarsitul vietii particulelor.

8.3.3 Light Entity

Adaugati spoturi, reflectoare si alte entitati de iluminare in scena pentru a finaliza efectul. Selectati "Scene Tab >

Environment Panel > Light Entity" pentru a deschide caseta de dialog prezentata mai jos.

Floodlight
Spotlight
+
Floodlights 01 Lawn Light 01
\ 4

1. Place entity: Faceti dublu clic pe o entitate luminoasa din galerie sau trageti-o direct pe spatiul de lucru.
2. To edit an entity library: Faceti clic dreapta pe lista de categorii de entitati:

(1) New: Creeaza o noua categorie de entitati luminoase.

(2) Delete: Sterge entitatea luminoasa nou creata.

(3) Clear: Elimina toate entitatile luminoase nou adaugate din categoria selectata.

(4) Edit: Redenumeste categoria de entitati luminoase nou creata.

3. Add: Faceti clic dreapta pe un spatiu liber din fereastra bibliotecii, faceti clic pe ,,Addugati” si selectati entitatea
luminoasa din spatiul de lucru pentru a o adduga.

4. Delete: Faceti clic dreapta pe miniatura si faceti clic pe ,Stergeti” pentru a sterge entitatea luminoasa addugata.
5. Descrierea parametrilor reflectoarelor:
(1) Activation: Faceti dublu clic pentru a activa sau dezactiva.

(2) Radius: Dimensiunea intervalului de lumina.
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(3) Direction: Directia luminii.
(4) Light cone: Cu cat valoarea este mai mare, cu atat este mai mare gama de radiatii luminoase.

(5) Attenuation: Cu cat valoarea este mai mare, cu atat bricheta este concentrata.
(6) Light intensity: Cu cat valoarea este mai mare, cu atat lumina este mai stralucitoare.

(7) Specular intensity: Cu cat valoarea este mai mare, cu atat evidentierea este mai puternica.
6. Descrierea parametrilor proiectoarelor:

(1) Activation: Faceti dublu clic pentru a activa sau dezactiva.

(2) Radius: Dimensiunea intervalului de lumina.

(3) Light intensity: Cu cat valoarea este mai mare, cu atat lumina este mai stralucitoare.

(4) Specular intensity: Cu cat valoarea este mai mare, cu atat evidentierea este mai puternica.

7. Nu exista efect de iluminare in timpul zilei, iar luminile se aprind automat noaptea.

8.3.4 Scene Entity

Adauga diferite tipuri de componente ca design exterior. Selectati "Scene Tab > Environment Panel > Scene

Entity" pentru a deschide caseta de dialog prezentata mai jos.

Amusement facilities

Bench

Bilboard ﬁ ¥ +
Bridge (4

Canopy Amusement facilities Amusement facilities Amusement facilities
Communal fadilities

Corridor frames

Featured landscape
Glass volume
Pavilion

Person

Public building Amusement fadilities Amusement facilities Amusement fadilities
Residence

Sports field

Street lamp
Transportation fadlities
Vehide

Spacing: 10.0000  Setback: 0.0000 ¢ Ol

ik

1. Place entity.

(1) Plasare directa: faceti dublu clic pe un model din galerie sau trageti-l direct pe spatiul de lucru.
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9
(2) Asezati de-a lungul liniei: Selecteazd modelul, faceti clic *s= buton si plasati entitatile la distant3 egald

intre punctele de inceput si de sfarsit specificate.

(3) Asezati de-a lungul obiectului: Selecteaza modelul, faceti clic = buton. Daca selectati un drum, puteti
aranja de-a lungul drumului; daca selectati volumul de apa, trebuie sa selectati un punct ca punct de

plecare al aranjamentului entitatii pe care sa il plasati de-a lungul volumului de apa.
(4) Select Layout: Selecteazi modelul si d3 clic == buton s plaseze entititile de-a lungul drumului in trei
modauri.

@® Introduceti ,,C” si selectati ,,Drum urban” pentru plasarea la distanta egala a entitatilor.

|”

@ Introduceti ,Q” si selectati ,,Drum rezidential” pentru plasarea la distantd egala a entitatilor.

|II

® Introduceti,Z” pentru a selecta simultan atat ,Drum urban” si ,,Drum rezidentia
entitati cu distanta egala.

si pentru a plasa

Note:

@ Previzualizarile care apar cu gri in galerie se vor descadrca automat daca dati clic. Ele pot fi plasate in

scena atunci cand sunt descarcate.

@ Distanta marginala se refera la distanta orizontald a punctului de pornire al aranjamentului de la

inceputul drumului sau a volumului de apa. Dupa cum se arata in figura de mai jos.

Margin di ance

2. Pentru a edita o biblioteca de entitati: Faceti clic dreapta pe lista de categorii de entitati:
(1) New: Creeaza o noud categorie de model.
(2) Delete: Sterge modelul nou creat.
(3) Clear: Elimina toate modelele nou addugate din categoria selectata.

(4) Edit: Redenumeste categoria de model nou creata.
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3. Adding objects: Faceti clic dreapta pe un spatiu liber din fereastra bibliotecii, faceti clic pe ,Adaugati obiect” si

selectati un model n spatiul de lucru pentru a-I

(Z)flower.cpi

ada uga. flower.fbx
pool.fbx

4. Add File: Faceti clic dreapta pe spatiul liber din @ stone.cpi

stone.fbx
fereastra bibliotecii si faceti clic pe , Adaugati

File name: [ vl File (*.cpi;*.fbx) v

fisier”, va aparea urmatoarea caseta de dialog.

Dupa ce ati selectat fisierul cpi sau fbx, faceti clic
pe butonul ,Deschidere” pentru a adauga fisierul

selectat.

5. Delete model: Faceti clic dreapta pe miniatura si faceti clic pe ,Sterge” pentru a sterge modelul nou addugat.

8.3.5 Vegetation Entity

Adauga entitati de vegetatie la scend pentru a o rafina. Selectati "Scene Tab > Environment Panel >

Vegetation Entity" pentru a deschide caseta de dialog prezentata mai jos.

Vegetaion Entity

/
Flower

Shrub +

Tree

-

Aquatic plants 01 Aquatic plants 02 Grass 01
i
Iris 01 Iris 02 Iris 03
.
Lotus 01 Lotus 02 Lotus 03
Spacing: 10.0000  Setback: 0.0000 f,. i3 ==

1. Place entity.

(1) Plasare directa: faceti dublu clic pe un model din galerie sau trageti-l direct pe spatiul de lucru.
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0
(2) Asezati de-a lungul liniei: Selectati modelul, faceti clic == buton si plasati entitatile |a distant egali intre

punctele de inceput si de sfarsit specificate.

(3) Asezati de-a lungul obiectului: Selectati modelul, faceti clic = buton. Daca selectati un drum, puteti
aranja de-a lungul drumului; daca selectati volumul de apa, trebuie sa selectati un punct ca punct de

plecare al aranjamentului entitatii pe care sa il plasati de-a lungul volumului de apa.

o

(4) Select LayoutSelectati modelul si faceti clic == buton sa plaseze entitatile de-a lungul drumului in trei

moduri.

4

@® Introduceti ,,C” si selectati ,,Drum urban” pentru plasarea la distanta egala a entitatilor.
@ Introduceti ,Q” si selectati ,,Drum rezidential” pentru plasarea la distantd egala a entitatilor.
|Il

(® Introduceti,Z” pentru a selecta simultan atat ,Drum urban” si ,Drum rezidential” si pentru a plasa

entitati cu distanta egala.

Note:

@ Previzualizarile care apar cu gri in galerie se vor descdrca automat daca dati clic. Ele pot fi plasate

n scena atunci cand sunt descarcate.

@ Distanta marginald se referd la distanta orizontald a punctului de pornire al aranjamentului de la
inceputul drumului sau volumul de apa.

2. Pentru a edita o biblioteca de entitati: Faceti clic dreapta pe lista de biblioteci de entitati:
(1) New: Creeaza o noua categorie de model.
(2) Delete: Sterge modelul nou creat.
(3) Clear: Elimina toate modelele nou adaugate din categoria selectata.
(4) Edit: Redenumeste categoria de model nou creata.

3. Add object: Faceti clic dreapta pe un spatiu liber
din fereastra bibliotecii, faceti clic pe ,Adadugati " —
obiect” si selectati un model in spatiul de lucru B poolbx
pentru a adauga.

) flower.cpi

() stone.cpi

4. Add File: Faceti clic dreapta pe spatiul liber din ke stone.fox

File name:l v | File (*.cpi™fbx)

fereastra bibliotecii si faceti clic pe ,Adaugati

I Open | Cancel

fisier”, va aparea urmatoarea caseta de dialog.
Dupa ce ati selectat fisierul cpi sau fbx, faceti clic

pe butonul ,,Deschidere” pentru a adduga fisierul selectat.
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5. Stergeti modelul: faceti clic dreapta pe miniatura si faceti clic pe , Stergeti” pentru a sterge modelul nou adaugat.

8.3.6 Environment

Aplica efecte de vreme, iluminare si ceata in mediu. Selectati ,Fila Scena> Panoul Mediu> Mediu ".

Weather
P
Sunrise Sunset Snow Rain Night
- Lighting
+ Effect parameter
+ Night vision settings

1. Weather: Faceti dublu clic pe o imagine a vremii pentru a aplica efectele vremii corespunzatoare.

2. lluminare: Faceti c

lic pe ,iluminare” si caseta de dialog va ardta dupa cum urmeaza.

(1) Show shadows: Bifati ,,afisati umbre” si ,afisati efecte de umbra

Weather
Clear sky ?unrise Sunset Snow Rain Night
B Cafing |
Lighting
[CJ shadow
Direction: -53 |
Height: 36 i
+ Efed parameter
+ Night vision settings
a” In scena.

(2) Introduceti o valoare in caseta de text sau trageti glisorul pentru a ajusta parametrii azimutului si

unghiului de altitudine ai soarelui. Cand umbrele sunt activate, ajustarea azimutului si al altitudinii va

afecta efectul umbrelor.
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3. Parametrii efectului: Faceti clic pe ,Parametrii efectului” si caseta de dialog va arata astfel:

Weather
: I ! !
Clear sky _Sunrise Sunset Snow Rain Night
+ Lighting
= Effect parameter
Type Parameter
= Sun
Sun Color D 251,235,205
Sunshine Color |:| 235,193,156
Intensity 1.301890
=] Environment
Environment Color D 149,177,219
Intensity 1.404080
Light-blocking int... 0.500000
Radius of light blo... 1.000000
=] Fog Effect
Color 103,163,216
+ Night vision settings

Solar, ambiental, efectul de ceata, lumina volumetrica si parametrii HDR pot fi modificati separat pentru a

imbunatati efectul ambiental.

(1) Sun

@ Sun Color: Culoarea soarelui, care poate fi desenatd direct din panoul de culori.

® Sunshine Color: Culoare sunshine, care poate fi desenata direct din panoul de culori.

®

Intensity: Intensitatea razelor solare pe sol (valoare mai mare, intensitate mai puternica).
(2) Environment

@® Environment Color: Mediul si culoarea obiectelor din mediu

@
®

Intensity: Intensitatea culorii (valoare mai mare, intensitate mai puternica).

Light-blocking intensity: Intensitatea umbrei la unghiul dintre obiecte (valoare mai mare,

intensitate mai puternica.

Radius of light blocking: Dimensiunea zonei de umbra la unghiul dintre obiecte (valoare mai mare,

zond mai mare).
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(3) Efect de ceata

©)
@
®

Color: Aplica culoarea de ceata.
Intensity: Densitatea cetii in partea de cer (valoare mai mare, ceatd mai densa).

Density: Densitatea cetii generale (mai mare este valoarea, mai densa este ceata).

(4) Lumina volumetricac

©)
@

®

(5) HDR

©)

4. Night vision settings: Faceti clic pe ,Setari de vedere nocturna

Color: Culoarea luminii volumetrice.

Weight: Proportia de culoare a luminii de volum. Cand greutatea este 0, culoarea luminii
volumetrice va fi afisata complet, cu cat valoarea greutatii este mai mare, cu atat proportia culorii

setarii volumului luminii este mai mica.
Intensity: ontroleaza haloul si lumina soarelui, cu cat valoarea este mai mare, cu atat haloul si
lumina sunt mai puternice.

Attenuation: Controleaza intensitatea luminii solare care ajunge la sol; cu cat valoarea este mai
micd, cu atat lumina ajunge la pamant mai puternica.

HDR: Interval dinamic ridicat.

20

si caseta de dialog va arata astfel:

Weather

J—

Clear sky Sunrise Sunset Snow Rain Night
+ Lighting
+ Effect parameter
- Night vision settings

Night vision settings

Light up type: @ Enclosed Balcony Glass Door
Glass Window Light Strip
Lightingrate: 4 7 [ |

0 02 0.4 0.6 0.8 1

Brightness: 40 : | ]
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Categoria de iluminare, rata de iluminare si luminozitatea pot fi modificate separat pentru a regla efectul de
iluminare Tn modul de noapte.

(1) Light up type: Controleazd starea de iluminare a categoriei corespunzatoare din scena.
(2) Lighting rate: Controleaza numarul de entitati aprinse in scend. Cu cat este mai mare valoarea ratei de
iluminare, cu atat sunt aprinse mai multe entitati si invers.

(3) Brightness: Afecteaza doar luminozitatea materialului solid aprins.

8.3.7 Optimizare

Seteaza anti-aliasing, echilibru Anti aliasing: 1 i 43
vizual si segmente de arc pentru a Visual balance: 1 i 10 5.00
. VT . Arc segment: 1 i 10 5.00
ajusta efectele entitatii in spatiul de
{{-—"}} , Apply Reset
lucru. W L

Valorile mai mari nu sunt neaparat mai
bune. Selectati "Scenes Tab >
Environment Panel > Optimization".

1. Anti-aliasing

indeparteazd afisajul zimtat si aliasing-ul pentru a face vizualizarea mai neted3 si mai frumoas3. Setati valoarea
anti-aliasing si faceti clic pe ,Aplicare”. Butonul Anti-aliasing din coltul din dreapta jos poate activa sau dezactiva si
acest efect, asa cum se arata mai jos:

Light Projection

Isometric | Perspective | Shadow | Anti-Aliasing

2. Echilibrul vizuall

Simplifica detaliile de suprafata ale entitatilor pentru a reduce complexitatea geometrica a unei scene,
fara a afecta efectele vizuale. Setati o valoare pentru a creste performanta scenei fara a pierde detalii grafice
vizibile. Trageti glisorul sau introduceti o valoare pentru a modifica distanta de afisare LOD. Entitatile mai
indepartate vor fi afisate in modele mai simple sau nu vor fi redate deloc; entitatile apropiate de punctul de
vedere vor fi afisate Tn modele detaliate.

Note: in timpul desenirii, dac3 desenele importate nu sunt vizibile, este posibil ca desenul importat s3 fie

prea mare si punctul de vedere sa fie prea indepartat. Mariti valoarea LOD si desenul ar trebui sa fie afisat

normal.
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3. Segmente de arc

Seteaza efectul de afisare al arcelor si al planurilor curbe. Trageti glisorul sau introduceti o valoare direct pentru a
ajusta numarul de segmente. Cu cat valoarea este mai mica, cu atdt mai putine segmente si randarea este mai
eficientd; cu cat valoarea este mai mare, cu atat efectul arcului este mai detaliat, dar performanta va fi mai mica.

Nota: Segmentele de arc afecteaza urmatoarele entitati:

@ Linie: sferd, arc, elipsd, arc eliptic..

® Muchia: marginea planurilor si volumelor care contin sferd, arc, elipsa sau arc eliptic.

® Curved plane: Entitate plan curbat individual sau plan curbat pe volume. Cu alte cuvinte, toate avioanele

neplate sunt afectate.

8.4 Panoul de animatie

8.4.1 Animatie scheletica

Adauga obiecte animate la scend pentru a adauga efecte de animatie. Selectati "Scene > Animation Panel > EE

Skeletal Animation" pentru a deschide urmatoarea caseta de dialog.

Skeletal Animation

Bird

Butterfly

Fish &
Person

Bird 01 Bird 02 Bird 03
Bird 04 Bird 05
Velodty: 7.00 mfs ~ Height: 10.0000 m

1. Aplicati entitatea animata:
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(1) Selectati entitatea animata, setati viteza de miscare si naltimea
de inserare; (2) Faceti dublu clic pe modelul de entitate animata sau
trageti-l in scena pentru a-l insera.

2. Editati biblioteca de entitdti de
animatie:

. . . Skeletal Animation X
Cand faceti clic dreapta pe lista de
Bird
g "R .. . . Butterfl
entitati ale bibliotecii de animatie: B Y
Person
< <
(1)  New: Creeazd o noud AU e
Delete
categorie de entitati de animatie Clear
Edit
scheletica; Import
(2)  Delete: Sterge categoria
de animatie schelet nou creat3;
(3) Empty: Goleste toate
entltatlle de animatie schelet Velocity: | 0.00 ‘ m/s v | Height: IOOT m

nou adaugate in categoria de
animatie schelet selectata;
(4) Edit: Redenumeste categoria de schelet nou creat3;
(5) Import: Selecteaza folderul si importa fisierul fbx in folder.
3. Adaugd modele:
(1) Add file: Faceti clic dreapta pe spatiul liber din partea dreapta a ferestrei, faceti clic pe ,,Adaugati fisier”,
apoi selectati fisierul fbx Tn caseta de dialog pop-up.

(2) Delete: Faceti clic dreapta pe model si faceti clic pe ,Sterge” pentru a sterge modelul nou addugat.

8.4.2 Play Animation

Reda animatia sau opreste redarea animatiei conform caii stabilite. Selectati "Scene Tab > Animation Panel >
Play Animation" pentru a incepe sau opri redarea filmului.

8.4.3 Calea ondulata

Adauga trasee ondulate la entitatile animate, generate la desen pe baza Tnaltimii punctului specificat. Selectati

) n . . . v . . . .
"Scene Tab > Animation Panel > Wavy Path", selectati entitatea animata si desenati calea ondulatiei.
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Note:

@ Daca nu existd un punct de control pentru fixarea in scena, calea desenata este o cale
orizontala si trebuie sa faceti clic pe comanda ,Editati calea” pentru a modifica punctul de control, consultati

,Editati calea” pentru operatia specifica.
®) Paleta de proprietati va permite sa ajustati parametri precum frecventa entitatii animate,
daca se misca, daca urmeaza calea, viteza traseului, dacd modul de miscare este unic sau circular si daca arunca

o umbra.

8.4.4 Edit Path

=g
Editeaza traseul de animatie desenat. Selectati "Scene Tab > Animation Panel > 4 B Edit Path” pentru a deschide
caseta de dialog prezentata mai jos.

1. Selectie: Click pe By buton pentru a selecta entitatea animata sau faceti clic pe numele entitatii animate din
partea stanga a casetei de dialog pentru a afisa calea si punctele de control din scena si punctele de control

si inaltimea din partea dreapta a casetei de dialog.

Edit Path X

2. Undulating Path: Click | putton to

draw undulating paths.
G o 4 X
3. Move: Click pe 4 puton si selectati Velodty:%_ mfs v
» g Person\Person | | Control point| Height || oMt
unctul de control de mutat.
p FB’ersorr;l\Ff\eBrsoni 1 point 0.0 100
“ 2point 0.0
4. Delete: Click pe ' buton pentru a 40 50
Delete animation 01
sterge punctul de control selectat. Clear path 0.0
- 0.0
o L 6 point 0.1 0 |
5. Faceti clic dreapta pe numele entitatii 7 pint 0.0
. . Ay . 8 point 0.0
animate din partea stanga a casetei de 5
dialog pentru a deschide meniul
contextual; — -100
\ 4

(1) Delete animation: Sterge entitatea
animata selectata si calea acesteia.
(2) Clear path: Elimind calea de animatie a entitatii selectate.

Note:

@ Nu este permisa stergerea sau mutarea primului punct de control.
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(@ Faceti dublu clic pe textul albastru ,indltime”, iar toate punctele de sub réndul selectat vor fi modificate

la valoarea indltimii randului selectat.

8.4.5 Sterge calea

Sterge calea de animatie definita. Selectati "Scene Tab > Animation Panel > BE83 Erase Path" si selectati entitatea

din care doriti sa stergeti calea animatiei.

8.4.6 Afiseaza Calea

r Rl
Afiseaza sau ascunde calea de animatie definita. Selectati "Scene Tab > Animation Panel > Show Pathpentru

a afisa sau a ascunde calea de animatie definita.
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9 Meniul Video

Pentru a facilita utilizatorilor sa experimenteze lumea reala a modelelor 3D, Houseplan 1.0 reda video HD bazat

pe calea mediului real pentru a arata efectul designului Tn mod dinamic in toate aspectele.

9.1 Path Panel

9.1.1 Desenati calea

Deseneaza calea de miscare in scend. Selectati "Video Tab > Path Panel > Draw Path" a trasa o cale in scena.

Note:

@ Desenul este capturat in trei dimensiuni.

(@ Dupa desenarea unei cdi, atunci cdnd o desenati din nou, continuati implicit pe ultima cale.

(® Daci doriti sa o redesenati, puteti sa faceti clic pe comanda ,Sterge calea” si sd o desenati din nou.
@ Daca trebuie salvata calea anterioard, salvati-o in ,Relectie video” inainte de a sterge calea.

(® Daca linia traseului trasat nu este salvata in ,Evidentieri video”, informatiile despre linia traseului nu vor

fi inregistrate, iar calea se va pierde cand fisierul este deschis din nou.

9.1.2 Grounded Path

Deseneaza cadi video care adera la sol in scend, permitand video-ului sa se ondulati automat cu solul in roaming.

D::N
Selectati "Video Tab > Path Panel > M| Grounded Path" a trasa o cale in sceni.

Note:

@ Solul include pamaéntul, terenul si drumurile.
(@ Cand existd o suprapunere a entitatilor terestre, calea cade pe entitatea superioara.
(® Cand cele doud cdi sunt desenate prin comutarea intre ele, calea desenatd este generata in

acelasi mod ca calea nou desenata.

9.1.3 Edit Path

Editeaza calea de roaming curenta. Selectati "Video Tab > Path Panel > E Edit Path" si va apdrea urmatoarea
caseta de dialog.
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G X & + Input points: | 2979.03,1027.74,0
Height
Control point| Camera height | Height Angle Azimuth Velocity |Angular Velocity oot
____-_
2 0.0000 Look Up Front View 10.0 50
3 0.8481 Overlook Front View 2.0 10.0
4 1.0108 Front View Front View 2.0 10.0 0.0
5 10.0000 Front View Front View 2.0 10.0 i
6 10.0000 Front View Front View 2.0 10.0
-50
-100

1. Parametrii punctului de control: Faceti clic pe un element din caseta de dialog pentru a-I modifica.

(1) Camera height: inltimea camerei atunci cand va deplasati in acel punct, fie introducand valoarea direct,
fie tragand glisorul din dreapta pentru ao modifica.

(2) Unghi de inaltime, azimut: Setati punctul de vedere orizontal si vertical atunci cand va deplasati, faceti
clic pe lista derulanta si selectati ,, Alege”, puteti utiliza punctul selectat din scena ca punct de vedere.
Dupa aceea, selectati punctul de control, puteti modifica coordonatele punctului din partea de sus a
,Introducere punct de vedere".

(3) Velocity: Viteza la care ruleaza roamingul.

(4) Angular velocity: Viteza la care se roteste camera, care trebuie marita pentru a se potrivi daca camera
merge prea repede.

(5) Blue Font: Selectati o valoare si faceti dublu clic pe fontul albastru de deasupra coloanei pentru a

schimba toate valorile de mai jos la aceeasi valoare ca articolul respectiv.

2. Click pe & buton pentru a muta punctul de control selectat si a permite capturarea.
3. Click pe X buton pentru a sterge punctul de control selectat.

4. Click pe ™" | buton pentru a muta orizontal punctul de control selectat fird a modifica inaltimea punctului de
control.

5. Click pe * buton pentru a adauga puncte de control la linia traseului.

Note: Caile impamantate nu accepta deplasarea.
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9.1.4 Sterge calea

Sterge calea de roaming desenata in prezent. Selectati "Video Tab> Path Panel > 2 Delete Path” pentru a goli

automat calea de roaming in scena.

9.2 Panoul video

9.2.1 Operatiune de roaming

Implementati efecte de roaming si generati videoclipuri in roaming. Selectati "Video Tab> Video Panel >

Roaming Operation" pentru a deschide urmatoarea caseta de dialog.

Roaming Operation

1. Click on the button to open the dialog box shown below.

(1) Faceti clic pe ,Parametri detaliati” pentru a deschide caseta de dialog ,Editare cale”, consultati
elementul ,Editare cale” pentru detalii.

(2) Selectati ,Parametri temporari” si
Path Roaming Settings

caseta de dialog va confirma astfel.
© Detailed parameters

Temporaty parameters

@ Moving speed: Introduceti viteza cu

L A Moving speed:  20.0 m/s
care se misca punctul de vedere in

Path height: | 1.8000 Meters
roaming.
View: Front View
@ Path height: Introduceti indltimea

Video size:  1920*1080 v
orizontalad a punctului de vedere in
Video quality:  High v

roaming.

® View: Selectati vizualizarea camerei,
care contine cinci optiuni: Front,

Overlook, Look up, Stanga si Dreapta.
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(3) Video Size: Seteaza dimensiunea videoclipului generat. Selectati ,Personalizat” in lista derulanta pentru

a deschide caseta de dialog prezentata mai jos.

Introduceti dimensiunile [atimii si inaltimii si

faceti clic pe butonul ,,0k” pentru a le adauga la

lista de dimensiuni video. Width: 1920
Note: Cu cat dimensiunea este mai mare, cu
Height: 1080
atat fisierul generat este mai mare. Avand in
vedere ca salvarea datelor pe hard disk ocupa [CLﬁrmJ Cancel

resurse de sistem si afecteaza procesul de
inregistrare, va rugam sa alegeti dimensiunea
potrivita in functie de performanta computerului dvs.

(4) Video quality: Seteaza calitatea video, inclusiv High,Medie si Scazuta. Dupa setarea parametrilor,
faceti clic pe butonul ,,Confirmare” pentru a roaming conform setarilor.

2. Faceti clic pe E[butonul pentru a incepe roamingul prin scena in functie de calea desenatd si parametrii
acesteia.

3. Faceti clic pe E[ butonul pentru a opri roamingul.

4. Faceti clic pe "™ butonul pentru a intrerupe roamingul si faceti clic din nou pentru a continua roamingul.

5. Faceti clic pe @ butonul, setati calea de salvare si numele fisierului, apoi Tncepeti roamingul si Tnregistrati

procesul de roaming ca *. mp4, *. mky, *. fisiere in format mov.

9.2.2 Roam Path List

Salveaza calea de roaming curenta sau aplica o cale de roam salvata. Selectati "Video Tab > Video Panel >

Roam Path List" pentru a deschide urmatoarea caseta de dialog.
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Roam Path List

Roam
Name Turning point Length

Path name: name1 save [ ramer | 6 | 2779 |

Rename
E E Delete item
0% 25% 50% 75%  100%
o Delete all
0.0%

1. Salvare cale: Introduceti numele caii si faceti clic pe butonul ,Salvare” pentru a salva calea desenata curenta.
2. Apply path: Faceti dublu clic pe linia in care se afla calea din caseta de dialog pentru a invoca calea.

3. Context menu: Faceti clic dreapta in lista pentru a deschide ,meniul contextual”, puteti sterge sau redenumi
calea.

4. Faceti clic pe x| butonul pentru a seta parametrii de roaming al cdi.

5. Faceti clic pe butonul pentru a incepe roamingul prin scena in functie de calea desenata si parametrii
acesteia.

6. Faceti clic pe E butonul pentru a opri roamingul.

7. Faceti clic pe " butonul pentru a intrerupe roamingul si faceti clic din nou pentru a continua roamingul.

8. Faceti clic pe butonul, setati calea de salvare si numele fisierului, apoi incepeti roamingul si inregistrati
procesul de roaming ca fisiere in format *.mp4, *.mkv, *.mov.

Note:
(D csile modificate necesit3 un clic pe ,Salvare” pentru a actualiza calea la cea mai recent.

@Cénd salvati o cale catre un set video, vremea ambientalad este, de asemenea, inregistrata in informatiile
despre cale.

9.3 Panoul de vizualizare a camerei

9.3.1 Lista de vizualizare a camerei

Salveaza punctele de vedere din scenariu pentru o pozitionare rapida. Selectati "Video Tab > Camera View Panel

Camera View List", va apdrea urmatoarea caseta de dialog.
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Introduceti numele punctului de vedere si faceti clic
Camera View List X
=
Name ‘ Camera position  Camera viewpoint View type
B 61,51,2 62,51,2 Perspective
B 2 64,28,-22 65,28,-21 Perspective
D 3 -3026,1184,418 -3025,1185,417 Perspective
D 4 7938,7969,6460 7938,7969,64961 Isometric
O 3166,5969,505 | 316e.c0e0 a0 | _Jsometric |
Rename(M)
Delete item(S)
Delete all(D)
=

button to save the current viewpoint to the list. Check the viewpoint and click
butonul pentru a exporta punctul de vedere la local Tn format imagine. Faceti clic dreapta pe numele punctului de

vedere pentru a deschide meniul contextual, care va permite sa redenumiti, sa stergeti si sa stergeti toate punctele de

vedere. De asemenea, puteti elimina toate punctele de vedere facand clic dreapta in spatiul liber al casetei de dialog.
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10 Altii

Houseplan 1.0 ofera cateva instrumente si comenzi rapide comune pentru a ajuta utilizatorii sa clasifice si sa

gestioneze entitatile Tn procesul de proiectare a solutiilor Tntr-un mod organizat si eficient.

10.1 Controlul clasei grafice
Graph Control >

Cand proiectati entitati sau elemente, puteti utiliza functia [ Close the selected dass ]

de control al stratului pentru gestionarea usoara a operatiunii. Close dasses other than selected

7 Turn off the selected layer
Clic

@ butonul pentru a deschide caseta de dialog prezentata
Turn off the selected outer layer

mai jos.
') All dasses open
Faceti clic pe fiecare articol pentru a inchide sau deschide Al dasses dosed
clasa, stratul si fundalul. De exemplu, faceti clic pe butonul Close underlay DWG

Open underlay DWG

Jinchide clasa selectatd” pentru a selecta entitatea care

urmeaza sa fie inchisa. De exemplu, daca selectati o cladire,
puteti opri volumul principal al cladirii si balconul si alte
componente. Notd: De asemenea, puteti sa faceti clic pe partea de sus a software-ului pentru a avea control asupra

straturilor de clasa de grafic, asa cum se arata in imaginea urmatoare.

/] building =2 ll:]'@ building bod) — |

@
@ Faceti clic pe caseta de selectare din fata unei clase sau in fata unui strat pentru a activa sau dezactiva o
singura clasa/straturi.

(]

(@ Faceti dublu clic pe caseta de selectare din fata categoriei pentru a inchide toate categoriile. Faceti dublu

clic din nou pe pentru a deschide toate categoriile.

() Clasele si straturile sunt legate. De exemplu, dacd inchideti clasa din stinga, stratul corespunzator din

dreapta se inchide cu ea.
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10.2 Faceti clic dreapta pe meniul
contextual

Last command(K)

Orbit(0)
Eye View(D)
Daca faceti clic dreapta pe spatiul de lucru, va aparea Ll
Frame Selection(G)
" Pan(P}
un meniu contextual cu urmatoarele comenzi; Ultima ® View Controll)
Previous View(l)
Front Face(F)

comanda, Orbita, Vedere ochi, Vizualizare completa,

Window View(W)

Polyline(V)
Selectie cadru, Panare, Control vizualizare, Vedere Rectanglepq

Polygon(N}
Box(B)

£
=
3
o
&
m]

anterioara, Fata frontald, Vedere fereastrda, Polilinie,

Building Extrusion(L)

General Extrude(T)

Dreptunghi, Poligon, Casetd, Extrudare cladire, Extrudare

@ mo

generald, Copiere, Mutare, Rotire, Stergere, Ascunde

[ Erase(f)

. Hide Selected(H)

selectat, Ascunde neselectat, Afiseaza. . Hide Unselected(s)

't Unhide(U)

Pentru mai multe detalii de operare, consultati

descrierea fiecdreia dintre aceste comenzi de mai sus n

acest ghid.

10.3 Ortogonala

Restrictioneaza operatiunea la orientare orizontala sau verticala.
- Orthogonal L M . . . M
1. Faceti clic pe butonul de sub linia de comanda pentru a activa/dezactiva functia ortogonala.

2. Faceti clic dreapta pe DAHOge butonul pentru a deschide meniul contextual, asa cum se arata mai jos.
(1) Conventional: Comuta la orientarea ortogonala normala.
v user orthogonal

(2) User Orthogonal: Comuta in directia ortogonald a .
’ conventional

utilizatorului. Exista trei moduri de acces.

@ Selectarea directa a marginilor solide, ca directii ortogonale.
@ Unghiurile pot fi introduse ca directii ortogonale, asa cum se solicita in linia de comanda.

® Introduceti ,D” pentru a specifica doua puncte si a trasa directia ortogonala, iar ,C” pentru a sterge
directia ortogonala definita si a reveni la starea implicita.

Note: Setati utilizatorul ortogonal, adicd re-desemnati directia semiaxei pozitive a axei X. in unele
desene de proiect, orientarea terenului, a drumurilor si a altor entitati nu este conforma cu directia
implicita a axei XY a sistemului, asa ca pentru comoditatea desenului, va puteti defini propria directie

ortogonala.
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10.4 Axa polara

Tn timpul desenérii si editarii, puteti activa axa polard pentru a obtine cu usurintd puncte de captur in directia axei
X, YsauZ.

10.5 Snap

Cand desenati sau editati, puteti activa functia de snapping pentru a ajuta operatia pentru o pozitionare precisa.

1. Faceti clic pe butonul de sub linia de comanda sau apasati tasta F3 pentru a activa sau dezactiva
snapping.

2. Faceti clic dreapta pe butonul pentru a deschide meniul contextual, asa cum se aratd mai jos.

setting '

Selectati optiunea
“ Snap Mode Setti

deschide caseta de

dialog prezentata mai Endpoint | Center of cirdle

jos. Midpoint Closest point

Puteti seta optiuni de | Intersection Plane
fixare, unde ,plan” se refera Perpendicular point

. Mouse pick box (0-50):  ©
la suprafata unui plan sau —

Mouse capture frame(2-20): 10

solid.
Cursor length (1-100): 6

Faceti clic pe butonul

,Selectati tot” pentru a bifa Select all Confirm Cancel

toate casetele; faceti clic pe

butonul »Confirmare”

pentru a aplica setarile.
Note: Cand va aliniati la centrul cercului unui arc, trebuie sa
treceti cursorul peste linia de margine pentru a afisa centrul

cercului.
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10.6 Follow
Afiseaza distantele si unghiurile la pozitia de indreptare a mouse-ului atunci cand desenati si editati
obiecte. Faceti clic pe butonul din partea de jos a liniei de comanda pentru a activa/dezactiva functia de

urmarire. Unghiul afisat este unghiul cu semiaxa pozitiva a axei X.

10.7 Referinta

Cand desenati si editati obiecte, o linie temporara de extensie, o linie verticala sau o axa polara prin punctul
final al unei entitati, punctul de mijloc sau alte puncte de captare este afisata ca o linie intrerupta atunci cand

cursorul trece peste acel punct, astfel Tncat utilizatorul sa poata specifica un indicati la linia de prelungire sau

capturati intersectia mai multor linii de referinta. Clic butonul din partea de jos a liniei de comanda
pentru a activa/dezactiva functia de referinta. Referinta se bazeaza pe snapping si necesita ca snapping sa fie

activat pentru a o utiliza.

10.8 Isometric

Comutd mediul de proiectare In modul izometric. Faceti clic pe butonul Izometric din coltul din dreapta jos pentru

a activa functia si faceti clic din nou pentru a o dezactiva. Dupad cum se arata in figura de mai jos.

Anti-Aliasing | Light Projection

10.9 Perspectiva

Comuta mediul de proiectare la proiectia Tn perspectiva. Faceti clic pe butonul Perspectiva din coltul din dreapta

jos pentru a activa functia si faceti clic din nou pentru a o dezactiva. Dupa cum se arata n imaginea de mai jos.

Isometric l Perspective Anti-Aliasing | Light Projection

10.10 Shadow

Simuleaza efectul de umbrire al proiectului. Faceti clic pe butonul Umbra din coltul din dreapta jos pentru a activa
functia si faceti clic din nou pentru a o dezactiva. Dupa cum se arata in imaginea de mai jos.
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Isometric | Perspective | Shadow | Anti-Aliasing | Light Projection

10.11 Anti-Aliasing

Jaggies-urile sunt eliminate, iar marginile imaginii sunt inmuiate pentru a face ca marginile imaginii sa para mai
netede si mai aproape de obiectul fizic. Faceti clic pe butonul de blocare a luminii din coltul din dreapta jos pentru a
activa functia si faceti clic din nou pentru a o dezactiva.

Dupa cum se aratad in figura de mai jos.

Isometric | Perspective | Shadow | Anti-Aliasing | Light Projection

10.12 Proiectia luminii

Mascarea luminii ambientale, care descrie efectul de blocare a luminii difuze din jur atunci cand obiectele si obiectele
se intersecteaza sau sunt aproape unul de altul. Faceti clic pe butonul Projectie luminoasa din coltul din dreapta jos

pentru a activa functia si faceti clic din nou pentru a o dezactiva. Dupa cum se arata in figura de mai jos.

Isometric Perspectlve’Shadow Anti-Aliasing | Light Projection
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